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About This Manual

The Novell® Teaming 2.1 User Guide explains how to use the Teaming product.

This guide includes the following topics:

Chapter 1, “Getting Started,” on page 13
Chapter 2, “Getting Informed,” on page 27
Chapter 3, “Navigating the Teaming Interface,” on page 43
Chapter 4, “Managing and Using Workspaces,” on page 49
Chapter 5, “Managing and Using Folders,” on page 63
Chapter 6, “Working with Specific Folder Types,” on page 73
Chapter 7, “Working With Folder Entries,” on page 91
Chapter 8, “Managing Accessories,” on page 107
Chapter 9, “Connecting With Your Co-Workers,” on page 119
Chapter 10, “Using Workflows,” on page 127
Chapter 11, “Using Teaming on Your Mobile Phone,” on page 129
Appendix A, “What’s New in Teaming,” on page 131
Appendix B, “Troubleshooting,” on page 139
Appendix C, “Accessibility for People with Disabilities,” on page 149

Audience

This guide is intended for all new Novell Teaming users.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation 
included with this product. Please use the User Comments feature at the bottom of each page of the 
online documentation, or go to www.novell.com/documentation/feedback.html and enter your 
comments there.

Documentation Updates

For the most recent version of this manual, visit the Novell Teaming 2.1 Documentation Web site 
(http://www.novell.com/documentation/teaming21). 

Additional Documentation

You can find more information in the Novell Teaming documentation, which is accessible from links 
within the Novell Teaming software:

Novell Teaming Help Mode
Novell Teaming Quick Start Guide
About This Manual 11
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Novell Teaming Installation and Configuration Guide
Novell Teaming Administration Guide

Documentation Conventions

This manual uses the conventions described in the following paragraphs and table.

A greater-than symbol (>) is used to separate actions within a step and items in a cross-reference 
path.

A trademark symbol (®, TM, etc.) denotes a Novell trademark. An asterisk (*) denotes a third-party 
trademark.
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1Getting Started

When you begin to use Novell® Teaming, the first thing you might want to do is set up your personal 
workspace and create a team workspace. This section explains how to get started with Teaming by 
accomplishing these important tasks.

Section 1.1, “About Novell Teaming,” on page 13
Section 1.2, “Watching the Teaming Video Tutorials,” on page 14
Section 1.3, “Starting Novell Teaming,” on page 15
Section 1.4, “Getting to Know the Novell Teaming Interface and Its Features,” on page 16
Section 1.5, “Setting Up Your Personal Workspace,” on page 19
Section 1.6, “Creating a Team Workspace,” on page 20
Section 1.7, “Using Novell Teaming Folders,” on page 21
Section 1.8, “Using Help Mode,” on page 24

As you use this guide to help you accomplish tasks in Teaming, you might discover that you are 
unable to complete the tasks as the sections describe. If you encounter this problem, it is probably 
because you have not been granted appropriate rights. You should consult with your Teaming 
administrator. 

For more information on rights and access control in Teaming, see “Controlling User Access” in the 
Novell Teaming 2.1 Advanced User Guide.

1.1  About Novell Teaming
Section 1.1.1, “Teaming Is Collaboration Software,” on page 13
Section 1.1.2, “Teaming Is Social Networking Software,” on page 14

1.1.1  Teaming Is Collaboration Software
Collaboration through Teaming facilitates online work, creating a “virtual meeting space.”

You experience an increase in team synergy when using Teaming:

You and your teammates can work together without being in the same room or working at your 
computers at the same time. Someone can post a note or document to a folder, and, at their 
convenience, teammates can comment on the work, review and edit files, and further develop 
the idea. With Teaming, teamwork is ongoing and potentially never-ending.
When you are working online at the same time, the “presence” feature of Teaming allows you 
to see which teammates are currently online, and allows you to start a chat session by using 
Novell Conferencing, create an online meeting using Conferencing, make a Skype* phone call, 
and so on.
Ideas are formed together, interactively, with your teammates. By the time you hold a meeting 
in the conference room, the team has already been part of the formation of the idea, and 
teammates are more likely to understand it, buy into it, and assist with its implementation. 
Teaming becomes a “pre-meeting” meeting. 
Getting Started 13
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Documents are reviewed earlier in the process, which allows for easier modifications and 
adjustments. Teaming also makes it easier to co-author documents, because of workflow 
processes that automate drafting and review, and because of Teaming access control that easily 
designates writers and reviewers.
Your collaborative process is preserved and publicly accessible in Teaming. No more searching 
through e-mail folders in a frantic effort to “catch someone up” on a lengthy e-mail discussion. 
To review past discussions and decisions, or to review a previous version of a document, use 
the powerful search capability of Teaming to locate historical information quickly and easily. 
You can use various Teaming tools in combination—a milestones folder, tasks, workflow, 
discussions, chat, online meetings—to track progress against goals for multiple teams working 
on a large project.

1.1.2  Teaming Is Social Networking Software
The out-of-the-box Teaming tools provide powerful enhancements to online collaboration. In 
addition, when you use the tools in combination and apply structure to content design, Teaming 
becomes a powerful knowledge-management and enterprise social networking tool. Knowledge 
management involves the efficient development, management, access, and distribution of 
organizational knowledge. Enterprise social networking involves the efficient connection of 
knowledgeable people needed to form teams, make decisions, and complete work (like FaceBook* 
for the workplace).

Consider these examples:

When people use their personal workspaces to provide detailed information about themselves, 
the purpose of the workspace moves beyond merely contact data (phone numbers, e-mail 
addresses, Novell Conferencing username, and so on). It enables searches for various subject-
matter experts. Also, Teaming analyzes its search results, telling you which people discuss your 
search topic the most and in which places these conversations are happening. It is easy to see 
pockets of expertise associated with your area of interest.
Experts can rate entries in Teaming by using a five-star rating system (one star indicating the 
least impressive, and five stars the most impressive), providing an additional tool for 
determining the quality of information.
Teaming provides tools, such as wikis (information coauthored by all participants), blogs 
(chronological journal entries allowing for comments from readers), workflow (an online 
representation of a business process), and tags (categorical labels applied to items). People can 
use these tools to create and organize information organically, over time, in ways that map best 
to the team’s natural work style. Through these tools, teams literally move their business 
processes online and automate their work.
Teaming provides work-area summaries, called accessories, that provide a snapshot of a 
potentially large amount of information, highlighting the most relevant data. For example, the 
accessory can present entries submitted by an expert on a given subject, or it can summarize 
task-completion information by providing a milestone overview.

1.2  Watching the Teaming Video Tutorials
Novell Teaming 2.1 includes five video tutorials that are displayed in your personal workspace. 
These videos explain how to perform core tasks, and get you collaborating fast. It is a good idea to 
watch these video tutorials to help you get started with Teaming.
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You can minimize the Video Tutorials section by clicking the Minimize icon , or you can delete 
the section by clicking the Delete icon (X). 

After you have deleted the Video Tutorials section, you can launch it again:

1 In the main sidebar, click Personal Preferences.
2 In the Video Tutorial Panel section, click Show panel.

The Video Tutorials section is displayed.

You can also access the video tutorials from the following URLs:

What Is Teaming (http://www.brainstorminc.com/cbt/teaming/
index.php?category=whatisteaming)
Getting Started (http://www.brainstorminc.com/cbt/teaming/
index.php?category=gettingstarted)
Getting Informed (http://www.brainstorminc.com/cbt/teaming/
index.php?category=gettinginformed)
Navigation (http://www.brainstorminc.com/cbt/teaming/index.php?category=navigation)
Customizations (http://www.brainstorminc.com/cbt/teaming/
index.php?category=customizations)

1.3  Starting Novell Teaming
1 Launch a Web browser (such as Mozilla* Firefox* or Internet Explorer*).
2 Specify the URL of your corporation’s Teaming site.

3 In the User Id field, specify your Teaming username.
4 In the Password field, specify your Teaming password.

If you do not know your Teaming username and password, contact your Teaming administrator.
5 Click OK.

1.4  Getting to Know the Novell Teaming Interface 
and Its Features
When you first launch Novell Teaming, you see your personal workspace, which includes the 
following toolbars and features:
Getting Started 15
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Figure 1-1   Teaming Interface

Section 1.4.1, “Understanding the Navigation Toolbar,” on page 16
Section 1.4.2, “Understanding the Main Sidebar,” on page 17
Section 1.4.3, “Understanding the Workspace Toolbar,” on page 18
Section 1.4.4, “Understanding the Folder Toolbar,” on page 18
Section 1.4.5, “Understanding the Relevance Tabs in the Home Page of Your Personal 
Workspace,” on page 19

1.4.1  Understanding the Navigation Toolbar
The Navigation toolbar contains the following features:

Search: Enables you to search for entries, places, or people. Search functionality is helpful if you 
are looking for a subject-matter expert, or if you want to see what information is available 
concerning a particular topic.

For more information, see Section 2.5, “Searching for Information,” on page 29.

Find: Enables you to locate people, places, and tags that you know exist on the Teaming site.

For more information, see Section 3.2, “Finding Specific People, Places, or Tagged Items,” on 
page 43.

My Workspace: Click the My Workspace link to return to your personal workspace.
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Favorites: Click the Favorites drop-down list to add a place as a favorite, or to quickly visit your 
favorite places on the Teaming site.

For more information, see Section 3.5, “Using the Favorites Panel,” on page 44.

My Teams: The My Teams drop-down list enables you to quickly navigate to all of the team 
workspaces where you are a member.

1.4.2  Understanding the Main Sidebar
The main sidebar contains the following features:

Micro-Blog: Enables you to capture quick thoughts and to inform others of what you are currently 
working on.

For more information, see Section 2.10, “Using Micro-Blogs,” on page 35.

Track This Person/Track This Workspace/Track This Folder: Enables you to track the person, 
workspace, or folder that you are currently viewing.

For more information, see Section 2.6, “Tracking and Untracking Places and People of Interest,” on 
page 33.

Share This Workspace/Share This Folder: Enables you to share the workspace or folder with 
another Teaming user.

For more information, see Section 2.11, “Sharing Workspaces, Folders, and Entries,” on page 37.

Recent Places: Displays the places that you have most recently visited.

For more information, see Section 3.3, “Viewing and Revisiting Recent Places,” on page 44.

Workspace: Displays the workspace that you are currently viewing, and all of the sub-workspaces 
and sub-folders.

Folder Options: Enables you to change the folder view and some other folder-specific options.

For more information on managing your folders, see Chapter 5, “Managing and Using Folders,” on 
page 63.

Team: Enables you to view team members, manage the team, and send them e-mail messages.

For more information on managing a team workspace, see Section 4.3, “Managing a Team 
Workspace,” on page 57.

Tag This Workspace/Tag This Folder: Enables you to create a personal or community tag on the 
workspace or folder that you are currently viewing.

For more information, see Section 3.7, “Using Tags,” on page 45.

Personal Preferences: Enables you to change various personal preferences, such as the way entries 
are displayed, the default document editor, and more.

Send E-Mail: Enables you to send an e-mail message from Teaming. By default, the message has a 
link to the page that you are currently viewing.

For more information, see Section 9.3, “Sending E-Mail From within Teaming,” on page 121.
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Clipboard: Enables you to add people to the clipboard, so that you can have quick access to their 
names when necessary.

For more information, see Section 9.5, “Using the Teaming Clipboard,” on page 123.

Trash: Displays all deleted items in the current workspace or folder that have not yet been purged. 
You can restore or purge deleted items.

For more information, see “Restoring Deleted Items” in the Novell Teaming 2.1 Advanced User 
Guide.

1.4.3  Understanding the Workspace Toolbar
The Workspace toolbar and the Folder toolbar occupy the same space in the Teaming interface. The 
Workspace toolbar is displayed when you are in a workspace, and the Folder toolbar is displayed 
when you are in an individual folder of that workspace.

The Workspace toolbar contains the following features:

What’s Unread: Displays all of the entries contained in the workspace that you have not yet read.

What’s New: Displays all of the entries contained in the workspace that are new.

Manage: Provides various functions that enable you to manage the workspace, including adding 
new folders, managing access control, configuring the workspace, and more.

For more information on how to manage a workspace, see Section 4.1, “General Workspace 
Management,” on page 49.

Who Has Access: Displays who has rights to access the workspace. To modify the current settings, 
click Configure Access Control.

Modify Profile: Enables you to modify your personal profile information, such as your e-mail 
address, phone number, and picture.

For more information, see Section 1.5.1, “Modifying Your Profile,” on page 19.

1.4.4  Understanding the Folder Toolbar
The Workspace toolbar and the Folder toolbar occupy the same space in the Teaming interface. The 
Workspace toolbar is displayed when you are in a workspace, and the Folder toolbar is displayed 
when you are in an individual folder of that workspace.

The Folder toolbar contains the following features:

What’s Unread: Displays all of the entries contained in the folder that you have not yet read.

What’s New: Displays all of the entries contained in the folder that are new.

Manage: Provides various functions that enable you to manage the folder, including adding new 
folders, managing access control, configuring the folder, and more.

For more information on how to manage a folder, see Chapter 5, “Managing and Using Folders,” on 
page 63.
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Who Has Access: Displays who has rights to access the folder. To modify the current settings, click 
Configure Access Control.

E-Mail Notification: Enables you to subscribe to the folder. When you subscribe to a folder, 
Teaming notifies you via e-mail of the activity that takes place in the folder.

For more information on subscribing to e-mail notifications, see Section 2.12, “Subscribing to a 
Folder or Entry,” on page 38.

1.4.5  Understanding the Relevance Tabs in the Home Page of 
Your Personal Workspace
The home page of your personal workspace contains various tabs that are designed to help facilitate 
your work. Use these tabs as a central location where you can quickly get informed on new entries, 
upcoming tasks, your daily meetings, and more.

Overview: Contains an Accessory Panel that lists entries from your Guestbook, Blog, and Photo 
Album folders.

What’s New (Teams, Tracked Places, Site): Enables you to quickly see new entries in your teams, 
tracked places, or across the entire site.

Tasks and Calendars: Enables you to view tasks that are assigned to you, as well as today’s events 
from your tracked calendars.

Recent Entries: Enables you to view entries that you have recently posted, and entries that you 
have recently visited. 

Micro-Blogs and Shared Items: Enables you to view the micro-blog entries of the people you are 
tracking, as well as items that people have shared with you.

Profile: Displays your personal profile information. Click Modify Profile in the Workspace toolbar 
to change and add information.

1.5  Setting Up Your Personal Workspace
Before you take advantage of all of the features and functionality of Novell Teaming, you might 
want to customize your personal workspace. 

Section 1.5.1, “Modifying Your Profile,” on page 19
Section 1.5.2, “Presenting Your Professional Credentials,” on page 20

1.5.1  Modifying Your Profile
You might need to manually update your profile in order for important contact information to be 
seen, such as your e-mail address, phone number, time zone, and picture.

NOTE: If you are unable to modify your personal information (such as your Teaming password) as 
described in this section, it is most likely because your personal information is being synchronized 
from an external directory server. You must consult your Teaming administrator to make any 
changes.

1 In the home page of your personal workspace, click the Profile tab.
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If you are a new user, your profile does not currently contain much information.
2 Click Modify Profile in the Workspace toolbar.

The User page is launched. 
3 Change your password, e-mail address, phone number, time zone, language of the interface, 

upload a picture, and more.
4 When you are finished modifying your profile, click OK.

1.5.2  Presenting Your Professional Credentials
One advantage of Teaming is the ability to find experts on any particular subject within your 
organization. You, as a Teaming user, have the ability to be a subject-matter expert. If you want 
people to know what skills and past experience you have, you can post that information in a Blog 
entry in your personal workspace.

1 Select the Blog folder in your personal workspace.
2 Click Add Blog Entry.

The Blog Entry page is displayed.
3 Specify the following information:

Title: Provide a title for the blog entry, such as My Skills and Experience.
Description: You can paste pertinent sections of your resume, or you can simply type the 
information directly into the field.
Attachments: You can attach your entire resume, or any other files that you think might help 
other users understand your professional strengths.

4 Click OK.
You have now created a blog entry to inform other Teaming users about your skills and 
professional experience.

1.6  Creating a Team Workspace
By default, everyone in Novell Teaming has rights to create a team workspace.

Team workspaces are the most common type of workspaces. They facilitate team objectives by 
enabling team members to quickly share files, share ideas, and work together more efficiently and 
effectively.

To create a team workspace:

1 Expand Home Workspace in the Workspace tree, located near the top of the Teaming interface.
The Home Workspace directory is the highest-level folder in the workspace tree, and might be 
named something specific to your organization.

2 Click Team Workspaces.
3 Click Add a team workspace.

The Add a Team Workspace page is displayed.
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If you do not see this option, your site administrator has not permitted you to create a new 
workspace at this level. Continue to expand the workspace tree, following the path of your 
organizational unit, then click the name of the directory where you want to create the new team 
workspace. Or, follow the steps in “Creating a Team Workspace inside of an Existing Team 
Workspace” on page 58.

4 Specify the following information:
Title: Provide a title for the workspace. 
Team Members: Specify the team members.
You can specify individual users, entire groups, or add names that are on your clipboard. For 
more information about using the Teaming clipboard, see Section 9.5, “Using the Teaming 
Clipboard,” on page 123.
Workspace Folders: Select the folders that you want the workspace to contain.
If you later decide that you want to add additional folders, you can add them at any time. For 
information on how to add folders to a workspace, see Section 5.1, “Creating a New Folder,” 
on page 63.
Announcement: (Optional) Select the check box, then type a message in the Announcement 
Text field.
This message informs team members about the existence of the workspace, and can also 
explain the value of the workspace.

5 Click OK to create the new workspace.

For information on how to create a team workspace inside of an existing workspace, see “Creating a 
Team Workspace inside of an Existing Team Workspace” on page 58.

1.7  Using Novell Teaming Folders
Novell Teaming includes multiple types of folders that enable you to organize the various kinds of 
information in your workspaces.

Section 1.7.1, “Discussion,” on page 22
Section 1.7.2, “Blog,” on page 22
Section 1.7.3, “Calendar,” on page 22
Section 1.7.4, “Guestbook,” on page 22
Section 1.7.5, “File,” on page 22
Section 1.7.6, “Milestone,” on page 23
Section 1.7.7, “Micro-Blog,” on page 23
Section 1.7.8, “Mirrored File,” on page 23
Section 1.7.9, “Photo Album,” on page 23
Section 1.7.10, “Survey,” on page 23
Section 1.7.11, “Task,” on page 24
Section 1.7.12, “Wiki,” on page 24

For more detailed information about each type of Teaming folder, see Chapter 6, “Working with 
Specific Folder Types,” on page 73.
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1.7.1  Discussion
Use discussions as a way of obtaining comments and feedback to questions and thoughts that you 
might have. You can start general discussion threads in the Discussion folder in your personal 
workspace. For discussion threads that are more specific to a project and team, start the discussion 
thread in the Discussion folder of an appropriate team workspace.

For more information on Discussion folders, see Section 6.1, “Working with Discussion Folders,” 
on page 73.

1.7.2  Blog
Blogs are a good way to express your thoughts about topics that are important to you. For example, 
if you are working on a project and are responsible for a certain aspect of that project, you can 
update your team on your individual progress by posting a blog in the Blog folder in the team 
workspace. Also, you can use the Blog folder in your personal workspace to post your professional 
credentials and skills, as described in Section 1.5.2, “Presenting Your Professional Credentials,” on 
page 20.

For more information on Blog folders, see Section 6.2, “Working with Blog Folders,” on page 74.

1.7.3  Calendar
Teaming enables you to create a Calendar folder in any workspace that you desire. You can maintain 
a personal calendar in your personal workspace, and then add separate calendars in your team 
workspaces to keep track of events that are specific to that team.

For more information on Calendar folders, see Section 6.3, “Working with Calendar Folders,” on 
page 76.

1.7.4  Guestbook
The Guestbook folder in Teaming is a place to store all of your guestbook entries. By default, users 
can sign your Guestbook by clicking the Overview tab on the home page of your personal 
workspace. This is a quick way for your friends and co-workers to communicate with you.

For more information on Guestbook folders, see Section 6.4, “Working with Guestbook Folders,” on 
page 78.

1.7.5  File
File folders in Teaming make it easy to store and keep track of your files. You can store personal 
files in the File folder in your personal workspace, and team-related files in your individual team 
folders. This makes it easy to share files with your teammates and others who might be interested in 
viewing them.

For more information on File folders, see Section 6.5, “Working with File Folders,” on page 78.
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1.7.6  Milestone
Milestone folders track the progress of several task folders. Although you can use milestone folders 
outside of the scope of a project workspace, they are most often used in those workspaces. For more 
information, see Section 4.5, “Managing a Project Management Workspace,” on page 61.

For more information on Milestone folders, see Section 6.6, “Working with Milestone Folders,” on 
page 79.

1.7.7  Micro-Blog
The Micro-Blog folder in Teaming is a place to store all of your micro-blog entries. Use the Micro-
Blog feature to capture quick personal notes, or to inform others of what you are currently working 
on. This provides a greater transparency, so those you work with know what you are doing, and how 
they might offer assistance to help you accomplish your tasks.

You can navigate to someone else’s Micro-Blog folder to see what they have been working on, and 
possibly provide help by sharing your knowledge and experience.

For more information on the Micro-Blog feature, see Section 2.10, “Using Micro-Blogs,” on 
page 35.

1.7.8  Mirrored File
Mirrored File folders reference a file system on an external server, instead of the Teaming file 
system where other Teaming information is stored. Mirrored File folders can reference any 
WebDAV or local file path.

For more information about Mirrored File folders, see “Working with Mirrored Folders” in the 
Novell Teaming 2.1 Advanced User Guide.

1.7.9  Photo Album
Photo albums store and display pictures. You can store your personal photos in the Photo Album in 
your personal workspace, and team-related photos in the Photo Album of the team workspace.

For more information on Photo Album folders, see Section 6.9, “Working with Photo Album 
Folders,” on page 80.

1.7.10  Survey
Survey folders store surveys that you or other Teaming users have created. Surveys enable you to 
poll team members, or any other Teaming users, about issues that are important to you, your team, or 
your company.

For more information on Survey folders, see Section 6.10, “Working with Survey Folders,” on 
page 82.
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1.7.11  Task
Task folders keep track of the progress made in completing work assignments. Teaming enables you 
to create a Task folder in any workspace that you desire. You can maintain a personal Task folder in 
your personal workspace, and then add separate Task folders in your team workspaces to keep track 
of tasks that are specific to that team.

For more information on Task folders, see Section 6.11, “Working with Task Folders,” on page 83.

1.7.12  Wiki
Wiki folders contain wiki entries. A wiki is a set of related entries coauthored by folder participants. 
For example, the best known wiki on the Internet is Wikipedia*. Other examples of possible wiki 
content are glossaries, or policies and procedures.

For more information on Wiki folders, see Section 6.12, “Working with Wiki Folders,” on page 87.

1.8  Using Help Mode
Novell Teaming has a unique way of helping you to learn about product pages and tools. 

Section 1.8.1, “Launching Help Mode,” on page 24
Section 1.8.2, “Getting Help about a Topic,” on page 24
Section 1.8.3, “Using the Help Mode Control Panel,” on page 25
Section 1.8.4, “Viewing the Manuals,” on page 25
Section 1.8.5, “Exiting Help Mode,” on page 25

1.8.1  Launching Help Mode
1 Click the Teaming Help icon , which is located on all workspaces, folders, and entry pages.

When you click this icon, Teaming enters Help mode. 

1.8.2  Getting Help about a Topic
When you enter Help mode, Teaming dims the page, displays the Help mode control panel, and 
presents information icons  next to each section of that page for which there is Help information:

1 Click the information icon over the portion of the page about which you want more 
information.
Teaming displays a panel of information about the particular topic.

2 When you are finished reading the panel, click the Close icon (X) in the upper right corner of 
the panel to close it. 
or
Click another information icon to read about another topic.
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1.8.3  Using the Help Mode Control Panel
Teaming enables you to minimize and maximize the Help mode control panel.

“Minimizing the Help Mode Control Panel” on page 25
“Maximizing the Help Mode Control Panel” on page 25

Minimizing the Help Mode Control Panel

You might find that you want more room on the page to click information icons. If you choose, you 
can minimize the Help mode control panel. 

1 Click the Currently displayed (down-arrow) icon.

Maximizing the Help Mode Control Panel

You can display the contents of the control panel after you have minimized it.

1 Click the Currently hidden (right-arrow) icon.

1.8.4  Viewing the Manuals
To view manuals from the Help mode control panel:

1 Click View manuals in the control panel.
2 Click All Teaming Users for end user documentation, or click Teaming Administrators for 

administrator documentation.
3 Click the linked title of the manual that you want to view.

1.8.5  Exiting Help Mode
1 Click the Close icon (X) in the Help mode control panel.

or
Click any dimmed part of the page.
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2Getting Informed

Novell® Teaming provides numerous methods to help keep you informed of what’s going on in your 
teams and in your organization.

Section 2.1, “Accessing Novell Teaming from Your Mobile Phone,” on page 27
Section 2.2, “Finding What’s New,” on page 27
Section 2.3, “Finding What’s Most Popular In Your Teaming Site,” on page 28
Section 2.4, “Finding What’s Unread,” on page 28
Section 2.5, “Searching for Information,” on page 29
Section 2.6, “Tracking and Untracking Places and People of Interest,” on page 33
Section 2.7, “Viewing Recent Contributions,” on page 34
Section 2.8, “Viewing Tasks,” on page 35
Section 2.9, “Viewing Calendar Events,” on page 35
Section 2.10, “Using Micro-Blogs,” on page 35
Section 2.11, “Sharing Workspaces, Folders, and Entries,” on page 37
Section 2.12, “Subscribing to a Folder or Entry,” on page 38
Section 2.13, “Using Remote Applications,” on page 40
Section 2.14, “Viewing Live Teaming Feeds,” on page 41
Section 2.15, “Viewing Teaming Folders as RSS or Atom Feeds,” on page 42
Section 2.16, “Synchronizing Teaming Task and Calendar Folders to a Desktop Calendar 
Application,” on page 42

2.1  Accessing Novell Teaming from Your Mobile 
Phone
Novell Teaming includes a mobile interface that enables you to access your Teaming site from your 
iPhone*, Blackberry*, or any mobile device that provides an HTTP/HTML-based interface. In other 
words, most phones that have a data service plan can access the Teaming mobile interface.

For more information about using Teaming on your mobile phone, see “Using Teaming on Your 
Mobile Phone” in the Novell Teaming 2.1 Advanced User Guide.

2.2  Finding What’s New
One key to effective and efficient teamwork is knowing what people are working on and what they 
are saying. Novell Teaming enables you to view the newest files and entries, wikis, discussions, and 
more. This enables you to quickly learn about the latest issues. You can also use Teaming as a way to 
keep track of what you’ve been working on.
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Before you begin using Teaming What’s New functionality, you might want to view the short 
tutorial video, Finding What’s New (http://www.brainstorminc.com/cbt/teaming/
index.php?category=gettinginformed). To display the video, follow this link, then click Finding 
What’s New.

Section 2.2.1, “Finding What’s New in a Workspace or Folder,” on page 28
Section 2.2.2, “Finding What’s New in Your Teams, Tracked Places, or Across the Entire Site,” 
on page 28

2.2.1  Finding What’s New in a Workspace or Folder
To view newly created items in a specific workspace or folder:

1 Navigate to the workspace or folder where you want to view the new postings.
2 Clicks What’s New in the Workspace of Folder toolbar.

Teaming displays the most recent entries.

2.2.2  Finding What’s New in Your Teams, Tracked Places, or 
Across the Entire Site

1 Navigate to your personal workspace by clicking My Workspace in the Navigation toolbar.
2 Click the What’s New tab in the home page of your personal workspace.
3 Select My Teams, Tracked Places, or Site Wide.

In the left column of the page, Teaming displays the most recent entries.

2.3  Finding What’s Most Popular In Your 
Teaming Site
Novell Teaming enables you to view the most popular entries in your Teaming site.

1 Navigate to your personal workspace by clicking My Workspace in the Navigation toolbar.
2 Click the What’s New tab in the home page of your personal workspace.
3 Select Site Wide.

In the right column of the page, Teaming displays the most popular entries.

2.4  Finding What’s Unread
Novell Teaming enables you to view unread items in any workspace or folder.

1 Navigate to the workspace or folder where you want to view all unread items.
2 Click What’s Unread in the Workspace toolbar or Folder toolbar.

Teaming displays all of the items that you have not yet read.

Click the Mark These Read button to mark all unread items as read. These items no longer appear 
when you click What’s Unread in this workspace or folder.
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2.5  Searching for Information
Search functionality in Novell Teaming enables you to search for entries, places, or people. Search 
functionality is helpful if you are looking for a subject-matter expert, or if you want to see what 
information is available about a particular topic. 

If you want to quickly navigate to a personal workspace, team workspace, or folder that you know 
exists on the Teaming site, use Teaming Find functionality.

Before you begin using Teaming Search functionality, you might want to view the short tutorial 
video, Using Search (http://www.brainstorminc.com/cbt/teaming/index.php?category=navigation). 
To display the video, follow this link, then click Using Search.

The following topics describe Search functionality:

Section 2.5.1, “Using Basic Search,” on page 29
Section 2.5.2, “Using Advanced Search,” on page 30
Section 2.5.3, “Searching for Deleted Items,” on page 31
Section 2.5.4, “Saving and Reusing Searches,” on page 32
Section 2.5.5, “Using the Search Results Page,” on page 32
Section 2.5.6, “Search String Rules,” on page 33

2.5.1  Using Basic Search
When you perform a basic search, your search is case-insensitive. If you want to make your search 
case-sensitive, perform an advanced search.

“Performing a Basic Search” on page 29
“Using Wildcards in Your Search” on page 29

Performing a Basic Search

To perform a basic search:

1 Type the words or quoted phrases into the Search field, then either press Enter on your 
keyboard, or click the Search icon .

Using Wildcards in Your Search

When performing a search, Teaming supports the following wildcards:

Asterisk (*): You can insert an asterisk (*) after word fragments if you want Teaming to search for 
words that begin with what you typed; however, Teaming does not support putting an asterisk before 
word fragments.

For example, if you are searching for words that begin with “work,” such as “workspace” and 
“workshop,” you can type work* and Teaming returns all instances of words beginning with 
“work.” However, if you type *space, Teaming does not search for words ending in “space,” such 
as “workspace.”

Question Mark (?): You can insert a question mark (?) to replace any single character in your 
search.
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For example, you can type t??e, and teaming returns all results containing the words “true,” “tree,” 
and so forth.

You cannot use a question mark as the first character in a search.

2.5.2  Using Advanced Search
Advanced Search enables you to narrow your search based on any or all of the following criteria:

Text: Enter the specific text that you are searching for.

Places: This section enables you to restrict your search to a particular place. Expand the tree by 
clicking the plus sign (+) next to the Home Workspace, then navigate to and select the workspace or 
folder that you want to search.

If you want Teaming to search every place below your selection in the Workspace tree, select Search 
All Sub Places.

Case Sensitive: Select this check box to make the text that you enter in the Text field case sensitive. 
For example, “Tree” does not match “tree,” “TREE,” and so on.

NOTE: When you select this option, your search must contain at least one upper-case character. If 
your search contains all lower-case characters, then the results of your search are not case sensitive. 
For example, “tree” matches “Tree,” “TREE,” and so on.

Search deleted items: Search for items that have been deleted. The search returns only items that 
have been deleted.

Presentation Options: Select how many results you want to display on each Search Results page, 
and how many words are displayed for each result.

Authors: Search for items based on the author.

Tags: Search for items that are tagged, whether they are community or personal tags. For more 
information on tags, see Section 3.7, “Using Tags,” on page 45.

Workflow: Search for items that have a particular workflow applied to them.

Entry Attributes: Select the type of entry you are searching for, such as a blog entry, calendar 
entry, or comment.

Last Activity in Days: Select to search for items that have been active in the last 1, 3, 7, 30, or 90 
days.

Creation Dates: Search for items based on when the items were created. In the fields provided, 
specify the start and end dates of the desired interval.

Modification Dates: Search for items based on when the items were last modified. In the fields 
provided, specify the start and end dates of the desired interval.

Item Type: Select the type of item you are searching for.

The following sections provide further information for using Advanced Search:

“Adding Criteria” on page 31
“Accessing Advanced Search” on page 31
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Adding Criteria

If your search requires more than one criterion, click Add Another and Teaming provides another 
field for your use. 

Click the X icon next to a criterion to remove it from the search.

Accessing Advanced Search

You can access the Advanced Search from either the navigation bar or from a search results page:

“Navigation Bar” on page 31
“Search Results Page” on page 31

Navigation Bar

1 Click Advanced. (Located above the Search field.)

Search Results Page

1 Click Advanced.
2 If you want to provide more than the initially provided criteria, click Revise your Advanced 

Search query in the Summary of search criteria section.

2.5.3  Searching for Deleted Items
Teaming enables you to search for items that have been deleted from the Teaming site. After you 
find the deleted item that you’re searching for, you can view the item by clicking it. For information 
on how to undelete the item, see Section 4.1.3, “Undeleting a Workspace,” on page 50, Section 5.3, 
“Undeleting a Folder,” on page 64, or Section 7.9, “Undeleting a Folder Entry,” on page 96. You can 
undelete the item only if you have appropriate rights. If you want to undelete the item but you do not 
have appropriate rights, contact the user who created the item and ask them to undelete it.

For more information on undeleting items in Teaming, see “Restoring Deleted Items” in the Novell 
Teaming 2.1 Advanced User Guide.

To search for a deleted item:

1 Click Advanced, located above the Search field in the Navigation toolbar.
The Advanced Search page is displayed.

2 Select Search deleted items.
3 (Optional) Narrow your search in any of the ways described in Section 2.5.2, “Using Advanced 

Search,” on page 30.
If you decide not to narrow your search, all items that have been deleted from Teaming are 
displayed.

NOTE:  Purged items cannot be displayed.

4 Click Search.
Getting Informed 31



32 Novell

novdocx (en)  7 January 2010
2.5.4  Saving and Reusing Searches
Teaming enables you to save searches, so you can reuse them in the future.

“Saving Your Search” on page 32
“Accessing Saved Searches” on page 32

Saving Your Search

To save a search for later use:

1 After you have performed a search that you want to save, provide a name in the Saved searches 
section of the main sidebar, on the left side of the page.

2 Click Save.

Accessing Saved Searches

1 Click the drop-down arrow next to the Search icon.
Links to saved searches are displayed.

2.5.5  Using the Search Results Page
When the search finishes, the Search Results page is displayed. In the main section of this page, 
Teaming lists all of the results for your search. Also, Teaming provides tools in the main sidebar, and 
displays search criteria at the top of the right column, as described in the following sections:

“Search Results” on page 32
“Tools” on page 32
“Quick Search” on page 33

Search Results

In the main section of the right column, Teaming displays the results of your search. To view a 
result, click the name of the result. Results can be attachments, comments, or any type of Teaming 
entry.

Tools

The main sidebar provides the following tools to help make your search more efficient:

Recent Places: As you conduct searches, Teaming places links to each search in the Recent Places 
section of the main sidebar, so you can easily perform a recent search again. However, because 
Teaming saves only the most recently visited places and searches, use Saved searches for searches 
that you want to keep available.

Saved Searches: Provide a name for your current search and click Save. Later, in the navigation bar, 
you can click the drop-down arrow next to the Search icon and click the linked name of a saved 
search you want to perform again.

Top Ranked Places: Lists the places where your search topic is most often being discussed. Items 
at the top of the list are most relevant.
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Top Ranked People: Lists the people who are most often contributing to the discussions about the 
topic for which you searched. Items at the top of the list are most relevant.

Tags: Shows tags that have been applied to matched items.

Quick Search

If your initial search did not yield the desired results, the Quick search section enables you to 
perform another search. Specify the topic to search for in the Text field, then click Search. 

If you want to perform a more in-depth search, click Advanced.

2.5.6  Search String Rules
The rules for search strings are as follows:

Case Sensitivity: All basic searches in Teaming are case-insensitive. For example, “tree” matches 
“tree,” “Tree,” “TReE,” and so on. If you want to make your search case-sensitive, then you must 
perform an advanced search. For information on how to access Advanced Search, see “Accessing 
Advanced Search” on page 31.

More Than One Word: Teaming returns items that contain all words in the search string.

Quoted Phrase: Teaming returns items that match all words in order. Case sensitivity rules apply as 
described previously.

Exclusions: To exclude a word (do not return matches for items that contain this word), place a 
minus sign (-) in front of it. For example, “-tree” excludes all items containing “tree”, “Tree”, 
“TREE”, and so on.

2.6  Tracking and Untracking Places and People 
of Interest
Novell Teaming enables you to track workspaces, folders, or people. When you track something or 
someone in Teaming, you can easily see activity generated in the specific place that you are 
tracking, or by the specific person that you are tracking.

Before you begin using the tracking capabilities in Teaming, you might want to view the short 
tutorial video, Tracking People, Places, and Projects (http://www.brainstorminc.com/cbt/teaming/
index.php?category=gettinginformed). To display the video, follow the link, then click Tracking 
People, Places, and Projects.

Section 2.6.1, “Configuring Teaming to Track Workspaces, Folders, and People,” on page 34
Section 2.6.2, “Viewing Your Tracked Workspaces, Folders, and People of Interest,” on 
page 34
Section 2.6.3, “Untracking Workspaces, Folders, or People,” on page 34
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2.6.1  Configuring Teaming to Track Workspaces, Folders, and 
People

1 Navigate to the workspace or folder that you want to track. If you want to track a person, 
navigate to that person’s personal workspace.

2 In the main sidebar, click Track This Workspace, Track This Folder, or Track This Person.

2.6.2  Viewing Your Tracked Workspaces, Folders, and People 
of Interest
If you are currently tracking a workspace, folder, or person, Teaming enables you to easily see 
activity generated in the specific place that you are tracking, or by the specific person that you are 
tracking.

1 Navigate to your personal workspace.
2 Click the What’s New tab.
3 Select Tracked Places.

Teaming lists all of the new entries that have been posted to the folders that you are tracking, 
and lists the entries that have been contributed by the people you are tracking.

Staying up-to-date on another Teaming user’s micro-blog entries is another reason that you might 
want to track a person in Teaming. For information on the various and convenient ways that you can 
view the micro-blog entries of people you are tracking, see Section 2.10.2, “Viewing the Micro-Blog 
Entries of People You Are Tracking,” on page 36.

2.6.3  Untracking Workspaces, Folders, or People
If you are currently tracking someone or some place in Teaming, it is easy to untrack that person or 
place.

1 Navigate to your personal workspace.
2 Click the What’s New tab.
3 Select Tracked Places.
4 On the right hand side of the page, click the (X) next to the tracked people or tracked places 

that you want to untrack.

2.7  Viewing Recent Contributions
Novell Teaming enables you to quickly revisit entries that you either recently posted, or recently 
visited.

1 Navigate to your personal workspace.
2 Click the Recent Entries tab.

The left column lists all of the entries that you have most recently posted. The right column 
lists all of the entries that you have most recently visited.
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To view a demonstration of how this is done, see Checking Recent Entries (http://
www.brainstorminc.com/cbt/teaming/index.php?category=gettinginformed). To display the video, 
follow this link, then click Checking Recent Entries.

2.8  Viewing Tasks
To help you keep track of tasks that have been assigned to you, Novell Teaming provides a quick, 
easy way to view tasks.

1 Navigate to the home page of your personal workspace.
2 Click the Tasks and Calendars tab.

In the left column, Teaming displays the tasks that are assigned to you. You can sort them by 
tasks due within two weeks, or any tasks that are currently assigned to you.

2.9  Viewing Calendar Events
To help you keep track of your calendar events, Novell Teaming enables you to view all of the 
calendar events for which you are scheduled on the current day. 

1 Navigate to the home page of your personal workspace.
2 Click the Tasks and Calendars tab.

The right section of the page displays today’s schedule with all of the calendar events from all 
of your tracked calendars.

2.10  Using Micro-Blogs
Use the Micro-Blog feature to capture quick personal notes, or to inform others of what you are 
currently working on. This provides a greater transparency, so those you work with know what you 
are doing, and how they might offer assistance to help you accomplish your tasks.

Micro-blogs differ from regular blogs in that their purpose is not to present an entire topic or 
argument, but rather to give a quick snippet of information about the author of the micro-blog. 
Micro-blogs should be only one or two short sentences.

For more information on traditional blogs within Teaming, see Section 6.2, “Working with Blog 
Folders,” on page 74.

Section 2.10.1, “Posting a Micro-Blog,” on page 35
Section 2.10.2, “Viewing the Micro-Blog Entries of People You Are Tracking,” on page 36
Section 2.10.3, “Viewing the Micro-Blog Entries of Novell Teaming Users Who You Are Not 
Tracking,” on page 36

2.10.1  Posting a Micro-Blog
You can post a micro-blog from anywhere within Novell Teaming.

1 In the main sidebar, compose your micro-blog in the Micro-Blog field.
2 Click OK.
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2.10.2  Viewing the Micro-Blog Entries of People You Are 
Tracking
You can view your tracked people’s micro-blog entries in the following three convenient ways:

“Setting Up a Live Feed to View the Micro-Blog Entries of People You Are Tracking” on 
page 36
“Using the Relevance Tabs in Your Personal Workspace to View the Micro-Blog Entries of 
People You Are Tracking” on page 36
“Using Your Mobile Device to View the Micro-Blog Entries of People You Are Tracking” on 
page 36

For information on how to track people in Teaming, see Section 2.6.1, “Configuring Teaming to 
Track Workspaces, Folders, and People,” on page 34.

Setting Up a Live Feed to View the Micro-Blog Entries of People You Are Tracking

Like Twitter*, Teaming enables you to see live feeds for the micro-blog entries of the people you are 
tracking.

For information on how to set up a live micro-blog feed, see Section 2.14.1, “Setting Up a Live 
Feed,” on page 41.

Using the Relevance Tabs in Your Personal Workspace to View the Micro-Blog 
Entries of People You Are Tracking

1 Navigate to your personal workspace.
2 Click the Micro-Blogs and Shared Items tab.

The Micro-Blogs column lists the micro-blog entries of the people you are currently tracking.

Using Your Mobile Device to View the Micro-Blog Entries of People You Are Tracking

Teaming enables you to use your mobile device to view the micro-blog entries of the people you are 
tracking, as described in “Viewing the Newest Micro-Blog Entries of People You’re Tracking” in 
“Using Teaming on Your Mobile Phone” in the Novell Teaming 2.1 Advanced User Guide.

2.10.3  Viewing the Micro-Blog Entries of Novell Teaming Users 
Who You Are Not Tracking

“Viewing a User’s Micro-Blog Entries by Using the Presence Icon” on page 36
“Viewing a User’s Micro-Blog Entries by Navigating to His or Her Personal Workspace” on 
page 37

Viewing a User’s Micro-Blog Entries by Using the Presence Icon

Teaming enables you to view a user’s micro-blog entries by clicking the user’s Presence icon , 
located next to his or her name in an entry.

1 Click the Presence icon of the user whose micro-blog entries you want to view.
2 Click View Micro-Blog.
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Viewing a User’s Micro-Blog Entries by Navigating to His or Her Personal Workspace

You can navigate to a user’s personal workspace to view their micro-blog entries.

1 Navigate to the personal workspace of the person whose micro-blog entries you want to view.
2 In the main sidebar, click the Micro-Blog folder.

The person’s micro-blog entries are listed in the folder.

2.11  Sharing Workspaces, Folders, and Entries
Novell Teaming enables you to share workspaces, folders, and entries with other Teaming users. 
This is a quick and easy way to refer a co-worker to a place on the Teaming site.

Section 2.11.1, “Sharing Workspaces and Folders,” on page 37
Section 2.11.2, “Sharing Entries,” on page 37
Section 2.11.3, “Viewing Shared Items,” on page 38

2.11.1  Sharing Workspaces and Folders
1 Navigate to the workspace or folder that you want to share.
2 Click Share This Workspace or Share This Folder in the main sidebar.
3 Specify the individual users, groups, or teams that you want to share the workspace or folder 

with.
4 In the Comments field, specify any comments that you want to include in the e-mail.
5 Click OK.

A notification is displayed stating that an e-mail was successfully sent to the users, groups, or 
teams that you specified.

2.11.2  Sharing Entries
1 Navigate to and open the entry that you want to share.
2 Click Share This Entry in the Entry toolbar.
3 Specify the individual users, groups, or teams that you want to share the workspace or folder 

with.
4 In the Comments field, specify any comments that you want to include in the e-mail.
5 Click OK.

A notification is displayed stating that an e-mail was successfully sent to the users, groups, or 
teams that you specified.

2.11.3  Viewing Shared Items
When others share an item with you, Teaming sends you an e-mail notification with a link to the 
item. Also, Teaming makes it easy to find items that others have shared with you, directly from the 
Teaming interface.

1 Navigate to your personal workspace.
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2 Click the Micro-Blogs and Shared Items tab.
In the right column, Teaming lists all of the items that people have shared with you.

2.12  Subscribing to a Folder or Entry
You can configure Novell Teaming to send you e-mail notifications for folders and their sub-folders, 
or for individual entries (this is called “subscribing” to a folder or entry). Also, folder owners can 
configure Teaming to send e-mail notifications to you (as described in “Configuring Folders to Send 
E-Mail Notifications to Other Users” in the Novell Teaming 2.1 Advanced User Guide). However, 
because a user’s individual subscription settings override those of the folder owner, you can override 
any higher-level configurations.

If you are particularly interested in a specific folder or entry, you might want to subscribe to that 
folder or entry. When you subscribe to a folder or entry, Teaming notifies you of the activity that 
takes place in the folder or entry.

Before you begin subscribing to folders or entries in Teaming, you might want to view the short 
tutorial video, Setting Notifications (http://www.brainstorminc.com/cbt/teaming/
index.php?category=gettinginformed). To display the video, follow this link, then click Setting 
Notifications.

Section 2.12.1, “Subscribing to a Folder,” on page 38
Section 2.12.2, “Subscribing to an Entry,” on page 38
Section 2.12.3, “Selecting Notification Types and Delivery Destinations,” on page 39
Section 2.12.4, “Deciding Which Type of E-Mail Notification You Want to Receive,” on 
page 39
Section 2.12.5, “Adding and Modifying Delivery Destinations,” on page 40
Section 2.12.6, “Overriding Higher-Level Notification Settings,” on page 40

2.12.1  Subscribing to a Folder
1 Navigate to the folder that you want to subscribe to.
2 Click E-Mail Notification in the Folder toolbar.

The Select the Type of E-Mail Notification form is displayed.
3 Continue with Section 2.12.3, “Selecting Notification Types and Delivery Destinations,” on 

page 39.

2.12.2  Subscribing to an Entry
1 Navigate to and open the entry that you want to subscribe to.
2 In the Footer toolbar of the entry, click Subscribe to This Entry.

The Select the Type of E-Mail Notification form is displayed.
3 Continue with Section 2.12.3, “Selecting Notification Types and Delivery Destinations,” on 

page 39.
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2.12.3  Selecting Notification Types and Delivery Destinations
This form enables you to choose which type of notification that you want to receive, as well as 
which e-mail address or phone number destination that you want the notifications to be sent to.

1 Select an e-mail address or phone number where you want the notifications to be sent.
You can select multiple e-mail or phone number delivery destinations for each notification type 
by simply pressing Ctrl and selecting the e-mail addresses or phone numbers.
You can select these delivery destinations in any of the provided sections, which represent the 
e-mail notification types:

Digest (available only when subscribing to folders)
Individual Messages
Individual Messages without Attachments
Messages Suitable for Text Messaging

For more information on the various notification types, see Section 2.12.4, “Deciding Which 
Type of E-Mail Notification You Want to Receive,” on page 39.

2 (Optional) Select Override preset notifications with these selections if you want your selections 
to override those made by the administrator or folder owner.
For more information, see Section 2.12.6, “Overriding Higher-Level Notification Settings,” on 
page 40. 

3 Click OK.

2.12.4  Deciding Which Type of E-Mail Notification You Want to 
Receive
You can receive several types of e-mail notifications:

Digest: (Available for folders only) Teaming sends one message that summarizes all of the activity 
in the folder and its sub-folders. Teaming sends digest notifications at a schedule established by your 
site administrator.

Individual Messages: (Includes Attachments) Teaming sends one message for every new or 
changed entry, and messages include attached files.

Individual Messages without Attachments: Teaming sends one message for every new or 
changed entry. The e-mail messages do not include files that might be attached to the new or 
changed entries. Teaming sends all types of individual notifications every five minutes.

Message Suitable for Text Messaging: Teaming sends a message suitable for viewing as a text 
message. The content of the message includes only the linked title of the new or changed entry. 
Teaming sends text-message notifications up to every five minutes.

2.12.5  Adding and Modifying Delivery Destinations
You can add and modify your e-mail and phone number contact information in your Personal 
Profile.

1 Click My Workspace > Modify Profile.
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2 Specify the appropriate delivery destination information in the E-Mail Address, Mobile E-Mail 
Address, and Text Messaging E-Mail Address fields.

3 Click OK.

Now, when you select your notification types and delivery destinations, the new or modified contact 
information is displayed.

2.12.6  Overriding Higher-Level Notification Settings
If a folder owner or administrator has configured a folder to send you e-mail notifications, you can 
override the higher-level settings.

1 Navigate to the folder where you want to override the higher-level notification settings.
2 Select E-mail Notification.
3 Select the kinds of notification that you want to receive.
4 Select Override preset notifications with these selections.
5 Click OK.

If you want to receive no e-mail notifications:

1 Navigate to the folder where you want to override the higher-level notification settings.
2 Select E-mail Notification.
3 Ensure that no e-mail address is selected in any of the sections.
4 Select Override preset notifications with these selections.
5 Click OK.

2.13  Using Remote Applications
Remote applications communicate with a third-party, on-line application, and send information from 
that third-party application back into Novell Teaming. 

For example, your Teaming administrator could create a remote application for Twitter* that 
displays, in Teaming, all of your Twitter entries. 

Remote applications are very customizable, and are set up by your Teaming administrator. Talk with 
your Teaming administrator if you have a request for a new remote application.

For information on displaying remote applications that have been enabled by your Teaming 
administrator, see “Managing Remote Applications” in the Novell Teaming 2.1 Advanced User 
Guide.

You can also display remote applications as folder and workspace accessories, as described in 
Section 8.2, “Creating an Accessory,” on page 109.
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2.14  Viewing Live Teaming Feeds
Novell Teaming enables you to view live feeds of the latest entries in your teams, tracked places, or 
across the entire site, so you can be up-to-date in real time without entering the Teaming site. And, 
like Twitter, you can see live feeds for the micro-blog entries of the people you are tracking.

Section 2.14.1, “Setting Up a Live Feed,” on page 41
Section 2.14.2, “Viewing New Entries in Your Live Feed,” on page 41
Section 2.14.3, “Using the Notification Area to View the Number of New Entries (Firefox 
Only),” on page 41
Section 2.14.4, “Displaying a Teaming Feed in the GroupWise Client,” on page 42

2.14.1  Setting Up a Live Feed
To set up a live feed from your Teaming site:

1 In the main sidebar, click Teaming Feed.
The Teaming Feed window is displayed.

2 In the Select Feed drop-down list, select from the following options:
My Teams: Displays the most recent entries of members of your various teams.
Tracked Places: Displays the most recent entries that have been posted to the places that 
you are currently tracking.
Site Wide: Displays the most recent entries that have been posted to the Teaming site.
Micro-Blogs: Displays the most recent micro-blog entries of the people that you are 
currently tracking.

3 Minimize the Teaming Feed window.
The Teaming Feed window is displayed in your desktop notification area.

2.14.2  Viewing New Entries in Your Live Feed
1 Open the Teaming Feed window that you minimized (located in your desktop notification 

area).
The live feed is automatically updated every five minutes. To instantly update the feed and see 
the most recent entries, click Refresh.

2.14.3  Using the Notification Area to View the Number of New 
Entries (Firefox Only) 
In the Firefox Web browser, you can view how many new entries have been posted since the last 
time you refreshed the live feed.

1 Look at the notification area of the Teaming Feed window that you minimized. The number of 
new entries is displayed on the left. If there are no new entries, no number is displayed.
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2.14.4  Displaying a Teaming Feed in the GroupWise Client
You can display your Teaming feed in the GroupWise® client. This enables you to keep up with the 
latest Teaming additions without leaving GroupWise.

For information on how to do this, see:

 “Creating a New Panel” in “Getting Organized” in the GroupWise 8 Windows Client User 
GuideGroupWise 8 Windows Client Help
“Creating a New Panel” in “Getting Organized” in the GroupWise 8 Linux/Mac Client User 
Guide

2.15  Viewing Teaming Folders as RSS or Atom 
Feeds
RSS and Atom enable you to set up feeds to Teaming folders and view those feeds in one convenient 
location.

You can set up a Novell Teaming folder to be accessed by an RSS or Atom reader, so the Teaming 
folder sends new or modified folder entries to your RSS or Atom reader. This is an easy way to stay 
informed on activity in a certain folder.

For more information, see “Viewing Teaming Folders as RSS or ATOM Feeds” in the Novell 
Teaming 2.1 Advanced User Guide.

2.16  Synchronizing Teaming Task and Calendar 
Folders to a Desktop Calendar Application
iCal functionality in Novell Teaming enables you to synchronize Teaming task folders and calendar 
folders to other task lists and calendars that support the iCal format.

1 Navigate to the Task folder or Calendar folder that you want to synchronize to your desktop 
calendar application.

2 Click the Footer toolbar, located at the bottom of the folder page.
3 In the iCal URL section in the provided table, select and copy the iCal URL.

You use this link to export Teaming calendar data for inclusion in another calendar that 
supports the iCal format (for example, Google* and Outlook*).

4 Paste the iCal URL into the required section of the desktop calendar application.
Consult the documentation for the desktop application for instructions on where to paste the 
iCal URL and complete the synchronization.
 Teaming 2.1 User Guide



3
novdocx (en)  7 January 2010
3Navigating the Teaming Interface

Novell® Teaming provides various methods of navigating the interface.

Section 3.1, “Navigating the Workspace Tree,” on page 43
Section 3.2, “Finding Specific People, Places, or Tagged Items,” on page 43
Section 3.3, “Viewing and Revisiting Recent Places,” on page 44
Section 3.4, “Viewing and Revisiting Recent Entries,” on page 44
Section 3.5, “Using the Favorites Panel,” on page 44
Section 3.6, “Accessing Your Teams,” on page 45
Section 3.7, “Using Tags,” on page 45

3.1  Navigating the Workspace Tree
You can access the Workspace tree from any page within Novell Teaming. Located in the upper left 
corner of the Teaming interface, the Workspace tree displays the path of all of the workspaces and 
folders that contain the place you are currently viewing, without leaving the current page. 

To navigate to another workspace or folder:

1 Click the plus sign (+) next to Home Workspace.
2 Navigate to and click the linked name of the desired location in the Workspace tree.

Teaming displays the desired location.

To view a demonstration of how this is done, see Using the Workspace Tree (http://
www.brainstorminc.com/cbt/teaming/index.php?category=navigation). To display the video, follow 
the link, then click Using the Workspace Tree.

3.2  Finding Specific People, Places, or Tagged 
Items
The Find feature is a quick way to navigate to a certain place within Novell Teaming. Use the Find 
feature to locate people, places, and tags that you know exist on the Teaming site. 

If you are looking for a subject-matter expert, or want to see what information is available 
concerning a particular topic, use the Teaming Search functionality. For more information on Search 
in Teaming, see Section 2.5, “Searching for Information,” on page 29.

Before you begin using Teaming Find functionality, you might want to view the short tutorial video, 
Using Find (http://www.brainstorminc.com/cbt/teaming/index.php?category=navigation). To 
display the video, follow the link, then click Using Find.

The Find feature provides the following fields:

People: Enables you to quickly navigate to a user’s personal workspace.
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Places: Enables you to quickly navigate to any folder or workspace within Teaming. For example, if 
you want to locate a colleague’s Blog folder, simply type blog, then specify the name of your 
colleague. The appropriate place is listed in the drop-down list.

Tags: Enables you to locate any workspaces, folders, or entries that have been tagged. Specify the 
name of the tag that you are searching for, and click the name in the drop-down list. Teaming 
displays all of the workspaces, folders, and entries that have been tagged with that particular tag.

Teaming displays all personal tags, and all community tags for which you have appropriate rights.

When using these fields, Teaming applies the Type-to-Find feature. As you type, Teaming lists items 
matching what you have typed so far (all items matching “d”, then all items matching “di,” for 
example). 

If there is more than one panel of choices, you can click the left-arrow and right-arrow icons to 
review your choices.

3.3  Viewing and Revisiting Recent Places
Novell Teaming provides a Recent Places section, where you can see and quickly revisit the folders 
and workspaces you have most recently accessed.

1 In the main sidebar, in the Recent Places section, click the place that you want to revisit.

The Recent Places section stores your five most recently visited places in your current Teaming 
session.

3.4  Viewing and Revisiting Recent Entries
Novell Teaming enables you to view and quickly revisit the entries that you have recently posted 
and recently visited.

1 Navigate to your personal workspace.
2 Click the Recent Entries tab.

In the left column, Teaming displays the entries that you have recently posted.
In the right column, Teaming displays the entries that you have recently visited.

The Recent Entries tab stores entries that you have recently visited in your current and in previous 
Teaming sessions.

3.5  Using the Favorites Panel
When you click the Favorites drop-down list, Novell Teaming displays the Favorites panel. You can 
add your favorite workspaces and folders to this panel, so you can access them more easily in the 
future.

Before you start working with the Favorites Panel, you might want to view the short tutorial video, 
Creating Favorites (http://www.brainstorminc.com/cbt/teaming/index.php?category=navigation). To 
display the video, follow the link, then click Creating Favorites.

Section 3.5.1, “Accessing Your Favorite Places,” on page 45
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Section 3.5.2, “Adding Places to the Favorites Panel,” on page 45
Section 3.5.3, “Editing the Favorites Panel,” on page 45

3.5.1  Accessing Your Favorite Places
Teaming makes it easy to quickly access your favorite places.

1 Click the Favorites drop-down list, located in the upper right corner of the Teaming interface.
2 Click the linked title of the place that you want to visit.

3.5.2  Adding Places to the Favorites Panel
1 Use the navigation bar or the Workspace tree to view a workspace or folder.
2 After arriving at one of your favorite places, click the Favorites drop-down list.
3 Click Add this place.

3.5.3  Editing the Favorites Panel
The Favorites panel includes tools for organizing links to your favorite places. 

1 Click the Favorites drop-down list, then click Edit Favorites.
2 Select the item you want to edit.
3 Click Down, Up, or Delete.

The Down and Up buttons move the link down or up in your Favorites list.
4 Click OK.

3.6  Accessing Your Teams
Novell Teaming makes it easy to quickly access your team workspaces where you are a member.

1 Click the My Teams drop-down list, located in the upper right corner of the Teaming interface.
This list contains all of the teams of which you are a member.

2 Click the linked title of the team workspace that you want to visit.

To view a demonstration of how this is done, see Setting Up My Teams (http://
www.brainstorminc.com/cbt/teaming/index.php?category=navigation). To display the video, follow 
the link, then click Setting Up My Teams.

3.7  Using Tags
Tags are keywords that categorize a workspace, folder, or entry. Tagging functionality in Novell 
Teaming enables you to create virtual containers for places and entries. Like folders in your e-mail, 
you can categorize information, and then come back to it at a later time.
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Before you begin using tags, you might want to view the short tutorial video, Using Tags (http://
www.brainstorminc.com/cbt/teaming/index.php?category=navigation). To display the video, follow 
the link, then click Using Tags.

Section 3.7.1, “Tagging Workspaces or Folders,” on page 46
Section 3.7.2, “Tagging Entries,” on page 46
Section 3.7.3, “Locating Tagged Items,” on page 46
Section 3.7.4, “Choosing Between Personal Tags and Community Tags,” on page 47

3.7.1  Tagging Workspaces or Folders
1 Navigate to the workspace or folder that you want to tag.
2 In the Tag This Workspace (or Tag This Folder) section of the main sidebar, type the name of 

the tag into the field in either the Personal Tags or Community Tags section. 
To decide whether you want to create a personal or community tag, see Section 3.7.4, 
“Choosing Between Personal Tags and Community Tags,” on page 47.
This field uses Type-to-Find functionality, so if a tag already exists with the desired name, it 
appears in the drop-down list. If the name does not appear in the drop-down list, you are 
creating a new tag.

3 Finish typing the name of the tag, or select it from the drop-down list, then click Add.

The workspace or folder is now marked with the tag that you specified.

3.7.2  Tagging Entries
1 In the entry that you want to tag, click Tag this.
2 Type the name of the tag into the field in either the Personal Tags or Community Tags section. 

To decide whether you want to create a personal or community tag, see Section 3.7.4, 
“Choosing Between Personal Tags and Community Tags,” on page 47.
This field uses Type-to-Find functionality, so if a tag already exists with the desired name, it 
appears in the drop-down list. If the name does not appear in the drop-down list, you are 
creating a new tag.

3 Finish typing the name of the tag, or select it from the drop-down list, then click Add.
The entry is now marked with the tag that you specified.

3.7.3  Locating Tagged Items
Teaming enables you to locate all places and entries that have a particular tag.

1 In the Find section of the Navigation toolbar, in the Tags field, specify the name of the tag that 
you want to search for.

2 Select the tag from the drop-down list.
or
Finish typing the name of the tag, then press Enter.
Teaming displays all of the places and entries that have the tag that you specified.
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3.7.4  Choosing Between Personal Tags and Community Tags
Personal Tags: Personal tags are for your use only. When you create a personal tag, it can be used 
and viewed only by you.

Community Tags: Community tags can be used and viewed by anyone who has rights to view the 
workspace, folder, or entry where a community tag is implemented. For example, if you create a 
community tag on the File folder in your team workspace, then anyone with View rights to the File 
folder can use the tag you created to tag other places with the same tag name. They can also use 
Teaming Search and Find features to locate entries that have been tagged with that tag name.

You can tag places and entries with a community tag only if you have appropriate rights. 

For more information on using Search to locate tagged items, see Section 2.5.2, “Using Advanced 
Search,” on page 30.

For more information on using Find to locate tagged items, see Section 3.2, “Finding Specific 
People, Places, or Tagged Items,” on page 43.
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4Managing and Using Workspaces

Your Novell® Teaming site is made up of various workspaces. Workspaces are designated areas 
where people can work together to accomplish tasks. Teaming supports multiple types of 
workspaces, including personal workspaces, where you can store items such as your personal files, 
calendars, and tasks; and team workspaces, where you can collaborate with team members by 
sharing ideas, files, and more. Other useful types of workspaces are also available for you to use. 

You can see the structure of the workspaces in your Teaming site by expanding Home Workspace 
and browsing the Workspace tree.

Section 4.1, “General Workspace Management,” on page 49
Section 4.2, “Managing Your Personal Workspace,” on page 54
Section 4.3, “Managing a Team Workspace,” on page 57
Section 4.4, “Managing a Discussions Workspace,” on page 61
Section 4.5, “Managing a Project Management Workspace,” on page 61
Section 4.6, “Managing a Landing Page,” on page 62
Section 4.7, “Understanding Global Workspaces,” on page 62

4.1  General Workspace Management
This section contains task information that applies to all types of workspaces.

Section 4.1.1, “Creating a New Workspace,” on page 49
Section 4.1.2, “Deleting a Workspace,” on page 50
Section 4.1.3, “Undeleting a Workspace,” on page 50
Section 4.1.4, “Copying a Workspace,” on page 51
Section 4.1.5, “Moving a Workspace,” on page 51
Section 4.1.6, “Adding a Sub-Workspace,” on page 51
Section 4.1.7, “Adding Additional Folders to a Workspace,” on page 52
Section 4.1.8, “Generating Activity Reports for a Workspace,” on page 52
Section 4.1.9, “Defining a User-Friendly URL for a Workspace,” on page 53
Section 4.1.10, “Customizing the Workspace View,” on page 53
Section 4.1.11, “Branding a Workspace,” on page 54
Section 4.1.12, “Displaying YouTube Videos in a Workspace,” on page 54

4.1.1  Creating a New Workspace
Teaming enables you to create new workspaces in any workspace where you have appropriate 
rights.

1 Navigate to the workspace where you want to create the new workspace.
2 Click Manage > Add New Workspace.
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The Add New Workspace page is displayed.
3 Specify the information.

Not all of the information is displayed for each type of workspace that you are creating.
Workspace Title: Specify a title for the workspace.
If you leave this field blank, the workspace is titled Workspace.
Workspace: Select the type of workspace that you want to create.
Team Members: (Conditional) This section is displayed only if you are creating a team 
workspace. Use this section to specify users and groups that you want to include as members of 
your team workspace.
Workspace Folders: Use this section to select the folders that you want the workspace to 
contain.
Announcement: (Optional) Create an announcement message to be sent to all members of the 
team.
If you are not creating a team workspace, this message is sent to all team members of the parent 
workspace.

4 Click OK.

4.1.2  Deleting a Workspace
1 Navigate to the workspace that you want to delete.
2 Click Manage > Delete This Workspace.

The Delete This Workspace page is displayed.
3 (Optional) Select Purge this workspace immediately if you want to purge the workspace so that 

it cannot be recovered.

NOTE: Selecting this option renders the workspace unrecoverable and it is permanently 
deleted from the Teaming site.

If you do not select this option, you can undelete the workspace as described in Section 4.1.3, 
“Undeleting a Workspace,” on page 50.

4 (Conditional) (Optional) If the workspace contains mirrored folders, you can select to delete 
the source files of the folders, and also all of the mirrored folders’ sub-folders.
For more information on working with mirrored folders, see “Working with Mirrored Folders” 
in the Novell Teaming 2.1 Advanced User Guide.

5 Click OK.

4.1.3  Undeleting a Workspace
Teaming enables you to undelete a workspace that you previously deleted, restoring it to its previous 
location.

1 Navigate to the workspace where the deleted workspace previously resided.
For example, if you want to restore a team workspace that was in the Team Workspaces 
directory, navigate to the Team Workspaces directory.
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TIP: If you want to see everything that has been deleted in the Teaming site, navigate to the 
highest level workspace. (By default this is the Home Workspace directory.)

2 Click the Trash icon , located in the Workspace toolbar.
The Trash page displays all workspaces, folders, and entries that have been deleted in or below 
the current workspace.

3 Select the workspace that you want to undelete.
4 Click Restore.

The workspace is restored to its previous location.

For more information about undeleting, see “Restoring Deleted Items” in the Novell Teaming 2.1 
Advanced User Guide.

4.1.4  Copying a Workspace
1 Navigate to the workspace that you want to copy.
2 Click Manage > Copy This Workspace.

The Copy Workspace page is displayed.
3 Use one of the following methods to copy the workspace:

Select the Destination Folder or Workspace: Use the Workspace tree to navigate to and 
select the folder or workspace where you want to copy the workspace.
Find the Destination Folder or Workspace: In the provided field, specify the name of 
the folder or workspace where you want to copy the workspace.

4 Click OK.

4.1.5  Moving a Workspace
Teaming enables you to move a workspace into any folder or workspace where you have appropriate 
rights.

1 Navigate to the workspace that you want to move.
2 Click Manage > Move This Workspace.

The Move Workspace page is displayed.
3 Use one of the following methods to move the workspace:

Select the Destination Folder or Workspace: Use the Workspace tree to navigate to and 
select the folder or workspace where you want to move the workspace.
Find the Destination Folder or Workspace: In the provided field, specify the name of 
the folder or workspace where you want to move the workspace.

4 Click OK.

4.1.6  Adding a Sub-Workspace
Teaming enables you to create sub-workspaces inside of existing workspaces.

1 Navigate to the workspace where you want to add the sub-workspace.
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2 Click Manage > Add New Workspace.
The Add New Workspace page is displayed.

3 Specify the information.
Not all of the information is displayed for each type of workspace that you are creating.
Workspace title: Specify a title for the workspace.
If you leave this field blank, the workspace is titled Workspace.
Team Members: (Conditional) This section is displayed only if you are creating a team 
workspace. Use this section to specify users and groups that you want to include as members of 
your team workspace.
Workspace: Select the type of workspace that you want to create.
Workspace Folders: Use this section to select the folders that you want the workspace to 
contain.
Announcement: (Optional) Create an announcement message to be sent to all members of the 
team.
If you are not creating a team workspace, this message is sent to all team members of the parent 
workspace.

4 For information on filling in this page, see Section 4.1.1, “Creating a New Workspace,” on 
page 49.

4.1.7  Adding Additional Folders to a Workspace
Teaming enables you to add additional folders to your workspace at any time.

1 Navigate to the workspace where you want to add the new folders.
2 Click Manage > Add new folder.

The Add New Folder page is displayed.
3 Specify the following information:

Folder Title: Specify a title for the folder.
If you do not provide a title, the folder is given the default folder name. For example, a 
Discussion folder is named Discussion.
Folder: Select the type of folder that you want to create.
For information about each type of folder, see Chapter 6, “Working with Specific Folder 
Types,” on page 73.

4 Click OK.

4.1.8  Generating Activity Reports for a Workspace
Teaming enables you to generate reports about the activity that has occurred in a particular 
workspace.

1 Navigate to the workspace that you want to generate the activity report for.
2 Click Manage > Activity Reports.

The Folder Activity page is displayed.
3 Specify the following information:
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Report on Activity Between: Select the date range for which you want to generate the activity 
report.
Report Workspace or Folder Activity: Select this option to see how many views, adds, 
modifies, and deletes have been made in the folder. You can generate a report for the following 
categories of users:

Team Members: View the workspace activity of individual team members only.
All Users: View the workspace activity of all Teaming users. This option shows the name 
of each user who has had some type of activity in the workspace.
Summary: View a summary of all the activity that has occurred in the workspace. This 
option does not list individual users.

Report on Workflow State: Select this option to view the activity of a workflow. You can 
select to show the average amount of time the workflow spent in each state, or show the 
number of entries that are currently in each state.
Select the Folders for Reporting: Select the folders about which you want to generate the 
activity report. If you select the workspace, then Teaming generates an activity report that 
includes all folders in the workspace.

4 Click OK.
Teaming launches the report in a spreadsheet. For information regarding the columns in this 
spreadsheet, see Section 7.10.1, “Activity Reports,” on page 97.

4.1.9  Defining a User-Friendly URL for a Workspace
When you define a user-friendly URL for your workspace, it can make it easier for others to easily 
navigate to the workspace.

1 Navigate to the workspace where you want to define the URL.
2 In the Workspace toolbar, click Manage > Configure.

The Configure Default Settings page is displayed.
3 In the Define a simple URL for this folder or workspace section, select one of the predefined 

global keywords from the Define URL drop-down list.
Unless you are a site administrator, your URL must begin with one of these predefined global 
keywords.

4 In the provided field, specify the desired URL for the folder or workspace.
5 Click Add > Close.

To delete a defined URL, select the URL in the Currently defined URLs section, then click Delete 
the selected URLs.

4.1.10  Customizing the Workspace View
Teaming enables you to customize the layout of your workspace. For more information, see 
“Creating Custom Workspace Views” in the Novell Teaming 2.1 Advanced User Guide.
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4.1.11  Branding a Workspace
Branding a workspace is a good way to make the workspace more unique and identifiable. When 
you brand a workspace, the brand is also applied to all sub-workspaces and sub-folders.

For more information on branding, see “Branding a Folder or Workspace” in the Novell Teaming 2.1 
Advanced User Guide.

4.1.12  Displaying YouTube Videos in a Workspace
Teaming enables you to display YouTube* videos in a workspace. This section describes how to 
display YouTube videos in the Description section of the workspace. For information on how to 
display YouTube videos in the Branding section of a workspace, see “Branding a Folder or 
Workspace” in the Novell Teaming 2.1 Advanced User Guide.

To display a YouTube video in the Description section of a workspace:

1 Navigate to the workspace where you want to display the YouTube video.
2 In the Workspace toolbar, click Manage > Modify This Workspace.
3 In the Description section, click the Video icon .
4 In the provided window, in the YouTube URL field, paste the URL of the YouTube video that 

you want to post.
5 In the Dimensions fields, do not make any changes if you want to keep the default YouTube 

dimensions.
6 Click Insert, then click OK to display the video in the workspace.

For more information about displaying YouTube videos in Teaming, see Section 7.15, “Displaying 
YouTube Videos in a Folder Entry,” on page 101.

4.2  Managing Your Personal Workspace
Your personal workspace in Novell Teaming is a place where you can store your personal files, 
blogs, photos, and all other types of Teaming folder entries.

Your personal workspace also includes relevance tabs that help you easily keep track of tasks and 
calendar events, get informed on new entries, view shared items, and more.

The relevance tabs are located in the home page of your personal workspace. These tabs enable you 
to get quick access to important information that pertains directly to you.

Before you begin working in your personal workspace, you might want to view the short tutorial 
video, Exploring Your Personal Workspace (http://www.brainstorminc.com/cbt/teaming/
index.php?category=gettingstarted). To display the video, follow the link, then click Exploring Your 
Personal Workspace.

Section 4.2.1, “Using the Overview Tab,” on page 55
Section 4.2.2, “Using the What’s New Tab,” on page 55
Section 4.2.3, “Using the Tasks and Calendars Tab,” on page 55
Section 4.2.4, “Viewing Recently Posted and Recently Visited Entries,” on page 56
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Section 4.2.5, “Using the Micro-Blogs and Shared Items Tab,” on page 56
Section 4.2.6, “Viewing Your Profile Information,” on page 57

4.2.1  Using the Overview Tab
The Overview tab contains an accessory panel. You can use this accessory panel to make items in 
your personal workspace more visible. For example, by default, the Overview tab contains a 
Guestbook accessory that references the Guestbook folder in your personal workspace. By 
displaying this accessory in the Overview tab, you don’t need to view the Guestbook folder in order 
to see who has signed your Guestbook.

 By default, a Task, Guestbook, Blog, and Photo Album accessory exist in this accessory panel, but 
you can add more as you desire. (For information on how to add additional accessories, see 
Section 8.2, “Creating an Accessory,” on page 109.)

4.2.2  Using the What’s New Tab
Use the What’s New tab to accomplish the following tasks:

“Finding What’s New” on page 55
“Finding What’s Hot” on page 55

Finding What’s New

The What’s New tab enables you to find what’s new in your teams, tracked places, or the entire site.

1 In the home page of your personal workspace, click the What’s New tab.
2 Select My Teams, Tracked Places, or Site Wide, depending on where you want Teaming to 

search for new items.
All of the new items recently added are displayed in the left side of the page, in the What’s New 
section.

Finding What’s Hot

The What’s New tab enables you to find the entries and folders that are most popular in your 
Teaming site.

1 In the home page of your personal workspace, click the What’s New tab.
2 Select Site Wide.

The most popular items in your Teaming site are displayed in the right side of the page, in the 
What’s Hot Site Wide section.

4.2.3  Using the Tasks and Calendars Tab
Use the Tasks and Calendars tab to accomplish the following tasks:

“Viewing Your Tasks” on page 56
“Viewing Today’s Calendar Events” on page 56
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Viewing Your Tasks

To help you keep track of tasks that have been assigned to you, Teaming provides a quick, easy way 
to view tasks.

1 In the home page of your personal workspace, click the Tasks and Calendars tab.
In the left column, Teaming displays the tasks that are assigned to you. You can sort these tasks 
by tasks due within two weeks, or any tasks that are currently assigned to you.

Viewing Today’s Calendar Events

To help you keep track of your calendar events, Teaming enables you to view all of the calendar 
events for which you are scheduled on the current day. 

1 In the home page of your personal workspace, click the Tasks and Calendars tab.
The right section of the page displays today’s schedule with all of the calendar events from all 
of your tracked calendars.

4.2.4  Viewing Recently Posted and Recently Visited Entries
Teaming enables you to view which entries you have most recently posted, and which entries you 
have most recently visited. This can help you remember what you have currently been working on, 
or quickly locate an entry that you have recently created or viewed.

1 In the home page of your personal workspace, click the Recent Entries tab.
The left section of the page displays the entries that you have recently posted, and the right 
section of the page displays the entries that you have recently visited.

4.2.5  Using the Micro-Blogs and Shared Items Tab
Use the Micro-Blogs and Shared Items tab to accomplish the following tasks:

“Viewing the Micro-Blog Entries of People You Are Tracking” on page 56
“Viewing What Others Have Shared With You” on page 56

Viewing the Micro-Blog Entries of People You Are Tracking

1 In the home page of your personal workspace, click the Micro-Blogs and Shared Items tab.
The Micro-Blogs column lists the micro-blog entries of the people you are currently tracking.

Viewing What Others Have Shared With You

When others share an item with you, Teaming sends you an e-mail notification with a link to the 
item. Also, Teaming makes it easy to find items that others have shared with you, directly from the 
Teaming interface.

1 In the home page of your personal workspace, click the Micro-Blogs and Shared Items tab.
In the right column, Teaming lists all of the items that people have shared with you.
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4.2.6  Viewing Your Profile Information
1 In the home page of your personal workspace, click the Profile tab.

Your personal profile information is displayed.

For information on modifying your profile information, see Section 1.5.1, “Modifying Your 
Profile,” on page 19.

4.3  Managing a Team Workspace
Team workspaces are the key to helping you and your team accomplish tasks and meet objectives, 
together.

As the owner of a workspace, you are primarily responsible for workspace administration. You can 
create other containers for information (sub-workspaces and folders), adjust access control to 
determine who can do what in the workspace, and provide some initial content to assist team 
members with getting started.

Section 4.3.1, “Creating a Team Workspace,” on page 57
Section 4.3.2, “Adding Additional Team Members to Your Workspace,” on page 59
Section 4.3.3, “Sending E-Mail to Team Members and Announcing the Workspace After Its 
Creation,” on page 60
Section 4.3.4, “Starting or Scheduling a Team Meeting,” on page 60
Section 4.3.5, “Viewing Team Members,” on page 60
Section 4.3.6, “Allowing Visitors to Your Team Workspace,” on page 61

4.3.1  Creating a Team Workspace
By default, everyone in Teaming has rights to create a team workspace.

Team workspaces are the most common type of workspaces. They facilitate team objectives by 
enabling team members to quickly share files, share ideas, and work together more efficiently and 
effectively.

Novell Teaming enables you to create a highly visible team workspace in the Team Workspaces 
directory, or you can create a nested team workspace, which is a team workspace inside of an 
existing team workspace.

Before you begin creating a team workspace, you might want to view the short tutorial video, 
Building a Team Workspace (http://www.brainstorminc.com/cbt/teaming/
index.php?category=gettingstarted). To display the video, follow the link, then click Building a 
Team Workspace.

“Creating a Highly Visible Team Workspace” on page 58
“Creating a Team Workspace inside of an Existing Team Workspace” on page 58
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Creating a Highly Visible Team Workspace

If you want your team workspace to be highly visible and easy to find in the workspace tree, create 
the team workspace in the Team Workspaces directory.

1 Expand Home Workspace in the Workspace Tree Navigation tool, located near the top of the 
Teaming interface.
The Home Workspace directory is the highest-level folder in the workspace tree, and might be 
named something specific to your organization.

2 Click Team Workspaces.
3 Click Add a Team Workspace.

The Add a Team Workspace page is displayed.
If you do not see this option, your site administrator has not permitted you to create a new 
workspace at this level. Continue to expand the workspace tree, following the path of your 
organizational unit, then click the name of the directory where you want to create the new team 
workspace. Or, follow the steps in “Creating a Team Workspace inside of an Existing Team 
Workspace” on page 58.

4 Specify the following information:
Workspace Title: Provide a title for the workspace. 
Team Members: Specify the team members.
You can specify individual users, entire groups, or add names that are on your clipboard. For 
more information about using the Teaming clipboard, see Section 9.5, “Using the Teaming 
Clipboard,” on page 123.
Workspace Folders: Select the folders that you want the workspace to contain.
If you later decide that you want to add additional folders, you can add them at any time.
For information on how to add folders to an existing workspace, see Section 4.1.7, “Adding 
Additional Folders to a Workspace,” on page 52.
Announcement: (Optional) Select the check box, then type a message in the Announcement 
Text field. 
This message informs team members about the existence of the workspace, and can also 
explain the value of the workspace.

5 Click OK to create the new workspace.

Creating a Team Workspace inside of an Existing Team Workspace

Teaming enables you to create nested workspaces, which are workspaces inside of other 
workspaces. You can create a team workspace inside of any existing workspace where you have 
appropriate rights. 

You might want to do this if you are not concerned about having high visibility in the workspace 
tree, and if the team workspace that you want to create consists mostly of members that already 
belong to a certain workspace.

1 Navigate to the workspace where you want to create the new team workspace.
2 Click Manage > Add New Workspace.

The Add New Workspace page is launched.
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3 In the Workspace section, select Team Workspace.
You can also create a basic workspace, a project management workspace, and a discussions 
workspace.

4 Specify the following information:
Workspace Title: Specify a title for the workspace.
Team Members: Specify the team members.
You can specify individual users, entire groups, or add names that are on your clipboard. For 
more information about using the Teaming clipboard, see Section 9.5, “Using the Teaming 
Clipboard,” on page 123. 
You can also click Team Members. This displays a list of all of the members of the team 
workspace where you are creating your new team workspace. Select the names of the users that 
you want to include in your new team workspace.
Workspace Folders: Select the folders that you want the workspace to contain.
If you later decide that you want to add additional folders, you can add them at any time.
For information on how to add folders to an existing workspace, see Section 4.1.7, “Adding 
Additional Folders to a Workspace,” on page 52.
Announcement: (Optional) Select the check box, then type a message in the Announcement 
Text field. 
This message informs team members about the existence of the workspace, and can also 
explain the value of the workspace.

5 Click OK to create the new workspace.

4.3.2  Adding Additional Team Members to Your Workspace
After you create your workspace, you can add other Novell Teaming users who need to join your 
team.

Before you begin adding team members to your workspace, you might want to view the short 
tutorial video, Adding Members to a Team Workspace (http://www.brainstorminc.com/cbt/teaming/
index.php?category=gettingstarted). To display this video, follow the link, then click Adding 
Members to a Team Workspace.

1 Navigate to the team workspace where you want to add the additional team members.
2 In the sidebar, in the Team section, click Manage Team.

The Add or Delete Team Members page is launched.
3 (Conditional) If this workspace is currently inheriting its team membership from a parent 

folder, click Yes.
4 In the Users field, specify the names of the individual users that you want to add to the team.

You can also specify entire groups in the Groups field, or you can add names that are on your 
clipboard by clicking Clipboard User Names. For more information about using the Teaming 
clipboard, see Section 9.5, “Using the Teaming Clipboard,” on page 123.

5 Click OK.

You can announce the workspace to the new team members. For information on how to do this, see 
Section 4.3.3, “Sending E-Mail to Team Members and Announcing the Workspace After Its 
Creation,” on page 60.
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4.3.3  Sending E-Mail to Team Members and Announcing the 
Workspace After Its Creation
Teaming enables you to send e-mail messages to your entire team. Also, if new team members join 
the team after the team workspace has already been created, you can use this functionality to 
announce the workspace to the new team members.

To send mail to team members:

1 Navigate to the team workspace.
2 In the sidebar, in the Team section, click Send E-Mail To Team.

The Send E-Mail page is displayed.
3 Fill in the appropriate fields.

For information on filling in the rest of the Send E-Mail form, see Section 9.4, “Filling Out the 
Send E-Mail Page,” on page 123.

4 Click OK.

4.3.4  Starting or Scheduling a Team Meeting
If you have Novell Conferencing, you can start or schedule a team meeting.

1 Navigate to the team workspace that contains the team members with whom you want to meet.
2 In the main sidebar, click Team > Start a Team Meeting.

The Add meeting page is displayed.
3 In the Team Members section, deselect any team members that you do not want to invite to the 

meeting.
By default, all members of the team are selected.

4 Click Start Meeting Now, or Schedule for Later, depending on when you want to meet.
The Conferencing client is launched.
For more information about how to use Novell Conferencing, see the Novell Conferencing 
User Guide (http://www.novell.com/documentation/team_plus_conf/conf10_user/data/
bookinfo.html).

4.3.5  Viewing Team Members
“Viewing Team Members in an Accessory from the Workspace Home Page” on page 60
“Viewing Team Members from Any Page within The Workspace” on page 61

Viewing Team Members in an Accessory from the Workspace Home Page

Accessories are sections at the top of workspaces and folders that provide summary information for 
you. For more information on working with accessories, see Chapter 8, “Managing Accessories,” on 
page 107.

By default, Novell Teaming includes a team-membership accessory on the home page of your 
workspace. This accessory displays all team members.
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Viewing Team Members from Any Page within The Workspace

You can view the members of the team from any folder within the workspace:

1 On any page within the workspace, click Team > View Team in the main sidebar.

4.3.6  Allowing Visitors to Your Team Workspace
By default, only team members can view and participate in the workspaces and folders contained in 
the team workspace. There might be times when you want to allow other people to visit your team 
workspace (which, by default, means that they can read entries and comment on them, but they 
cannot create entries).

To allow visitors to your team workspace:

1 Navigate to the team workspace where you want to allow visitors.
2 Click Manage > Access Control.

Teaming displays the Configure Access Control page for the team workspace.
3 Ensure that the workspace is not inheriting its access control settings. Select the no radio 

button, then click Apply.
4 (Conditional) If Visitor is not already a column in the provided table, click Add a role > Visitor:
5 On the left side of the table, click Add a User, and use the type-to-find feature to select the 

name of the person who you want to add as a visitor to the team workspace.
6 In that new user’s row, select the check box in the Visitor column.
7 Repeat Step 5 and Step 6 until you have added all your visitors.
8 Click Save Changes > Close.

The people for whom you selected the Visitor role now have the right to view your team workspace 
and to add comments to existing entries. They cannot create new entries.

For more information on managing access control, see “Managing Access Control for Users and 
Groups” in the Novell Teaming 2.1 Advanced User Guide.

4.4  Managing a Discussions Workspace
Create a Discussions workspace if you want a place to store multiple discussion forums. This can 
help organize your Teaming site, so users know where they should go if they are looking for a 
particular discussion forum.

For more information on Discussions workspaces, see “Creating and Managing a Discussions 
Workspace” in the Novell Teaming 2.1 Advanced User Guide.

4.5  Managing a Project Management Workspace
Project Management workspaces are optimized for managing a project.

Project Management workspaces include special accessories that help a leader to track the progress 
of task completion for a potentially large project. Although project workspaces can contain any type 
of folder, they are specifically designed to work in conjunction with task and milestone folders.
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For more information on Project Management workspaces, see “Creating and Managing a Project 
Management Workspace” in the Novell Teaming 2.1 Advanced User Guide.

4.6  Managing a Landing Page
Novell Teaming enables you to configure a workspace to have a landing page. When you create a 
workspace landing page, you can populate that landing page with entries that exist within the 
workspace. 

For information on how to create a landing page on a workspace, see “Creating and Managing 
Landing Pages” in the Novell Teaming 2.1 Advanced User Guide.

4.7  Understanding Global Workspaces
Global workspaces contain information that might be of interest throughout your organization.

For more information on global workspaces, see “Creating Global Workspaces” in the Novell 
Teaming 2.1 Administration Guide.
 Teaming 2.1 User Guide



5
novdocx (en)  7 January 2010
5Managing and Using Folders

The topics in this section describe how to perform management functions for all types of Novell® 
Teaming folders. 

Most functions are the same, regardless of the type of folder that you are managing. However, some 
management functions are unique to individual folder types. These functions are described in 
Chapter 6, “Working with Specific Folder Types,” on page 73.

Section 5.1, “Creating a New Folder,” on page 63
Section 5.2, “Deleting a Folder,” on page 64
Section 5.3, “Undeleting a Folder,” on page 64
Section 5.4, “Copying a Folder,” on page 65
Section 5.5, “Moving a Folder,” on page 65
Section 5.6, “Importing Files into a Folder,” on page 65
Section 5.7, “Accessing WebDAV Files from within Teaming,” on page 66
Section 5.8, “Generating an Activity Report on a Folder,” on page 68
Section 5.9, “Subscribing to E-Mail Notifications from a Folder,” on page 68
Section 5.10, “Setting Up a Folder to Receive Entries Via E-Mail,” on page 68
Section 5.11, “Adding Entries to a Folder Via E-Mail,” on page 69
Section 5.12, “Changing the Folder View,” on page 69
Section 5.13, “Branding a Folder,” on page 70
Section 5.14, “Displaying YouTube Videos in a Folder,” on page 70
Section 5.15, “Using Filters on Teaming Folders,” on page 70
Section 5.16, “Listing Folder Entries and Pages,” on page 72

5.1  Creating a New Folder
Teaming enables you to create folders in any workspace where you have appropriate rights.

1 Navigate to the workspace where you want to create the new folders.
2 Click Manage > Add New Folder.

The Add New Folder page is displayed.
3 Specify the following information:

Folder Title: Specify a title for the folder.
If you do not provide a title, the folder is given the default folder name. For example, a 
Discussion folder is named Discussion.
Folder: Select the type of folder that you want to create.
For information about each type of folder, see Chapter 6, “Working with Specific Folder 
Types,” on page 73.

4 Click OK.
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To view a demonstration of how this is done, see Creating a Folder (http://www.brainstorminc.com/
cbt/teaming/index.php?category=gettingstarted). To display the video, follow the link, then click 
Creating a Folder.

5.2  Deleting a Folder
1 Navigate to the folder that you want to delete.
2 Click Manage > Delete This Folder.

The Delete This Folder page is displayed.
3 (Optional) Select Purge this folder immediately if you want to purge the folder so that it cannot 

be recovered.

NOTE: Selecting this option renders the folder unrecoverable and it is permanently deleted 
from the Teaming site.

If you do not select this option, you can undelete the folder as described in Section 5.3, 
“Undeleting a Folder,” on page 64.

4 (Conditional) (Optional) If the folder is a mirrored folder, you can select to delete the source 
files of the folder, and also all of the mirrored folders’ sub-folders.
For more information on working with mirrored folders, see “Working with Mirrored Folders” 
in the Novell Teaming 2.1 Advanced User Guide.

5 Click OK.

5.3  Undeleting a Folder
Teaming enables you to undelete a folder that you previously deleted, restoring it to its previous 
location.

1 Navigate to the folder or workspace where the deleted folder previously resided.
For example, if you want to restore a Blog folder that was in your personal workspace, navigate 
to your personal workspace.

TIP: If you want to see everything that has been deleted in the Teaming site, navigate to the 
highest level workspace. (By default this is the Home Workspace directory.)

2 Click the Trash icon , located in the Workspace or Folder toolbar.
The Trash page displays all workspaces, folders, and entries that have been deleted in or below 
the current workspace or folder.

3 Select the folder that you want to undelete.
4 Click Restore.

The folder is restored to its previous location. Contents of the folder are not automatically 
restored.

For more information about undeleting, see “Restoring Deleted Items” in the Novell Teaming 2.1 
Advanced User Guide.
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5.4  Copying a Folder
1 Navigate to the folder that you want to copy.
2 Click Manage > Copy This Folder.

The Copy Folder page is displayed.
3 Use one of the following methods to copy the folder:

Select the Destination Folder or Workspace: Use the Workspace tree to navigate to and 
select the folder or workspace where you want to copy the folder.
Find the Destination Folder or Workspace: In the provided field, specify the name of 
the folder or workspace where you want to copy the folder.

4 Click OK.

5.5  Moving a Folder
Teaming enables you to move a folder into any folder or workspace where you have appropriate 
rights.

1 Navigate to the folder that you want to move.
2 Click Manage > Move This Folder.

The Move Folder page is displayed.
3 Use one of the following methods to move the folder:

Select the Destination Folder or Workspace: Use the Workspace tree to navigate to and 
select the folder or workspace where you want to move the folder.
Find the Destination Folder or Workspace: In the provided field, specify the name of 
the folder or workspace where you want to move the folder.

4 Click OK.

5.6  Importing Files into a Folder
Teaming enables you to import files from any location and add them to a folder in your workspace. 
There are two ways to do this.

Section 5.6.1, “Dragging and Dropping Files,” on page 65
Section 5.6.2, “Importing Files into the File Folder,” on page 66
Section 5.6.3, “Importing Files as Entry Attachments,” on page 66

5.6.1  Dragging and Dropping Files
Teaming enables you to drag files from any location, and drop them into any Teaming folder.

1 Navigate to the folder where you want to import the files.
2 Click Add Files to Folder in the Folder Entry toolbar.

The drag-and-drop window opens.
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3 Drag a file from one location, such as your desktop, and drop it onto the folder icon in the drag-
and-drop window.
This adds the document as a new file entry. The name of the document is automatically the 
name of the entry.

5.6.2  Importing Files into the File Folder
For specific information about File folders in Teaming, see Section 6.5, “Working with File 
Folders,” on page 78.

You can import single files into a File folder by browsing your computer’s file system and creating a 
new file entry.

1 Navigate to the File folder where you want to import the file.
2 Click Add File Entry in the Folder Entry toolbar.
3 Click Browse, then browse to and select the file that you want to import.
4 Add a description of the file in the Description field, then click OK.

5.6.3  Importing Files as Entry Attachments
If you want to add files to a folder other than a File folder, you can browse for the file by adding an 
entry to the folder, then adding the file as an attachment to the entry.

For more information about attaching files to entries, see Section 7.14, “Attaching Files to a Folder 
Entry,” on page 100.

5.7  Accessing WebDAV Files from within 
Teaming
WebDAV is a standard collaborative editing and file management tool. Teaming supports the use of 
WebDAV tools, and enables you to manage your WebDAV files from within Teaming.

Section 5.7.1, “Prerequisites for Using WebDAV,” on page 66
Section 5.7.2, “Accessing Files Through WebDAV,” on page 67

5.7.1  Prerequisites for Using WebDAV
Teaming enables WebDAV tools only in the following environments:

Windows: When using Internet Explorer Version 7.0 or later as your Web browser, and you are 
using Microsoft* Windows* XP as your operating system.

Linux: When using SUSE® Linux Enterprise Desktop (SLED) 10 or SUSE Linux Enterprise 
Desktop 11 via Nautilus.
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5.7.2  Accessing Files Through WebDAV
Accessing a file folder through WebDAV is not exactly the same as accessing files in a standard disk 
folder. This is because Teaming entries are more rich than typical files in a folder. For example, files 
in Teaming can contain multiple versions and comment threads; likewise, each Teaming entry can 
contain multiple files, or no files at all.

When you use WebDAV files from within Teaming, you might need to specify your Teaming 
username and password several times. WebDAV requires several passwords for applications (your 
browser and Teaming), and it might require a third login when accessing an individual file.

While running Novell Access Manager on your server, you might be required to sign in multiple 
times as you access WebDAV files from within Teaming. Multiple sign-ins using WebDAV are 
triggered by the client, not by server software.

You can access WebDAV tools from within a Teaming folder, or from an individual entry.

“Accessing WebDAV from a Folder” on page 67
“Accessing WebDAV from an Entry” on page 67

Accessing WebDAV from a Folder

1 Navigate to the File folder where you want to use WebDAV.
2 In the Footer toolbar, click View this folder as a WebDAV folder.

Teaming invokes a WebDAV window. If the window is not operable, consult with the folder 
owner or administrator to ensure that the configuration supports WebDAV (folder filenames 
must be unique).

Accessing WebDAV from an Entry

Teaming enables you to use WebDAV to access entry attachments.

1 Navigate to and select the entry where you want to access the attachment from Teaming using 
WebDAV.

2 In the Attachments section of the entry, click Access Attachments Using WebDAV.
3 Specify your Teaming login credentials.

Your WebDAV client, such as Windows Explorer, is launched.
4 In the Windows Explorer window, navigate to and select the file that you want to retrieve from 

Teaming.
5 Perform the desired action on the file. For example, you can:

View the file.
Drag the file and copy it onto the desktop.
Delete the file.
This deletes the attachment file only. It does not delete the entry itself.

NOTE: If you map a Teaming folder to a WebDAV client such as Windows Explorer or 
Nautilus, then deleting a file from the Teaming folder via the WebDAV client deletes the 
entire entry, including all files contained in the entry.
Managing and Using Folders 67



68 Novell

novdocx (en)  7 January 2010
5.8  Generating an Activity Report on a Folder
1 Navigate to the folder about which you want to generate the activity report.
2 In the Folder toolbar, click Manage > Activity Reports.

The Folder Activity page is displayed.
3 Select the date range for which you want to generate the activity report.
4 Choose between the following options:

Report Workspace or Folder Activity: Select this option to see how many views, adds, 
modifies, and deletes have been made in the folder. You can generate a report for the following 
categories of users:

Team Members: View the folder activity of individual team members only.
All Users: View the folder activity of all Teaming users. This option shows the name of 
each user who has had some type of activity in the folder.
Summary: View a summary of all the activity that has occurred in the folder. This option 
does not list individual users.

Report on Workflow State: Select this option if you want to view a report on workflows in 
the folder. You can select to show the average time entries spent in each workflow state, or the 
number of entries that are currently in each state.

5 In the Select the Folders for Reporting section, navigate to and select the folders for which you 
want to generate the report. You can select multiple folders.

6 Click OK.
Teaming launches the report in a spreadsheet. For information regarding the columns in this 
spreadsheet, see Section 7.10.1, “Activity Reports,” on page 97.

You can run activity reports on individual entries. For information on how to do this, see 
Section 7.10, “Generating Reports about a Folder Entry,” on page 97.

5.9  Subscribing to E-Mail Notifications from a 
Folder
You can configure a folder to send you e-mail notifications to inform you about activity that takes 
place in the folder.

For information on how to subscribe to receive e-mail notifications from a folder, see Section 2.12, 
“Subscribing to a Folder or Entry,” on page 38.

5.10  Setting Up a Folder to Receive Entries Via 
E-Mail
Before you can add e-mail and text message entries to a folder, as described in Section 5.11, 
“Adding Entries to a Folder Via E-Mail,” on page 69, you first need to set up the folder to allow 
such entries.
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Your Teaming administrator can disable this feature. If you have rights to add entries to a particular 
folder, but are unable to do so through your e-mail, as described in this section, contact your 
Teaming administrator.

1 Navigate to the folder where you want to define the URL.
2 Click Manage > Configure.
3 In the Define a simple URL for this folder or workspace section, enter the URL that you want to 

use to reference the folder in the Define URL field. 
4 Click Add.
5 Select Allow e-mail posts to this folder via the following addresses.
6 Click Apply, then click Close.

You can now make entries to the folder via e-mail and text message. For information on how to do 
this, see Section 5.11, “Adding Entries to a Folder Via E-Mail,” on page 69.

5.11  Adding Entries to a Folder Via E-Mail
Teaming enables you to e-mail entries into folders. This is useful if you don’t have access to the 
Teaming site and you still want to create an entry. You can also text-message entries into folders, so 
when you don’t have access to a computer or the Internet, you can still capture thoughts and 
contribute to conversations.

To e-mail entries into folders, you must have appropriate rights, and you must know the previously 
defined e-mail address for the folder.

If you are the folder owner and want to define an e-mail address for the folder, see Section 5.10, 
“Setting Up a Folder to Receive Entries Via E-Mail,” on page 68 for instructions on how to do this.

To see the e-mail address of a folder:

1 Navigate to the folder where you want to add entries via e-mail.
2 Click the Footer toolbar, located at the bottom of the folder page.

In the E-Mail Addresses section of the provided table, the e-mail address of the folder is 
displayed.
This is the e-mail address that you use to make entries to the folder via e-mail.

5.12  Changing the Folder View
Teaming enables you to change the view of a folder. For example, if you are viewing your Calendar 
folder in the default Calendar view, you can change the view to the Task folder view. You can also 
change the default view of the folder, so no other options are available to those who want to view the 
folder.

Anyone who has access to a folder can change the view of the folder, if the folder owner or someone 
with appropriate rights has configured the folder to allow alternate folder views. 

If you are the owner of a folder and you want to allow alternate views on a folder, or if you want to 
change the default view of a folder, see “Managing Folder Views” in the Novell Teaming 2.1 
Advanced User Guide.
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To change the view of a folder after the folder owner has configured it to support alternate folder 
views:

1 Navigate to the folder where you want to change the view.
2 In the main sidebar, in the Folder Options section, click the Folder View drop-down list.

All of the folder views that have been enabled on the folder are displayed.
3 Click the view that you want to change the folder to.

The folder view is changed to the view that you specified.

5.13  Branding a Folder
Branding a folder is a good way to make the folder more unique and identifiable. When you brand a 
folder, the brand is applied to all sub-workspaces and sub-folders.

For more information on branding, see “Branding a Folder or Workspace” in the Novell Teaming 2.1 
Advanced User Guide.

5.14  Displaying YouTube Videos in a Folder
Novell Teaming enables you to display YouTube videos in a folder. This section describes how to 
display YouTube videos in the Description section of the folder. For information on how to display 
YouTube videos in the Branding section of a folder, see “Branding a Folder or Workspace” in the 
Novell Teaming 2.1 Advanced User Guide.

To display a YouTube video in the Description section of a folder:

1 Navigate to the folder where you want to display the YouTube video.
2 In the Folder toolbar, click Manage > Modify This Folder.
3 In the Description section, click the Video icon .
4 In the provided window, in the YouTube URL field, paste the URL of the YouTube video that 

you want to post.
5 In the Dimensions fields, do not make any changes if you want to keep the default YouTube 

dimensions.
6 Click Insert, then click OK to display the video in the folder.

For more information about displaying YouTube videos in Teaming, see Section 7.15, “Displaying 
YouTube Videos in a Folder Entry,” on page 101.

5.15  Using Filters on Teaming Folders
Many types of folders in Novell Teaming provide a filter that helps you quickly sift through 
information in your folder.

Section 5.15.1, “Creating a Filter,” on page 71
Section 5.15.2, “Applying an Existing Filter,” on page 71
Section 5.15.3, “Modifying a Filter,” on page 71
Section 5.15.4, “Deleting a Filter,” on page 71
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5.15.1  Creating a Filter
In the Filter section, Teaming enables you to create multiple filters in your folder. You can easily 
apply those filters to help you quickly sift through your entries.

1 Navigate to the folder where you want to create the filter.
2 In the Filter section, click Filters.
3 Click Add a New Filter.

This form is nearly identical to the one used for advanced searches (see Section 2.5.2, “Using 
Advanced Search,” on page 30 for information regarding the various fields in this form).
In addition to the elements explained in Section 2.5.2, “Using Advanced Search,” on page 30, 
when creating a filter you must consider the following elements:
Filter Name: Specify a name for the filter.
Make This Filter Available to Everyone: Select this option if you want the filter to be 
available to all users who visit the folder. If this option is left unselected, the filter is available 
only to the user who created it.

4 Click OK.

5.15.2  Applying an Existing Filter
1 Navigate to the folder where you have already created the filter that you want to apply.
2 In the Filter section, click the name of the filter.

The filter is applied to the folder.

After you apply a filter, items that do not match the filter criteria in that folder are not displayed in 
the folder listing. To clear the filter, click None in the Filter section.

5.15.3  Modifying a Filter
1 Navigate to the folder where you want to modify a filter that has already been created.
2 In the Filter section, click Filters.
3 In the Personal Filters section, click the drop-down list and select the filter that you want to 

modify.
4 Click Modify.
5 Make the modifications that you desire, then click OK.

5.15.4  Deleting a Filter
1 Navigate to the folder where you want to delete a filter that has already been created.
2 In the Filter section, click Filters.
3 In the Personal Filters section, click the drop-down list and select the filter that you want to 

delete.
4 Click Delete, then click OK to confirm that you want to delete the filter.
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5.16  Listing Folder Entries and Pages
Many types of folders in Novell Teaming provide an Entry Listing toolbar that enables you to search 
for entries individually, or navigate among pages of listings. Some of these tools are useful only if 
there is more than one page of entries. The available tools are:

Go to An Entry: Specify the number (displayed in the # column) of the entry that you want to view, 
then click Go.

Previous/Next: Enables you to scroll through the pages of the folder.

Go to Page: Type a page number in this text box, then click Go to display the entries on that page of 
listings.
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6Working with Specific Folder 
Types

Novell® Teaming provides various kinds of folders that enable you and your teams to accomplish 
specific tasks.

Many folder management functions are the same for all types of folders. For information on how to 
perform general folder-management functions, see Chapter 5, “Managing and Using Folders,” on 
page 63.

This section describes how to manage and perform functions that are unique to each folder type.

Section 6.1, “Working with Discussion Folders,” on page 73
Section 6.2, “Working with Blog Folders,” on page 74
Section 6.3, “Working with Calendar Folders,” on page 76
Section 6.4, “Working with Guestbook Folders,” on page 78
Section 6.5, “Working with File Folders,” on page 78
Section 6.6, “Working with Milestone Folders,” on page 79
Section 6.7, “Working with Micro-Blog Folders,” on page 79
Section 6.8, “Working with Mirrored File Folders,” on page 79
Section 6.9, “Working with Photo Album Folders,” on page 80
Section 6.10, “Working with Survey Folders,” on page 82
Section 6.11, “Working with Task Folders,” on page 83
Section 6.12, “Working with Wiki Folders,” on page 87

6.1  Working with Discussion Folders
Use discussions as a way of obtaining comments and feedback to questions and thoughts that you 
might have. You can start general discussion threads in the Discussion folder in your personal 
workspace. For discussion threads that are more specific to a project or team, start the discussion 
thread in the Discussion folder of the appropriate workspace.

Starting a discussion thread is often more effective than sending individual users an e-mail, because 
other interested parties and knowledge holders can easily join the discussion, without waiting for the 
e-mail to be forwarded partway through the discussion.

By default, the Discussions folder is sorted with the most recent discussions appearing first in the 
list of discussion entries.

Section 6.1.1, “Sorting Discussion Entries by Column Title,” on page 74
Section 6.1.2, “Pinning Discussion Entries,” on page 74
Section 6.1.3, “Viewing Discussion Entries,” on page 74
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6.1.1  Sorting Discussion Entries by Column Title
You can organize your discussion entries by any of the column titles, which are Entry Number (#), 
Title, Author, State, Activity Date, or Rating.

To sort discussion entries by column titles:

1 Click the title of the column that represents how you want to sort your discussions.
The Sort icon  is displayed by the column title that represents how the discussions are being 
sorted.

2 Click the column title again to reverse the sort order for the discussions.

6.1.2  Pinning Discussion Entries
Teaming enables you to pin discussion entries, which makes them easy to view in the future by 
bringing them to the top of the list of discussion entries. This is like placing a bookmark on a 
discussion entry that you want to keep track of.

1 In a Discussion folder, click the gray Pin icon  next to a discussion entry that you are 
interested in.
The Pin icon changes from gray to orange. The next time the page refreshes, the discussion 
entry is brought to the top of the list of discussion entries. It remains at the top of the list until 
you click the Pin icon again, and un-pin the discussion entry.
You can pin multiple discussion entries. Pinned discussion entries are sorted alphabetically by 
title.

6.1.3  Viewing Discussion Entries
To view a discussion entry:

1 Click the title of the discussion entry.
The discussion entry is opened in-line in the discussion folder.

6.2  Working with Blog Folders
Blogs are a good way to express your thoughts about topics that are important to you. For example, 
if you are working on a project and are responsible for a certain aspect of that project, you can 
update your team on your individual progress by posting a blog in the Blog folder in the team 
workspace. Also, you can use the Blog folder in your personal workspace to post your professional 
credentials and skills, as described in Section 1.5.2, “Presenting Your Professional Credentials,” on 
page 20.

Section 6.2.1, “Using the Blog Toolbar,” on page 75
Section 6.2.2, “Organizing Your Blog Folder,” on page 75
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6.2.1  Using the Blog Toolbar
Unlike other folder views, the Blog folder provides the Blog toolbar on each entry. The Blog toolbar 
is displayed at the bottom of any blog entry, and enables you to do several actions without opening 
the entry:

Add Comment: Enables you to quickly add a comment to an entry.
View Comments: Opens a list containing all of the comments that have been made on the 
entry.
Send to Friend: Enables you to e-mail the blog entry to anybody who might be interested in 
viewing it.
Subscribe: Enables you to send notifications to yourself when activity takes place in this entry. 
For more information, see Section 2.12, “Subscribing to a Folder or Entry,” on page 38.

6.2.2  Organizing Your Blog Folder
There are various ways that you can organize your Blog folder.

“Creating a New Blog Page” on page 75
“Sorting Blog Entries” on page 75
“Using the Archives Section” on page 75

Creating a New Blog Page

You can organize your Blog folder into separate Blog pages. Blog pages are displayed in the Blog 
sidebar, located in the right section of the Blog folder, above the Archives section. Also, in the main 
sidebar, in the Workspace section, you can expand your Blog folder to view your Blog pages.

To create a new Blog page:

1 Click New Blog Page in the Folder Entry toolbar.
2 In the Folder Title field, specify the name of the new Blog page that you want to create.
3 Click OK.

Sorting Blog Entries

You can sort your blog entries by Entry Number (#), Activity Date, Author, State, or Title.

To sort blog entries:

1 Click the Sort by drop-down list in the Folder Entry toolbar.
2 Select how you want to sort the entries in your Blog folder.

Using the Archives Section

The Blog sidebar in the Blog folder includes an Archives section that displays each month of the 
year that blogs were created. When you first enter a Blog folder, all of the blog entries are displayed 
in the main viewing area. Selecting an archived month simply filters the entries in the folder to 
display only entries that were created in that month.
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Using the Archives section, you can quickly navigate to a specific blog entry if you know the month 
when it was created. Or, you can view all of the blog entries that were created in any given month.

1 In the Archives section, click the month that the blog was created.
The most recent month is displayed at the top of the Archives section.
In the main viewing area of the Blog folder, Teaming displays all of the blog entries that were 
created in that month.

2 (Optional) You can further navigate to the blog you are looking for by clicking the name of the 
Blog page where the blog is stored.
The blog is displayed in the main viewing area.

6.3  Working with Calendar Folders
Teaming enables you to create a Calendar folder in any workspace that you desire. You can maintain 
a personal calendar in your personal workspace, and then add separate calendars in your team 
workspaces to keep track of events that are specific to that team.

Section 6.3.1, “Changing the View of Your Calendar Folder,” on page 76
Section 6.3.2, “Synchronizing Teaming Calendars of Your Choice,” on page 76
Section 6.3.3, “Viewing All Calendar Events for Which you Are Scheduled,” on page 77
Section 6.3.4, “Viewing Today’s Calendar Items from All of Your Tracked Calendars,” on 
page 77
Section 6.3.5, “Synchronizing Your Calendar with a Desktop Application,” on page 78

6.3.1  Changing the View of Your Calendar Folder
The Date toolbar in Teaming enables you to customize the Calendar folder view in various ways.

Specify whether Teaming should display all hours in the day, or only regular working hours.
Specify the amount of time displayed on a single folder page (1 day, 3 days, 5 days, 1 full week, 
2 weeks, or a month).
Use the left-arrow and right-arrow icons to specify the next or previous folder page. For 
example, if you are currently viewing three days of information, clicking the arrows shows you 
the previous or next three days of information.
Click the Calendar Settings icon  to specify the following options:

The day of the week that the calendar starts. (Saturday, Sunday, or Monday).
The time your work day starts.

Use the calendar applet to display the month or day. After you select a new month to view, be 
sure to click OK to refresh the folder page.

6.3.2  Synchronizing Teaming Calendars of Your Choice
Teaming enables you to synchronize the Teaming calendars of your choice, and display them in a 
single, summarized calendar in the Accessory Panel. This eliminates the need to check multiple 
calendars.

1 Navigate to the workspace or folder where you want to display the calendar.
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2 Click the Accessory Panel drop-down list.
3 Click Add an Accessory.
4 In the Accessory Scope section, select where you want the accessory to be displayed.

Personal accessory for this page only: This accessory appears only to you and only on the 
currently displayed workspace or folder page.
Personal accessory for all workspaces and folders: This accessory appears only to you, but 
it appears on all workspace and folder pages that you view.
Community accessory for this page: This accessory appears only on this page, and it appears 
to everyone who views the current page. Only workspace and folder owners are allowed to 
establish community accessories.

5 In the Accessory Type section, select Calendar Summary.
6 Click OK.

The Accessory Setup page is displayed.
7 In the Title field, provide a title for the calendar.
8 In the Display Style section, select whether you want the calendar to have a border.
9 In the Select the Calendar Folder(s) to be Shown section, navigate the workspace tree and 

select all of the calendars that you want to be included in the Calendar Summary accessory. 
Teaming takes the calendar events from all of the Calendar folders that you select here, and 
displays them in a single, convenient calendar in the Accessory Panel.

10 Click Apply > Close.
The Calendar Summary accessory is displayed in the Accessory Panel on the pages where you 
configured it to be shown, as explained in Step 4.

6.3.3  Viewing All Calendar Events for Which you Are 
Scheduled
Teaming enables you to display all past and future calendar events for which you are scheduled in 
one convenient location.

1 Navigate to the calendar folder in your personal workspace.
2 In the Show drop-down list, select Assigned Events.

All calendar events that are assigned to you in the Teaming system are displayed in the 
calendar.

6.3.4  Viewing Today’s Calendar Items from All of Your Tracked 
Calendars
Teaming enables you to view all of your calendar events for the current day, in one synchronized 
view. This view displays events from the calendars that you are tracking, and displays only those 
events for which you are scheduled.

1 Navigate to the home page of your personal workspace.
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2 Click the Tasks and Calendars tab.
The right section of the page displays today’s schedule with all of the calendar events from all 
of your tracked calendars.

6.3.5  Synchronizing Your Calendar with a Desktop Application
Teaming provides iCal URLs for Calendar folders, so you can synchronize your Teaming Calendar 
folder to your desktop application. 

For information on using iCal to synchronize your calendar with a desktop application, see 
Section 2.16, “Synchronizing Teaming Task and Calendar Folders to a Desktop Calendar 
Application,” on page 42.

6.4  Working with Guestbook Folders
The Guestbook folder in Teaming is a place to store all of your guestbook entries. By default, 
guestbook signatures are displayed in the Overview tab of a user’s personal workspace. Signing the 
Guestbook is a quick way for your friends and co-workers to communicate with you.

To sign another user’s Guestbook:

1 Navigate to the user’s Guestbook folder.
2 In the upper right corner of the folder, click Sign the guestbook.
3 In the Title section, provide a title for signature.
4 In the Description section, compose your message.
5 (Optional) In the Attachments section, add any attachments that you desire.
6 Click OK.

6.5  Working with File Folders
File folders in Teaming make it easy to store and keep track of your files. You can store personal 
files in the File folder in your personal workspace, and team-related files in your individual team 
folders. This makes it easy to share files with your teammates and others who might be interested in 
viewing them.

Section 6.5.1, “Adjusting the Column Width,” on page 78
Section 6.5.2, “Showing and Hiding Columns,” on page 79

6.5.1  Adjusting the Column Width
Teaming enables you to adjust the column width of the table in the File folder.

1 Click and drag the arrow icons, located at the top of each column.
2 When you have reached the desired width, release the mouse.
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6.5.2  Showing and Hiding Columns
Teaming enables you to show or hide table columns in the File folder. The available columns are:

Entry Number (#): Displays the number of the entry (“1” meaning that the entry was created 
first)
Title: Displays the title of the entry.
Author: Displays the author of the entry.
Comments or Replies: Displays how many comments or replies have been made on the entry.
Size: Displays the file size of the entry.
Download: Enables you to download the file to your local workstation.
VIEW: Enables you to view the file in an HTML format.
State: Shows the workflow state of the file.
Activity Date: Displays when the entry was last modified or commented on.
Rating: Displays the rating that users have given the entry.

To show or hide table columns in the File folder:

1 Navigate to the File folder where you want to show or hide the table columns.
2 In the main sidebar, click Folder Options > Configure Columns.
3 Select the columns that you want to show, and deselect the columns that you want to hide.
4 (Optional) Select Set the default folder columns for everyone if you want all users to see only 

the columns that you have selected.
5 Click OK.

6.6  Working with Milestone Folders
Milestone folders track the progress of several task folders. Although you can use milestone folders 
outside of the scope of a project workspace, they are most often used in those workspaces. For more 
information, see Section 4.5, “Managing a Project Management Workspace,” on page 61.

6.7  Working with Micro-Blog Folders
The Micro-Blog folder in Teaming is a place to store all of your micro-blog entries. Use micro-blog 
entries to display your status to your co-workers. You can navigate to someone else’s Micro-Blog 
folder to see what they have been working on, and possibly provide help by sharing your knowledge 
and experience.

For more information on the Micro-Blog feature, see Section 2.10, “Using Micro-Blogs,” on 
page 35.

6.8  Working with Mirrored File Folders
Mirrored File folders reference a file system on an external server, instead of the Teaming file 
system where other Teaming information is stored. Mirrored File folders can reference any 
WebDAV or local file path.
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Mirrored folder functionality is not supported in Kablink Teaming.

For more information about Mirrored File folders, see “Working with Mirrored Folders” in the 
Novell Teaming 2.1 Advanced User Guide.

6.9  Working with Photo Album Folders
Photo albums store and display pictures. You can store your personal photos in the Photo Album 
folder in your personal workspace, and team-related photos in the Photo Album folder of the team 
workspace.

Section 6.9.1, “Organizing Your Photo Album,” on page 80
Section 6.9.2, “Synchronizing Photo Albums,” on page 81
Section 6.9.3, “Viewing and Managing Photo Entries,” on page 82

6.9.1  Organizing Your Photo Album
“Creating New Photo Albums within the Folder” on page 80
“Sorting Photo Entries” on page 80
“Using the Archives Section” on page 80

Creating New Photo Albums within the Folder

You can organize your Photo Album folder into separate photo albums. Photo albums are displayed 
in the Photo Album sidebar, located in the right section of the Photo Album folder. Also, in the 
Workspace section of the main sidebar, you can expand your Photo Album folder to view all of your 
photo albums in the folder.

To create a new photo album in your Photo Album folder:

1 Click New Photo Album in the Folder Entry toolbar.
The Add New Folder page is displayed.

2 In the Folder Title field, specify the name of the new photo album that you want to create.
3 Click OK.

Sorting Photo Entries

You can organize your photo album entries by Activity Date, Creation Date, or Title.

To sort photo album entries:

1 Click the Sort by drop-down list in the Folder Entry toolbar.
2 Select how you want to sort the entries in your Photo Album folder.

Using the Archives Section

The Photo Album sidebar in the Photo Album folder includes an Archives section that displays each 
month of the year that photos were created. When you first enter a Photo Album folder, all of the 
photo album entries are displayed in the main viewing area. Selecting an archived month simply 
filters the entries in the folder to display only entries that were created in that month.
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Using the Archives section, you can quickly navigate to a specific photo entry if you know the 
month when it was created. Or, you can view all of the photo entries that were created in any given 
month.

1 In the Archives section, click the month when the photo was created.
The most recent month is displayed at the top of the Archives section.
In the main viewing area of the Photo Album folder, Teaming displays all of the photo entries 
that were created in that month.

2 (Optional) You can further navigate to the photo entry you are looking for by clicking the name 
of the Photo Album where the photo entry is stored.
The photo entry is displayed in the main viewing area.

6.9.2  Synchronizing Photo Albums
Teaming enables you to synchronize the Teaming photo albums of your choice, and display them in 
a single, summarized photo album (called a Photo Gallery) in the Accessory Panel.

1 Navigate to the workspace or folder where you want to display the Photo Gallery.
2 Click the Accessory Panel drop-down list.
3 Click Add an Accessory.
4 In the Accessory Scope section, select where you want the accessory to be displayed.

Personal accessory for this page only: This accessory appears only to you and only on the 
currently displayed workspace or folder page.
Personal accessory for all workspaces and folders: This accessory appears only to you, but 
it appears on all workspace and folder pages that you view.
Community accessory for this page: This accessory appears only on this page, and it appears 
to everyone who views the current page. Only workspace and folder owners are allowed to 
establish community accessories.

5 In the Accessory Type section, select Photo Gallery.
6 Click OK.

The Accessory Setup page is displayed.
7 In the Title field, provide a title for the photo gallery.
8 In the Display Style section, select whether you want the photo gallery to have a border.
9 In the Select the Photo Album(s) to be Shown section, navigate the workspace tree and select all 

of the photo albums that you want to be included in the Photo Gallery accessory. 
Teaming takes the photos from all of the Photo Album folders that you select here, and displays 
them in a single, convenient Photo Gallery in the Accessory Panel.

10 Click Apply > Close.
The Photo Gallery accessory is displayed in the Accessory Panel on the pages where you 
configured it to be displayed, as explained in Step 4.
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6.9.3  Viewing and Managing Photo Entries
“Viewing Photos” on page 82
“Managing Photo Entries” on page 82

Viewing Photos

To view a photo in a full-sized view in a separate window, click the thumbnail picture.

To scroll through an album that contains multiple photos, simply click the navigation arrows.

Managing Photo Entries

To manage a photo entry, including deleting, modifying, commenting, etc., click the linked title of 
the photo entry.

6.10  Working with Survey Folders
Survey folders store surveys that you or other Teaming users have created. Surveys enable you to 
poll team members, or any other Teaming users, about issues that are important to you, your team, or 
your entire organization.

Section 6.10.1, “Participating in a Survey,” on page 82
Section 6.10.2, “Creating a Survey,” on page 82
Section 6.10.3, “Checking the Results of a Survey,” on page 83

6.10.1  Participating in a Survey
1 Navigate to the Survey folder that contains the survey that you want to participate in.
2 Click the entry title of the survey.
3 Provide answers to the survey questions, then click Vote.

6.10.2  Creating a Survey
1 Navigate to the Survey folder where you want to create the survey.
2 Click Add Survey in the Folder Entry toolbar.

The Survey page is launched. 
3 Fill in the Title, Description, and Attachments sections as described in Section 7.1.1, “Filling In 

the Add Entry Form,” on page 92.
4 In the Due Date section, specify the date when you want to stop all voting on the survey. After 

the date that you specify, users cannot cast a vote.
5 Specify the following access control settings:

Who Can See Vote Results Before Due Time: When users have access to view the vote 
results before the survey is due, they can see how other participants have voted so far. You can 
enable all users to have this ability, the moderator and those users who have already voted, or 
only the moderator.
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Who Can See Vote Results After Due Time: When users have access to view the vote results 
after the survey is due, they can see how other participants have voted, but only after they have 
cast a vote and the voting is closed. You can enable all users to have this ability, the moderator 
and those users who have voted, or only the moderator.
Who Can See Who Has Voted and How: When users have access to see who has voted and 
how, they can see how other individual users have voted. Using this option is not recommended 
if your users want their votes to remain confidential. You can enable all users to have this 
ability, the moderator and those users who have voted, or only the moderator.
Allow Voters to Change/Remove Their Votes: Select this option if you want to grant users 
the ability to change or remove their votes before the survey is due. Users who are logged in as 
Guest cannot have this ability.

6 Select one of the following options for the first question of your survey:
Multiple Choice: Multiple Answers: Adds a multiple-choice question, and enables users 
to select more than one answer.
Multiple Choice: Single Answer: Adds a multiple-choice question, and restricts users to 
only one answer.
Written Reply: Adds a written reply question, and provides users with a field where they 
can specify their written response.

7 (Optional) Select Answer to this question is required, if you want to require users to answer the 
question.

8 (Optional) Click Add More Answers, if you want to add more answer possibilities for a 
multiple-choice question. (This option does not exist for Written Reply questions.)

9 Repeat Step 6 through Step 8 to add additional questions to your survey.
10 Click OK.

6.10.3  Checking the Results of a Survey
After you have voted, you can check the results by viewing the entry again.

1 Navigate to and open the survey where you want to check the voting results.
2 Click View Voting Details, located near the bottom of the survey entry.

Teaming displays the percentage of votes cast for each survey question.

6.11  Working with Task Folders
Task folders keep track of the progress made in completing work assignments. Teaming enables you 
to create a Task folder in any workspace that you desire. You can maintain a personal Task folder in 
your personal workspace, and then add separate Task folders in your team workspaces to keep track 
of tasks that are specific to that team.

Section 6.11.1, “Changing the View of Your Task Folder,” on page 84
Section 6.11.2, “Sorting Tasks in Your Task Folder By Task Characteristics,” on page 84
Section 6.11.3, “Synchronizing the Teaming Task Folders of Your Choice,” on page 84
Section 6.11.4, “Viewing All Tasks That Are Assigned to You,” on page 85
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Section 6.11.5, “Viewing All Tasks That Are Assigned to a Specific Team, Group, or 
Individual User,” on page 86
Section 6.11.6, “Importing Tasks,” on page 87

6.11.1  Changing the View of Your Task Folder
The View toolbar enables you to choose the kinds of tasks that you want to display in the task list, 
according to the following categories:

Closed: Displays tasks that have the status of Closed.
Today: Displays tasks that have a due date of today.
Week: Displays tasks that have a due date sometime in the next seven days.
Month: Displays tasks that have a due date sometime in the next 30 days.
All Active: Displays tasks that are currently active.
All Entries: Displays all tasks.
Assigned Tasks: Available only in user workspaces. Displays all tasks assigned to the owner of 
the workspace, regardless of where the tasks are located in Teaming.
From Folder: Available only in user workspaces. Displays all tasks that are in the current 
folder.

6.11.2  Sorting Tasks in Your Task Folder By Task 
Characteristics
Teaming enables you to sort the tasks in your task list based on task characteristics. You can sort 
tasks by the following categories: task name, priority, due date, status, assignee, percent done, and 
location.

1 Navigate to the task folder where you want to sort your tasks.
2 At the top of the task list, click the title of the column heading by which you want to sort the 

tasks.
Tasks in the task folder are sorted according to the column title that you clicked.

6.11.3  Synchronizing the Teaming Task Folders of Your Choice
Teaming enables you to synchronize the Teaming Task folders of your choice, and display them in a 
single, summarized task list in the Accessory Panel. You can display tasks that are assigned to 
specific users, groups, or teams.

1 Navigate to the page where you want to display the task list.
2 Click the Accessory Panel drop-down list.
3 Click Add an Accessory.
4 In the Accessory Scope section, select where you want the accessory to be displayed.

Personal accessory for this page only: This accessory appears only to you and only on the 
currently displayed workspace or folder page.
Personal accessory for all workspaces and folders: This accessory appears only to you, but 
it appears on all workspace and folder pages that you view.
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Community accessory for this page: This accessory appears only on this page, and it appears 
to everyone who views the current page. Only workspace and folder owners are allowed to 
establish community accessories.

5 In the Accessory Type section, select Task Summary.
6 Click OK.

The Accessory Setup page is displayed.
7 In the Title field, provide a title for the task list.
8 In the Display Style section, select whether you want the task list to have a border.
9 In the # of Results to be Shown section, specify how many results you want to display at any 

one time in the task list.
10 In the Show Only the Tasks Assigned To section, specify the specific users, groups, or teams 

whose tasks you want to display.
11 In the Select the Task Folder(s) to be Shown section, navigate the workspace tree and select all 

of the Task folders that you want to be included in the task list. 
Teaming takes the tasks from all of the Task folders that you select here, and displays them in a 
single, convenient task list in the Accessory Panel.

12 Click Apply > Close.
The Task Summary accessory is displayed in the Accessory Panel on the pages where you 
configured it to be shown, as explained in Step 4.

6.11.4  Viewing All Tasks That Are Assigned to You
Teaming enables you to display all of the tasks that are assigned to you, whether they are assigned 
personally to you, or assigned to a group or team of which you are a member.

“Viewing Your Tasks in a Full Interactive View” on page 85
“Viewing Summaries of All Your Assigned Tasks” on page 85
“Viewing Summaries of Your Assigned Tasks That Are Due within the Next Two Weeks” on 
page 86

Viewing Your Tasks in a Full Interactive View

Teaming enables you to view a full interactive view of all of your assigned tasks. In a graphical and 
interactive view, you can easily modify task priority, status, and completion level.

1 Navigate to a task folder in your personal workspace.
2 In the Show section, select Assigned Tasks.

Teaming displays all tasks that are currently assigned to you. You can easily modify task 
priority, status, and completion level.

Viewing Summaries of All Your Assigned Tasks

1 Navigate to the home page of your personal workspace.
2 Click the Tasks and Calendars tab.

The left section of the page displays all of the tasks that assigned to you, whether they are 
assigned personally to you, or assigned to a group or team of which you are a member.
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3 Select Anytime.
Teaming displays in a summarized view all tasks that are assigned to you.

Viewing Summaries of Your Assigned Tasks That Are Due within the Next Two 
Weeks

1 Navigate to the home page of your personal workspace.
2 Click the Tasks and Calendars tab.

The left section of the page displays all of the tasks that assigned to you, whether they are 
assigned personally to you, or assigned to a group or team of which you are a member.

3 Select Within 2 Weeks.
Teaming displays in a summarized view of all tasks that are due within the next two weeks and 
are assigned to you.

6.11.5  Viewing All Tasks That Are Assigned to a Specific Team, 
Group, or Individual User
Teaming enables you to view all tasks located in the Teaming site that are assigned to a specific 
team, group, or individual user, and display them in a single, summarized task list in the Accessory 
Panel.

1 Navigate to the page where you want to display the task list.
2 Click the Accessory Panel drop-down list.
3 Click Add an Accessory.
4 In the Accessory Scope section, select where you want the accessory to be displayed.

Personal accessory for this page only: This accessory appears only to you and only on the 
currently displayed workspace or folder page.
Personal accessory for all workspaces and folders: This accessory appears only to you, but 
it appears on all workspace and folder pages that you view.
Community accessory for this page: This accessory appears only on this page, and it appears 
to everyone who views the current page. Only workspace and folder owners are allowed to 
establish community accessories.

5 In the Accessory Type section, select Task Summary.
6 Click OK.

The Accessory Setup page is displayed.
7 In the Title field, provide a title for the task list.
8 In the Display Style section, select whether you want the task list to have a border.
9 In the # of Results to be Shown section, specify how many results you want to display at any 

one time in the task list.
10 In the Show Only the Tasks Assigned To section, specify the specific users, groups, or teams 

whose tasks you want to display.
11 In the Select the Task Folder(s) to be Shown section, do not select anything. 
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Teaming takes the tasks from the entire Teaming site that are associated to the user, group or 
team that you specified in Step 10, and displays them in a single, convenient task list in the 
Accessory Panel.

12 Click Apply > Close.
The Task Summary accessory is displayed in the Accessory Panel on the pages where you 
configured it to be shown, as explained in Step 4.

6.11.6  Importing Tasks
Teaming enables you to import tasks from other software applications. You can import tasks from 
Outlook or from other applications that export to files of .ical, .ics, .ifb, and .icalendar 
formats.

You can import tasks as a single file, or you can import a list of tasks from a URL.

“Importing Tasks as a Single File” on page 87
“Importing Tasks from a URL” on page 87

Importing Tasks as a Single File

1 Navigate to the Task folder where you want to import the task.
2 In the main sidebar, click Folder Options > Import Tasks.
3 Click Import Tasks from a File.
4 Click Browse, then browse to and select the task that you want to import.
5 Click Import from File.

Importing Tasks from a URL

1 Navigate to the Task folder where you want to import the task.
2 In the main sidebar, click Folder Options > Import Tasks.
3 Click Import Tasks from a URL.
4 In the provided field, specify the URL where there is a list of tasks that you want to import.
5 Click OK.

6.12  Working with Wiki Folders
Wiki folders contain wiki entries. A wiki is a set of related entries coauthored by folder participants. 
For example, the best known wiki on the Internet is Wikipedia. Other examples of possible wiki 
content are glossaries, and policies or procedures.

Section 6.12.1, “Organizing Your Wiki Folder,” on page 87
Section 6.12.2, “Formatting Your Wiki Entry,” on page 89

6.12.1  Organizing Your Wiki Folder
There are various ways that you can organize your Wiki folder.

“Setting a Wiki Home Page” on page 88
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“Navigating to Your Wiki Home Page” on page 88
“Creating a New Wiki Topic” on page 88
“Sorting Wiki Entries” on page 88
“Finding a Wiki Entry” on page 89

Setting a Wiki Home Page

Teaming enables you to set an entry to be the wiki home page for any Wiki folder (Wiki Topic).

1 Locate and display the entry that you want to set as the home page for your Wiki Topic.
2 Click Set Wiki Home Page in the Entry toolbar.

The entry is now set as the home page for the Wiki Topic.

Navigating to Your Wiki Home Page

1 Navigate to the Wiki folder (Wiki Topic) where you want to display the wiki home page.
2 Click Wiki Home Page in the Wiki sidebar.

The wiki home page for the Wiki Topic is displayed in the main viewing window.

Creating a New Wiki Topic

You can organize your Wiki entries into separate Wiki folders (Wiki Topics). Wiki Topics are 
displayed in the Wiki sidebar, in the Wiki Topics section. Also, in the Workspace section of the main 
sidebar, you can expand your Wiki folder to view your Wiki Topics.

To create a new Wiki Topic:

1 Click New Wiki Topic in the Folder Entry toolbar.
The Add New Folder page is displayed.

2 In the Folder Title field, specify the name of the new Wiki Topic that you want to create.
3 Click OK.

or

1 In the Wiki folder where you want to create the new Wiki Topic, click Manage > Add New 
Folder in the Folder toolbar.
The Add New Folder page is displayed.

2 In the Folder Title field, specify the name of the new Wiki Topic that you want to create.
3 In the Folder section, select Wiki.
4 Click OK.

Sorting Wiki Entries

You can organize your wiki entries by Activity Date, Creation Date, or Title.

To sort wiki entries:

1 Click the Sort by drop-down list in the Folder Entry toolbar.
2 Select how you want to sort the entries in your Wiki folder.
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Finding a Wiki Entry

Wiki Entries are stored in Wiki folders (Wiki Topics). When you are looking for a Wiki Entry, first 
select the Wiki Topic in the Wiki Topics section of the Wiki sidebar where the entry is stored. Then, 
click the entry in the Wiki Entries section of the Wiki sidebar.

For Wiki Topics that contain many entries, you can use the Find a Page feature in the Wiki sidebar.

1 In the Wiki sidebar, click the Wiki Topic that contains the Wiki Entry that you are searching for.
2 In the Find a Page field, begin typing the name of the entry that you are looking for. Click the 

name of the entry when it appears in the drop-down list.

When you are working with a wiki entry, it can be helpful to review edits from your teammates. For 
information on how to check the edit history of an entry, see Section 7.10.2, “Edit History Reports,” 
on page 97.

6.12.2  Formatting Your Wiki Entry
“Creating Sections and Subsections” on page 89
“Linking to Another Wiki Entry” on page 89

Creating Sections and Subsections

Table 6-1 shows how you can create sections and subsections in a Wiki Entry.

Table 6-1   Sections and Subsections

Linking to Another Wiki Entry

If you know the exact name of the entry that you want to link to, you can enter [[entry name]] in 
the Description section of the entry to create a link to that entry.

Example Description

==Section name== Creates a section heading in the Wiki Entry.

===Subsection name=== Creates a subsection heading in the Wiki Entry.
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7Working With Folder Entries

Folder entries in Novell® Teaming are individual sections or parts that are used to populate folders 
with information.

Section 7.1, “Creating a Folder Entry,” on page 91
Section 7.2, “Linking within a Folder Entry,” on page 93
Section 7.3, “Commenting on a Folder Entry,” on page 94
Section 7.4, “Modifying a Folder Entry,” on page 94
Section 7.5, “Reserving a Folder Entry,” on page 95
Section 7.6, “Moving a Folder Entry,” on page 95
Section 7.7, “Copying a Folder Entry,” on page 95
Section 7.8, “Deleting a Folder Entry,” on page 96
Section 7.9, “Undeleting a Folder Entry,” on page 96
Section 7.10, “Generating Reports about a Folder Entry,” on page 97
Section 7.11, “Notifying Others about a Folder Entry,” on page 98
Section 7.12, “Subscribing to a Folder Entry,” on page 100
Section 7.13, “Tagging a Folder Entry,” on page 100
Section 7.14, “Attaching Files to a Folder Entry,” on page 100
Section 7.15, “Displaying YouTube Videos in a Folder Entry,” on page 101
Section 7.16, “Rating a Folder Entry,” on page 102
Section 7.17, “Printing a Folder Entry,” on page 102
Section 7.18, “Viewing and Editing Attached Files,” on page 102
Section 7.19, “Using Version Control with Attached Files,” on page 103
Section 7.20, “Enabling Alternate Folder Entry Types,” on page 104
Section 7.21, “Creating Custom Folder Entry Forms,” on page 104
Section 7.22, “Displaying Folder Entries on a Landing Page,” on page 105

7.1  Creating a Folder Entry
Novell Teaming enables you to create folder entries in any folder where you have appropriate rights.

1 Navigate to the folder where you want to create the entry.
2 In the Folder Entry toolbar, click the appropriate item to add the entry. For example, to add a 

blog entry in the Blog folder, click Add Blog Entry.
The Add Entry page is launched.

3 Specify the appropriate information in the Add Entry page. For more detailed information on 
the fields, see Section 7.1.1, “Filling In the Add Entry Form,” on page 92.

4 Click OK.
The entry is added to the folder.
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7.1.1  Filling In the Add Entry Form
Although the process for creating a folder entry is similar for each type of entry (File entry, Calendar 
entry, Discussion entry, etc.), the Add Entry form can vary considerably.

Because Teaming is highly customizable, field names in the Add Entry form can be defined by 
Teaming administrators and other Teaming users who create forms, and therefore can be called 
anything. This section contains a list of named fields for the various default entry types. For more 
information on creating custom forms, see “Designing Custom Folder Entry Forms” in the Novell 
Teaming 2.1 Advanced User Guide

Title: Provide a title for the entry.

Location: Specify the location for the event.

Description: Provide a description of the entry. This is the body of the entry, and is where you add 
the main content.

Event/Time Period: Specify the start and end time, whether you want the entry to adjust for the 
time zone of attendees, how you want your status to be displayed during this event (Free, Busy, 
Tentative, or Out of Office), and if you want the entry to repeat (Does not repeat, Daily, Weekly, 
Monthly, or Yearly).

Priority: Specify the priority of the entry.

Attendee: Specify individual attendees whom you want to invite to the calendar event.

Clipboard User Names: Use names that are on your clipboard to invite users to the event.

Groups: Specify groups that you want to be associated with the entry. When you specify a group, 
each member of the group is associated with the entry. For example, if you are scheduling a meeting 
and you specify a group to attend the meeting, each member of the group is considered an attendee.

Teams: Specify teams that you want to be associated with the entry. When you specify a team, each 
member of the team is associated with the entry. For example, if you are assigning a task to a team, 
each member of the team is responsible for completing the task.

Send an E-Mail Notification: Select this option if you want Teaming to send an e-mail notification 
to all of the users, groups, or teams that you associated with the entry.

Status: Select the current state for the task, such as In Process, Completed, and so forth.

Completed: Select the percentage of the task that is complete.

Attachments: Enables you to browse your file system and attach a file to the entry. Click Add more 
files to add additional attachments.

Photo: Enables you to browse to and upload a photo.

Due Date: The last day the entry is active.

Survey: Enables you to set parameters for your survey, such as whether to allow multiple answers, 
single answers, or written replies, who can see the vote results before the survey is due, who can see 
vote results after the survey is due, and who can see participant names. It also provides an option to 
allow voters to change or remove their votes.

For more detailed instructions on creating a survey, see “Creating a Survey” on page 82.
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Subscribe to This Entry: You can configure Teaming to send you notifications when activity takes 
place in this entry. For more information, see Section 2.12, “Subscribing to a Folder or Entry,” on 
page 38.

Send E-Mail When Entry is Submitted: To ensure that certain co-workers are aware of your 
entry, you can send them an e-mail directly from Teaming, notifying them that an entry has been 
created. For more information, see Section 9.4, “Filling Out the Send E-Mail Page,” on page 123.

7.2  Linking within a Folder Entry
When creating an entry, you can include a link to another entry in your Novell Teaming site, or to 
anywhere else on the Internet.

Section 7.2.1, “Linking to an Entry in the Current Folder,” on page 93
Section 7.2.2, “Linking to an Entry in Another Folder,” on page 93
Section 7.2.3, “Linking to an External Page on the Web,” on page 94

7.2.1  Linking to an Entry in the Current Folder
1 In the Description section of the Add entry form, click the Apply link icon , located near the 

end of the row of buttons in the HTML editor.
Teaming displays a window that allows you to specify the entry to which you want to link.

2 In the Page name to link to field, do either of the following:
Type the exact page title.
Click Find next to the field, start typing the name of the page, and select the appropriate 
title from the drop-down list.

3 Click Insert.

If you know the exact name of the entry that you want to link to, you can enter [[entry name]] in 
the Description section of the entry to create a link to that entry.

7.2.2  Linking to an Entry in Another Folder
1 In the Description section of the Add entry form, click the Apply link icon , located near the 

end of the row of buttons in the HTML editor.
Teaming displays a window that allows you to specify the entry to which you want to link.

2 Click the Change link.
3 In the provided field, start typing the name of the folder that contains the entry that you want to 

link to.
4 When the desired folder appears in the type-to-find list, click it.
5 In the Page name to link to field, specify the complete name of the entry that you want to link 

to, or click Find to use the type-to-find functionality.
6 After you have finished typing the name, or after you have clicked the name in the type-to-find 

drop-down list, click Insert.
 The linked title of your chosen entry is inserted into the Description box.
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7.2.3  Linking to an External Page on the Web
1 In the Description section of the Add entry form, select the text that you want to convert into a 

link.
2 Click the Insert/edit link icon .

The Insert/edit link window is displayed.
3 In the Link URL field, specify the URL of the page that you want the link to.
4 Fill in the following fields:

Target: Specify whether you want to open the link in the same window, or open the link in a 
new window.
Title: Specify a title for the link.
Class: Specify how big you want the link to appear.
If you leave this field blank, 12px is automatically selected. This is the standard setting.

5 Click Insert.

7.3  Commenting on a Folder Entry
People often post a folder entry to generate ideas and obtain feedback. Novell Teaming enables you 
to comment on any type of entry, so you can share your ideas and provide input.

1 Navigate to the entry where you want to make a comment.
2 Select the entry, then click Comment in the Entry toolbar.

For entries in Discussion folders, click Reply.
3 In the Description field, specify your comment.
4 (Optional) Use the Attachments section to attach a file to your comment.
5 Click OK.

Your comment is displayed as the last comment in the list of comments.

For Blog entries, you can use the Blog toolbar to make comments. For information on using the 
Blog toolbar, see “Using the Blog Toolbar” on page 75.

7.4  Modifying a Folder Entry
If you have appropriate rights, Novell Teaming enables you to modify a folder entry after it has been 
created. You can modify all sections of an entry, or the Description section only.

Section 7.4.1, “Modifying All Sections of an Entry,” on page 94
Section 7.4.2, “Modifying the Description Section of an Entry,” on page 95

7.4.1  Modifying All Sections of an Entry
1 Navigate to the entry that you want to modify.
2 Select the entry, then click Modify in the Entry toolbar.
3 Modify the entry as necessary.
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You can modify the title or description of the entry. You can also subscribe to the entry, or send 
an e-mail when the entry is submitted.

4 When you have finished modifying the entry, click OK.

7.4.2  Modifying the Description Section of an Entry
1 Navigate to the entry that you want to modify.
2 In the lower right corner of the Description section, click Edit.
3 Use the provided HTML editor to modify the Description section.
4 Click OK.

7.5  Reserving a Folder Entry
When you reserve a folder entry in Novell Teaming, other users who might want to modify, move, 
copy, or delete the entry are unable to do so for as long as you have the entry reserved.

This does not apply to users accessing the entry through WebDAV.

1 Navigate to the entry that you want to reserve.
2 Select the entry, then click Reserve in the Entry toolbar.

The entry is now reserved for your use. Nobody else can modify, move, copy, or delete the 
entry.
When you are finished modifying the entry, click Unreserve in the Entry toolbar to make it 
available to be modified by other users.

7.6  Moving a Folder Entry
Novell Teaming enables you to move a folder entry into any folder where you have appropriate 
rights.

1 Navigate to the entry that you want to move.
2 Select the entry, then click Move in the Entry toolbar.
3 In the Select the Destination Folder or Workspace section, use the Workspace tree to navigate 

to the folder where you want to move the entry.
4 Click the linked title of the folder where you want to move the entry.

The Current Save Location section shows you the path where you have selected to move the 
entry.

5 To move the entry to the location specified, click OK.

7.7  Copying a Folder Entry
Novell Teaming enables you to copy a folder entry from one folder and paste it into any folder 
where you have appropriate rights.

1 Navigate to the entry that you want to copy.
2 Select the entry, then click Copy in the Entry toolbar.
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3 In the Select the Destination Folder or Workspace section, use the Workspace tree to navigate 
to the folder that you want to copy the entry into.

4 Click the linked title of the folder that you want to copy the entry into.
The Current Save Location section shows you the path where you have selected to copy the 
entry.

5 To copy the entry into the location specified, click OK.

7.8  Deleting a Folder Entry
You can delete a folder entry wherever you have appropriate rights to do so.

1 Navigate to and select the entry that you want to delete.
2 Click Delete in the Entry toolbar.

Novell Teaming asks you if you really want to delete the entry.
3 (Optional) Select Purge this entry immediately if you want to purge the entry so that it cannot 

be recovered.

NOTE: Selecting this option renders the entry unrecoverable and it is permanently deleted 
from the Teaming site.

If you do not select this option, you can undelete the entry as described in Section 7.9, 
“Undeleting a Folder Entry,” on page 96.

4 Click OK.

7.9  Undeleting a Folder Entry
Teaming enables you to undelete a folder entry that you previously deleted, restoring it to its 
previous location.

1 Navigate to the folder where the deleted entry previously resided.
For example, if you want to restore an entry that was in your Blog folder in your personal 
workspace, navigate to the Blog folder in your personal workspace.

TIP: If you want to see everything that has been deleted in the Teaming site, navigate to the 
highest level workspace. (By default this is the Home Workspace directory.)

2 Click the Trash icon , located in the Folder toolbar.
The Trash page displays all workspaces, folders, and entries that have been deleted in or below 
the current folder.

3 Select the entry that you want to undelete.
4 Click Restore.

The entry is restored to its previous location. If the folder or workspace containing this entry 
has also been deleted, it is restored when you restore the entry.

For more information about undeleting, see “Restoring Deleted Items” in the Novell Teaming 2.1 
Advanced User Guide.
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7.10  Generating Reports about a Folder Entry
Novell Teaming enables you to generate reports about a folder entry. 

1 Navigate to the entry that you want to generate a report about.
2 Select the entry, then click Reports in the Entry toolbar, then select the type of report that you 

want to generate.

You can generate the following kinds of reports:

Section 7.10.1, “Activity Reports,” on page 97
Section 7.10.2, “Edit History Reports,” on page 97
Section 7.10.3, “Workflow History Reports,” on page 98

For information on how to change the default application that Teaming uses to view these reports, 
see Section B.10.1, “Changing the Default Editor Settings for a Single File Type,” on page 143.

7.10.1  Activity Reports
Activity reports contain the following kinds of information:

User: Shows the users who have had some kind of activity in the entry.
Views: Displays how many times the user has viewed the entry.
Adds: Displays who created the entry.
Edits: Displays who has edited the entry.
Deletes: Displays who deleted the entry. This column lists only entries that have been both 
deleted and purged.

NOTE: To acquire this information, you must run the report at the folder level, as described in 
Section 5.8, “Generating an Activity Report on a Folder,” on page 68.

Pre-deletes: Displays who deleted the entry. This column lists entries that have been deleted 
but not yet purged.

NOTE: To acquire this information, you must either run the report at the folder level, as 
described in Section 5.8, “Generating an Activity Report on a Folder,” on page 68, or navigate 
to the Trash folder to view the entry, as described in Section 7.9, “Undeleting a Folder Entry,” 
on page 96.

Restores: Displays who restored the entry.

7.10.2  Edit History Reports
Edit History Reports enable you to generate reports about the Title and Description sections of 
folder entries. You cannot generate reports about documents that are attached to folder entries.

Edit History Reports enable you to accomplish the following tasks:

“Viewing Version Information” on page 98
“Comparing Versions of an Entry” on page 98
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Viewing Version Information

Edit History reports contain version information about the entry, such as when it was created, when 
it was edited, and the additions and modifications that were made to it. You cannot view version 
information about documents that are attached to the entry.

In the Edit History page, the Data column lists a date for each time the entry was edited.

To view what modifications were made on a specific date:

1 In the Data column, click the date for which you want to view the modifications.
The Title and Description sections of the entry are displayed, showing what the entry looked 
like after the modifications were made on the specific date.

Comparing Versions of an Entry

The Edit History report in Teaming enables you to compare the Title and Description fields of two 
versions of an entry. You cannot compare versions of documents that are attached to entries.

1 In the Edit History page, in the Version column, select the left radio button of the first version 
that you want to compare, then select the right radio button of the second version that you want 
to compare.

2 Click Compare.
Teaming displays the additions underlined in green, and the deletions marked with strikeout in 
red.

7.10.3  Workflow History Reports
Workflow history reports contain the following kinds of information:

Event Number: Displays the order of the actions that have been performed concerning the 
workflow.
Modify Date: Displays the date the entry was modified in regards to the workflow.
Modified By: Displays the user who modified the entry in regards to the workflow.
Operation: Displays the operation that was performed.
Process Name: The name of the original workflow.
Parallel Workflow Thread Name: Name of the workflow thread that is parallel to the 
workflow.
State Name: State of the workflow process.

7.11  Notifying Others about a Folder Entry
When viewing a folder entry, you might think of a co-worker who might also need the information. 
Novell Teaming provides various ways to inform your friends and co-workers about entries that you 
think they might be interested in.

Section 7.11.1, “Sharing an Entry,” on page 99
Section 7.11.2, “Sending an E-Mail about an Entry,” on page 99
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7.11.1  Sharing an Entry
When you share a folder entry with someone, that person can view that entry in the Micro-Blogs and 
Shared Items tab in his or her personal workspace. For information on how to view shared entries, 
see Section 2.11.3, “Viewing Shared Items,” on page 38.

1 In the entry that you want to share, click Share This Entry in the Entry toolbar.
2 In the provided page, select the users, groups, or teams with whom you want to share the entry.
3 In the Comments section, provide any comments that you want to include.
4 Click OK.

The entry is now shared with the users that you specified.

7.11.2  Sending an E-Mail about an Entry
You can send a notification e-mail about a folder entry when you are creating the entry, or after the 
entry has already been created.

“Sending an E-Mail When the Entry Is Created” on page 99
“Sending an E-Mail After the Entry Is Created” on page 99

Sending an E-Mail When the Entry Is Created

1 In the entry creation form when you are creating an entry, click Send E-Mail When Entry is 
Submitted.

2 Fill in the appropriate fields.
For information on filling in the rest of the Send E-Mail form, see Section 9.4, “Filling Out the 
Send E-Mail Page,” on page 123.

3 Click OK to create the entry and send the e-mail.

Sending an E-Mail After the Entry Is Created

You do not need to be the author of the entry to send this type of e-mail.

1 Navigate to the entry that you want to inform others about via e-mail.
2 Select the entry, then click Send E-Mail in the entry’s Footer toolbar.

The Send E-Mail page is displayed.
A link to this entry is automatically created and is visible in the body of the received message.

3 Fill in the appropriate fields.
For information on filling in the rest of the Send E-Mail form, see Section 9.4, “Filling Out the 
Send E-Mail Page,” on page 123.

4 Click OK to send the notification.

For Blog entries, you can use the Blog toolbar to send an e-mail about the entry. For information on 
using the Blog toolbar, see “Using the Blog Toolbar” on page 75.
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7.12  Subscribing to a Folder Entry
If you are particularly interested in a specific folder entry, you can subscribe to that entry. When you 
subscribe to an entry, Novell Teaming notifies you of any activity that takes place in the entry.

1 Navigate to and open the entry that you want to subscribe to.
2 In the Footer toolbar of the entry, click Subscribe to This Entry.
3 Select the type of e-mail notification that you want to receive, then click OK.

For more information on subscribing to entries, see Section 2.12, “Subscribing to a Folder or Entry,” 
on page 38.

For Blog entries, you can use the Blog Toolbar to subscribe to the entry. For information on using 
the Blog Toolbar, see “Using the Blog Toolbar” on page 75.

7.13  Tagging a Folder Entry
Tags are keywords that categorize a workspace, folder, or folder entry. Tagging functionality in 
Novell Teaming enables you to create virtual containers for places and entries. Like folders in your 
e-mail, you can categorize information, and then come back to it at a later time.

1 In the entry that you want to tag, click Tag this.
2 Type the name of the tag into the field in either the Personal Tags or Community Tags section. 

To decide whether you want to create a personal or community tag, see Section 3.7.4, 
“Choosing Between Personal Tags and Community Tags,” on page 47.
This field uses Type-to-Find functionality, so if a tag already exists with the desired name, it 
appears in the drop-down list. If the name does not appear in the drop-down list, you are 
creating a new tag.

3 Finish typing the name of the tag, or select it from the drop-down list, then click Add.
The entry is now tagged with the tag that you specified.

For more information on tagging, see Section 3.7, “Using Tags,” on page 45.

7.14  Attaching Files to a Folder Entry
In the Attachments section of an entry, Novell Teaming provides various alternatives to add 
attachments to the entry.

1 Navigate to and select the entry where you want to attach the file, then continue with the 
appropriate action.

Section 7.14.1, “Dragging and Dropping Files,” on page 101
Section 7.14.2, “Accessing Attachments Through WebDAV (Supported Environments Only),” 
on page 101
Section 7.14.3, “Uploading a Single File,” on page 101
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7.14.1  Dragging and Dropping Files
You can attach a file to an entry by dragging it from another location and dropping into the entry.

1 Click the Drag and Drop Files icon.
This launches a window with a folder icon.

2 Drag the file that you want to upload and drop it onto the folder icon.
Teaming displays an opening and closing folder to signify that your dropped files are being 
uploaded as attachments.

You can also copy and paste files into the folder icon.

7.14.2  Accessing Attachments Through WebDAV (Supported 
Environments Only)
Teaming enables you to use WebDAV to access files and attach them to entries. However, Teaming 
enables WebDAV tools only in specific environments. For a description of supported environments, 
see “Prerequisites for Using WebDAV” on page 66.

1 Navigate to the entry where you want to attach a file using WebDAV.
2 Click Access Attachments Using WebDAV.
3 Navigate to and select the file that you want to attach.

For more information on WebDAV, see Section 5.7, “Accessing WebDAV Files from within 
Teaming,” on page 66.

7.14.3  Uploading a Single File
1 In the entry where you want to upload the file, click the Upload a Single File icon in the 

Attachments section.
2 Click Browse, then browse to and select the file that you want to attach.
3 Click OK.

7.15  Displaying YouTube Videos in a Folder 
Entry
Novell Teaming enables you to post YouTube videos in a folder entry, as well as in the following 
locations throughout the Teaming site:

In a workspace or folder brand, as described in “Branding a Folder or Workspace” in the Novell 
Teaming 2.1 Advanced User Guide.
In a workspace description, as described in Section 4.1.12, “Displaying YouTube Videos in a 
Workspace,” on page 54.
In a folder description, as described in Section 5.14, “Displaying YouTube Videos in a Folder,” 
on page 70.
On a landing page, as described in “Displaying YouTube Videos on a Landing Page” in the 
Novell Teaming 2.1 Advanced User Guide.
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To post a YouTube video in a folder entry:

1 Navigate to the folder where you want to post the YouTube video.
2 Create a new folder entry by clicking the appropriate item in the Folder Entry toolbar. For 

example, to add a blog entry in the Blog folder, click Add Blog Entry.
or
Open an existing folder entry that you want to modify, then click Modify in the Entry toolbar.
The Add Entry page is launched.

3 In the Description section, click the Video icon .
4 In the provided window, in the YouTube URL field, paste the URL of the YouTube video that 

you want to post.
5 In the Dimensions fields, do not make any changes if you want to keep the default YouTube 

dimensions.
6 Click Insert, then click OK to post the entry.

7.16  Rating a Folder Entry
Novell Teaming enables you to rate folder entries by using a five-star rating system (one star 
indicating the least impressive, and five stars the most impressive), which gives you an additional 
tool for determining the quality of information.

1 Navigate to the entry that you want to rate.
2 Click the star that represents your evaluation.

For example, to give an entry a rating of three stars, click the third star from the left.

In the parentheses to the right of the stars, Teaming displays the average rating for the entry, and 
how many users have rated the entry.

You can rate an entry as many times as you want, but Teaming records only your most recent rating.

7.17  Printing a Folder Entry
Novell Teaming enables you to print only the content of a folder entry.

1 Navigate to the entry that you want to print.
2 In the Entry toolbar, click the Print icon .
3 Configure your printer settings, then click OK.

7.18  Viewing and Editing Attached Files
Novell Teaming enables you to easily view and edit files that are attached to entries.

Section 7.18.1, “Viewing Attached Files,” on page 103
Section 7.18.2, “Editing Attached Files,” on page 103
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7.18.1  Viewing Attached Files
1 Navigate to and open the entry that contains the attached file that you want to view.
2 In the Attachments section, click VIEW next to the file that you want to view.

7.18.2  Editing Attached Files
1 Navigate to and open the entry that contains the attached file that you want to modify.
2 In the Attachments section, click Edit next to the file that you want to view.

The file is launched in the file editor that you specified. For information on how to change the 
editor that Teaming uses to edit files, see Section B.10, “Unable to Edit Files that Are Attached 
to Entries,” on page 142.

3 (Conditional) If Teaming prompts you to provide your Teaming credentials, specify the 
username and password that you use to log in to Teaming, then click OK.
You can now edit the file.

4 After you have edited the file, save your changes, then exit the editing application.
Teaming creates a version of the file as it was before you modified it. When you exit and 
reopen the entry, you can view the older version of the file, as described in Section 7.19.2, 
“Accessing a Previously Saved Version of a File,” on page 104.

IMPORTANT: When you edit an attached document using OpenOffice, each time you click Save 
Teaming creates a new version of the document. Because each version of a document counts against 
your data quota (for more information on data quota, see “Managing Your Data Quota” in the Novell 
Teaming 2.1 Advanced User Guide), it is recommended that when using OpenOffice as an editor you 
save the document only once, when closing the document.

When using Microsoft Office, Teaming creates only one new version each time you edit the 
document. Clicking Save multiple times does not create multiple versions, as is the case when 
editing documents with OpenOffice.

7.19  Using Version Control with Attached Files
When you modify a file in Novell Teaming, Teaming saves the previous version of the file, and 
makes it available for easy reference. This includes files that are stored in Teaming File folders, or 
any files that are saved as attachments.

Section 7.19.1, “Creating a New Version of a File,” on page 103
Section 7.19.2, “Accessing a Previously Saved Version of a File,” on page 104

7.19.1  Creating a New Version of a File
Teaming enables you to create a new version of a file in the following ways:

“Editing the File to Create a New Version” on page 104
“Dragging and Dropping an Updated File to Create a New Version” on page 104
Working With Folder Entries 103



104 Novell

novdocx (en)  7 January 2010
Editing the File to Create a New Version

You can simply edit the existing file to create a new version of a file, as described in Section 7.18.2, 
“Editing Attached Files,” on page 103.

Dragging and Dropping an Updated File to Create a New Version

You can simply drag and drop an updated version of a file into the drag-and-drop window to create a 
new version of a file.

1 Navigate to the folder where you want to import the new version of the file.
2 Click Add Files to Folder in the Folder Entry toolbar.

The drag-and-drop window opens.
3 Drag a file from one location, such as your desktop, and drop it onto the folder icon in the drag-

and-drop window.
In order to create a new version of an existing file in the folder, the file that you upload must 
have the same name as the existing file for which you want to create a new version.
The document is added as a new version of the existing file entry. Older versions are displayed 
in the Previous Versions section of the entry.

7.19.2  Accessing a Previously Saved Version of a File
1 Navigate to and select a saved file for which you want to access a previous version.
2 In the Attachments section of the entry, click Previous Versions.

All of the previously saved versions of the file are listed in reverse-chronological order. 
Teaming displays the date, file size, and the person who modified the file.

3 Click the version of the file that you want to view.

7.20  Enabling Alternate Folder Entry Types
Novell Teaming enables you to configure a folder to allow you to create folder entry types that you 
cannot create by default in a specific type of folder. For example, if you want your tasks to show up 
in your Calendar folder, you can configure your Calendar folder to allow you to create task entries.

1 Navigate to the folder where you want to enable the alternate entry type.
2 Click Manage > Configure.

The Configure Default Settings page is launched.
3 In the Default Entry Types section, select the entry types that you want to enable for the folder.
4 Click Apply, then click Close.

You can also create custom entry forms and enable them on any folder of your choice. For 
information on how to create custom entry forms, see “Designing Custom Folder Entry Forms” in 
the Novell Teaming 2.1 Advanced User Guide.

7.21  Creating Custom Folder Entry Forms
Novell Teaming enables you to create custom folder entry forms, so you can display fields that are 
specific to your organization and business requirements.
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For instructions on how to create custom entry forms, see “Designing Custom Folder Entry Forms” 
in the Novell Teaming 2.1 Advanced User Guide.

7.22  Displaying Folder Entries on a Landing 
Page
When you configure a workspace to have a landing page, you populate that landing page with 
entries that exist within that workspace. 

For information on how to display entries on a landing page, see “Adding Content to Your Landing 
Page” in the Novell Teaming 2.1 Advanced User Guide.
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8Managing Accessories

Accessories are subsections of a workspace or folder page that enhance the use of Novell® Teaming 
pages in various ways. Accessories do not contain new information; instead, they point to existing 
information, organizing and presenting it in a summarized way that can be helpful to you. This 
section presents examples of accessories to help you understand how you can use them.

This section includes the following subsections:

Section 8.1, “Types of Accessories,” on page 107
Section 8.2, “Creating an Accessory,” on page 109
Section 8.3, “Modifying an Accessory,” on page 114
Section 8.4, “Deleting an Accessory,” on page 115
Section 8.5, “Minimizing an Accessory,” on page 115
Section 8.6, “Minimizing the Accessory Panel,” on page 116
Section 8.7, “Repositioning Accessories,” on page 116
Section 8.8, “Establishing a Default Layout,” on page 116
Section 8.9, “Providing a Title for the Accessory Panel,” on page 116

8.1  Types of Accessories
Novell Teaming accessories make your work easier by making the most useful information more 
accessible and easy to consume.

Depending on your goals, you might decide to use any of the following Teaming accessories:

Section 8.1.1, “Search Results,” on page 108
Section 8.1.2, “Workspace Tree,” on page 108
Section 8.1.3, “Formatted Text (HTML Editor),” on page 108
Section 8.1.4, “Embedded Web Page (iframe),” on page 108
Section 8.1.5, “Buddy List,” on page 108
Section 8.1.6, “Team Members,” on page 108
Section 8.1.7, “Photo Gallery,” on page 108
Section 8.1.8, “Blog Summary,” on page 108
Section 8.1.9, “Guestbook,” on page 108
Section 8.1.10, “Task Summary,” on page 109
Section 8.1.11, “Wiki Home Page,” on page 109
Section 8.1.12, “Calendar Summary,” on page 109
Section 8.1.13, “Remote Application,” on page 109
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8.1.1  Search Results
The Search Results accessory enables you to configure a search, then apply that search to any 
Teaming page that you desire, across the entire site or only on the page where the accessory is 
displayed.

8.1.2  Workspace Tree
The Workspace Tree accessory enables you to display a customized Workspace tree. Unlike the 
main Workspace tree, you can configure the Workspace Tree accessory to start on any workspace 
that you desire.

8.1.3  Formatted Text (HTML Editor)
The Formatted Text accessory enables you to use the HTML editor to compose a message and 
display it in the Accessory Panel.

8.1.4  Embedded Web Page (iframe)
The Embedded Web Page accessory enables you to display any Web page as an accessory in a 
workspace or folder. For example, if a team you are working on often refers to a specific Web site, 
you could create an Embedded Web Page accessory in the team workspace, so team members don’t 
need to navigate separately to the Web site.

8.1.5  Buddy List
The Buddy List accessory enables you to specify certain Teaming users with whom you 
communicate often, so you can quickly contact them by using their Presence icon, or access their 
workspaces by clicking a linked name.

8.1.6  Team Members
The Team Members accessory enables you to display all members of the team in the folder or 
workspace where you currently are.

8.1.7  Photo Gallery
The Photo Gallery accessory enables you to display photos from any Photo Album that you desire.

8.1.8  Blog Summary
The Blog Summary accessory enables you to synchronize the Teaming Blog folders of your choice, 
and display them in a single, summarized Blog folder in the Accessory Panel.

8.1.9  Guestbook
The Guestbook accessory enables you to use the Accessory Panel to display the contents of a 
Guestbook folder. Unlike other accessories, such as the Calendar Summary and Task Summary, you 
can display the contents of only one Guestbook folder in each Guestbook accessory.
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8.1.10  Task Summary
The Task Summary accessory enables you to synchronize the Teaming Task folders of your choice, 
and display them in a single, summarized task list in the Accessory Panel. This eliminates the need 
to check multiple Task folders. You can display tasks that are assigned to specific users, groups, or 
teams.

For more information, see “Synchronizing the Teaming Task Folders of Your Choice” on page 84 
and Section 6.11.5, “Viewing All Tasks That Are Assigned to a Specific Team, Group, or Individual 
User,” on page 86.

8.1.11  Wiki Home Page
The Wiki Home Page accessory enables you to display the wiki home page of any Wiki folder (Wiki 
Topic) as an accessory. 

For information on how to set a wiki home page for a wiki topic, see “Setting a Wiki Home Page” on 
page 88.

8.1.12  Calendar Summary
The Calendar Summary accessory enables you to synchronize the Teaming calendars of your choice, 
and display them in a single, summarized calendar in the Accessory Panel. This eliminates the need 
to check multiple calendars.

For more information, see Section 6.3.2, “Synchronizing Teaming Calendars of Your Choice,” on 
page 76.

8.1.13  Remote Application
The Remote Application accessory enables you to add a remote application as an accessory, if the 
application has been enabled by your administrator.

For more information on remote applications, see Section 2.13, “Using Remote Applications,” on 
page 40.

8.2  Creating an Accessory
Section 8.2.1, “Locating The Accessory Panel,” on page 109
Section 8.2.2, “Creating the Accessory,” on page 110
Section 8.2.3, “Setting Up the Accessory,” on page 111

8.2.1  Locating The Accessory Panel
The Accessory Panel is located in different sections of the page, depending on whether you are in a 
workspace or a folder.

“Locating the Accessory Panel in Workspaces” on page 110
“Locating the Accessory Panel in Folders” on page 110
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Locating the Accessory Panel in Workspaces

The location of the accessory panel differs, depending on the type of workspace that you are 
viewing.

Project Management Workspace: Upper right corner of the workspace.

Personal Workspace: In the Overview tab.

Team Workspace: Upper right corner of the workspace.

Discussions Workspace: Upper right corner of the workspace.

Basic Workspace: Upper right corner of the workspace.

Landing Page: You can add an Accessory Panel element to any location in your landing page.

For more information on how to add an Accessory Panel to a landing page, see “Adding Accessories 
to Your Landing Page” in the Novell Teaming 2.1 Advanced User Guide.

Locating the Accessory Panel in Folders

For folders, The Accessory Panel is located in the upper right corner of the folder page, above the 
content of the folder.

By default, accessory panels are not displayed in Blog folders and Micro-Blog folders.

8.2.2  Creating the Accessory
1 Navigate to the workspace or folder where you want to create the accessory.
2 Click the Accessory Panel drop-down list.

If you are unable to find the Accessory Panel, see Section 8.2.1, “Locating The Accessory 
Panel,” on page 109.
If you currently have no accessories, only the Add an accessory item appears in the list.

3 Click Add an Accessory.
4 In the Accessory Scope section, select where you want the accessory to be displayed.

Personal accessory for this page only: This accessory appears only to you and only on the 
currently displayed workspace or folder page.
Personal accessory for all workspaces and folders: This accessory appears only to you, but 
it appears on all workspace and folder pages that you view.
Community accessory for this page: This accessory appears only on this page, and it appears 
to everyone who views the current page. Only workspace and folder owners are allowed to 
establish community accessories.

5 In the Accessory Type section, select the type of accessory that you want to display, then click 
OK.
For more information on the various types of accessories, see Section 8.1, “Types of 
Accessories,” on page 107.
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The Accessory Setup page is displayed.
6 To finish creating the accessory, continue with Section 8.2.3, “Setting Up the Accessory,” on 

page 111 for specific information on filling in the Accessory Setup page for each type of 
accessory. 

8.2.3  Setting Up the Accessory
Use the steps in this section to set up an accessory after you have completed the steps in 
Section 8.2.2, “Creating the Accessory,” on page 110.

This section contains specific information on filling in the Accessory Setup page for each type of 
accessory.

“Search Results” on page 111
“Workspace Tree” on page 111
“Formatted Text (HTML Editor)” on page 112
“Embedded Web Page (iframe)” on page 112
“Buddy List” on page 112
“Team Members” on page 112
“Photo Gallery” on page 112
“Blog Summary” on page 113
“Guestbook” on page 113
“Task Summary” on page 113
“Wiki Home Page” on page 114
“Calendar Summary” on page 114
“Remote Application” on page 114

Search Results

1 In the Accessory Setup page, specify the following information:
Title: Specify a title for the Search Results accessory.
Display Style: Specify whether you want a border around the accessory.
Advanced Search: For information on all of the Advanced Search options, see Section 2.5.2, 
“Using Advanced Search,” on page 30.

2 Click Apply > Close.

Workspace Tree

1 In the Accessory Setup page, specify the following information:
Title: Specify a title for the Workspace Tree accessory.
Display Style: Specify whether you want a border around the accessory.
Starting Point for the Tree: Select whether you want to start at the current workspace, or 
select a starting workspace in the workspace tree. If you want to select a starting workspace, 
select Select a Starting Workspace and then navigate to and select the workspace in the 
workspace tree.
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Expand the First Level of the Tree: Select Yes if you want the first level of the tree to always 
be expanded. Select No if you want to manually expand the tree.

2 Click Apply > Close.

Formatted Text (HTML Editor)

1 In the Accessory Setup page, specify the following information:
Title: Specify a title for the Formatted Text (HTML Editor) accessory.
Enter the HTML to be Shown: Create your HTML message in the HTML editor provided.
This message is displayed in your Formatted Text accessory.
Display Style: Specify whether you want a border around the accessory.

2 Click Apply > Close.

Embedded Web Page (iframe)

1 In the Accessory Setup page, specify the following information:
Title: Specify a title for the Embedded Web Page (iframe) accessory.
Display Style: Specify whether you want a border around the accessory.
Iframe URL: Specify the URL of the Web page that you want to display in this accessory.
Iframe height in pixels: Specify the height for your embedded Web page. 
If you don’t specify anything in this field, Teaming uses the default height (about 200 pixels).

2 Click Apply > Close.

Buddy List

1 In the Accessory Setup page, specify the following information:
Title: Specify a title for the Buddy List accessory.
Display Style: Specify whether you want a border around the accessory.
Configure Buddy List: Specify the users, groups, and team members that you want to add to 
your buddy list.

2 Click Apply > Close.

Team Members

1 In the Accessory Setup page, specify the following information:
Title: Specify a title for the Team Members accessory.
Display Style: Specify whether you want a border around the accessory.
Number of Results to be Shown: Specify the number of team members that you want to be 
shown at one time.

2 Click Apply > Close.

Photo Gallery

1 In the Accessory Setup page, specify the following information:
Title: Specify a title for the Photo Gallery accessory.
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Display Style: Specify whether you want a border around the accessory.
Number of Photos to be Shown: Specify the number of photos that you want to display at any 
one time in your photo gallery.
Image Size: Select whether you want to display big images or small images.
Select the Photo Album(s) to be Shown: Use the workspace tree to browse to and select the 
photo albums that you want to be displayed in the accessory.

2 Click Apply > Close.

Blog Summary

1 In the Accessory Setup page, specify the following information:
Title: Specify a title for the Blog Summary accessory.
Display Style: Specify whether you want a border around the accessory.
Number of Results to be Shown: Specify the number of Blog results that you want to show in 
the Blog Summary.
Number of Words of Summary to be Shown: Specify the number of words that you want to 
display for each blog summary.
Select the blog(s) to be shown: Use the Workspace tree to navigate to and select the Blog 
folders that you want to display in the Blog Summary.

2 Click Apply > Close.

Guestbook

1 In the Accessory Setup page, specify the following information:
Title: Specify a title for the Guestbook accessory.
Display Style: Specify whether you want a border around the accessory.
Number of Results to be Shown: Specify the number of Guestbook results that you want to 
show in the Guestbook accessory.
Number of Words of Summary to be Shown: Specify the number of words that you want to 
display for each guestbook entry.
Select the guestbook to be shown: Use the Workspace tree to navigate to and select the 
Guestbook folder that you want to display in the Guestbook accessory.

2 Click Apply > Close.

Task Summary

1 In the Accessory Setup page, specify the following information:
Title: Specify a title for the Task Summary accessory.
Display Style: Specify whether you want a border around the accessory.
Number of Results to be Shown: Specify the number of Task results that you want to show in 
the Task Summary accessory.
Show Only the Tasks Assigned To: Specify the users, groups, or teams who are the assignees 
of the tasks that you want to display.
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Select the Task Folder(s) to be Shown: Use the Workspace tree to navigate to and select the 
Task Summary folder that you want to display in the Task Summary accessory.

2 Click Apply > Close.

Wiki Home Page

1 In the Accessory Setup page, specify the following information:
Title: Specify a title for the Wiki Home Page accessory.
Display Style: Specify whether you want a border around the accessory.
Select the Wiki to be Shown: Use the Workspace tree to navigate to and select the Wiki folder 
that you want to display in the Wiki Home Page accessory.
In the Wiki Home Page accessory, Teaming displays the wiki entry that you have configured to 
be the wiki home page for the Wiki folder (Wiki Topic) that you select here.

2 Click Apply > Close.

Calendar Summary

1 In the Accessory Setup page, specify the following information:
Title: Specify a title for the Calendar Summary accessory.
Display Style: Specify whether you want a border around the accessory.
Select the Calendar Folder(s) to be Shown: Use the Workspace tree to navigate to and select 
the Calendar folders that you want to display in the Calendar Summary accessory.

2 Click Apply > Close.

Remote Application

You can set up a remote application as an accessory if your administrator has enabled the 
application.

1 In the Accessory Setup page, specify the following information:
Title: Specify a title for the Remote Application accessory.
Display Style: Specify whether you want a border around the accessory.
Remote Application: From the provided drop-down list, select the remote application that you 
want to display in the accessory.

2 Click Apply > Close.

8.3  Modifying an Accessory
You can modify an accessory after you have created it.

Section 8.3.1, “Modifying an Accessory That Has a Border,” on page 115
Section 8.3.2, “Modifying an Accessory That Doesn’t Have a Border,” on page 115
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8.3.1  Modifying an Accessory That Has a Border
1 Click the Modify icon  in the accessory’s title bar.
2 Make the modifications that you desire, then click Apply > Close.

8.3.2  Modifying an Accessory That Doesn’t Have a Border
1 Click the Accessory Panel drop-down list > Show Hidden Borders and Controls.

The accessory’s title bar is displayed.
2 Click the Modify icon  in the accessory’s title bar.
3 Make the modifications that you desire, then click Apply > Close.

8.4  Deleting an Accessory
When you delete an accessory, remember that accessories do not contain information; they merely 
point to and summarize information that exists elsewhere. When you delete an accessory, you delete 
the pointer, not the source information. It is very easy to add the accessory again, if you mistakenly 
delete it.

Section 8.4.1, “Deleting an Accessory That Has a Border,” on page 115
Section 8.4.2, “Deleting an Accessory That Doesn’t Have a Border,” on page 115

8.4.1  Deleting an Accessory That Has a Border
1 Click the Delete icon (X) in the accessory’s title bar.
2 Click OK.

8.4.2  Deleting an Accessory That Doesn’t Have a Border
1 Click the Accessory Panel drop-down list > Show Hidden Borders and Controls.

The accessory’s title bar is displayed.
2 Click the Delete icon (X) in the accessory’s title bar.
3 Click OK.

8.5  Minimizing an Accessory
After you minimize an accessory, only the accessory’s title bar is displayed.

Section 8.5.1, “Minimizing an Accessory That Has a Border,” on page 115
Section 8.5.2, “Minimizing an Accessory That Doesn’t Have a Border,” on page 116

8.5.1  Minimizing an Accessory That Has a Border
1 Click the Minimize icon  in the accessory’s title bar.
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8.5.2  Minimizing an Accessory That Doesn’t Have a Border
1 Click the Accessory Panel drop-down list > Show Hidden Borders and Controls.

The accessory’s title bar is displayed.
2 Click the Minimize icon  in the accessory’s title bar.

8.6  Minimizing the Accessory Panel
You can minimize the entire Accessory Panel. This hides all of the accessories that are in the 
Accessory Panel on the current page.

1 Click the Minimize icon , located to the right of the Accessory Panel drop-down list.

8.7  Repositioning Accessories
On pages where you have more than one accessory, you can reposition accessories within the 
Accessory Panel.

1 In the title bar of the accessory that you want to move, click the arrow icons , depending 
on whether you want to move the accessory up or down in the Accessory Panel.

8.8  Establishing a Default Layout
When you create accessories for every page that you view or for a community accessories panel, the 
accessories are displayed in the reverse order in which they were created. Novell Teaming enables 
you to rearrange the order of the accessories within the panel, allowing you to determine an optimal 
default order in which the defined accessories appear. (If you are not the owner of the community 
accessory, you can override higher-level settings by personalizing the order of the accessories within 
the community panel, as described in Section 8.7, “Repositioning Accessories,” on page 116.)

To change the layout of a global, personal accessory panel or a community accessory panel:

1 Click the Accessory Panel drop-down list.
2 Click Set Default Layout for Community Accessories, or Set Default Layout for Personal 

Global Accessories, depending on which type of layout that you want to set.
The Configure the Accessory Panel page is displayed.

3 In the title bar of the accessory that you want to move, click the arrow icons , depending 
on whether you want to move the accessory up or down in the Accessory Panel.

4 Click Close.

8.9  Providing a Title for the Accessory Panel
To name your Accessory Panel:

1 Click the Accessory Panel drop-down list.
2 Click Set the accessory panel’s title.
3 Specify the following information:

New Title: Provide a title for your Accessory Panel.
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Accessory Panel Title Scope: Select whether you want the new name to apply to your 
personal Accessory Panel for this page only, your personal Accessory Panel for all pages, or the 
community Accessory Panel for this place only.

4 Click OK.
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9Connecting With Your Co-Workers

Novell® Teaming enables you to directly connect with your co-workers.

Section 9.1, “Using Novell Conferencing with Novell Teaming,” on page 119
Section 9.2, “Using Skype From within Teaming,” on page 121
Section 9.3, “Sending E-Mail From within Teaming,” on page 121
Section 9.4, “Filling Out the Send E-Mail Page,” on page 123
Section 9.5, “Using the Teaming Clipboard,” on page 123

9.1  Using Novell Conferencing with Novell 
Teaming
Teaming 2.0 and later supports the use of Conferencing 1.0. Before you can use Conferencing with 
Teaming as described in this section, your Teaming administrator must first enable these 
integrations, as described in “Configuring Presence” in “Advanced Installation and 
Reconfiguration” in the Novell Teaming 2.1 Installation Guide.

You can use Conferencing to collaborate with other Teaming users in the following ways:

Section 9.1.1, “Starting an Instant Conferencing Meeting,” on page 119
Section 9.1.2, “Scheduling a Conferencing Meeting,” on page 120
Section 9.1.3, “Instant Messaging,” on page 120
Section 9.1.4, “Making a Conferencing Voice Call,” on page 120

9.1.1  Starting an Instant Conferencing Meeting
You can start an instant Conferencing meeting from within Teaming by using the Presence icon of a 
Teaming user, or by clicking Meet in the main sidebar.

“Using the Presence Icon to Start an Instant Meeting” on page 119
“Starting an Instant Meeting from the Main Sidebar” on page 119

Using the Presence Icon to Start an Instant Meeting

1 Click the Presence icon of a Teaming user with whom you want to schedule a meeting.
2 Click Start Instant Meeting.

The Conferencing client is launched.

Starting an Instant Meeting from the Main Sidebar

1 In the main sidebar, click Meet.
The Add meeting page is displayed.

2 In the Invitees section, specify the users who you want to invite to the meeting.
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3 Click Start Meeting Now.
The Conferencing client is launched.

For more information about how to use Novell Conferencing, see the Novell Conferencing User 
Guide (http://www.novell.com/documentation/team_plus_conf/conf10_user/data/bookinfo.html).

9.1.2  Scheduling a Conferencing Meeting
You can schedule a Conferencing meeting from within Teaming by using the Presence icon of a 
Teaming user, or by clicking Meet in the main sidebar.

“Using the Presence Icon to Schedule a Meeting” on page 120
“Scheduling a Meeting from the Main Sidebar” on page 120

Using the Presence Icon to Schedule a Meeting

1 Click the Presence icon of a Teaming user with whom you want to schedule a meeting.
2 Click Schedule a Meeting.

The Conferencing client is launched.

Scheduling a Meeting from the Main Sidebar

1 In the main sidebar, click Meet.
The Add meeting page is displayed.

2 In the Invitees section, specify the users who you want to invite to the meeting.
3 Click Schedule for Later.

The Conferencing client is launched.

For more information about how to use Novell Conferencing, see the Novell Conferencing User 
Guide (http://www.novell.com/documentation/team_plus_conf/conf10_user/data/bookinfo.html).

9.1.3  Instant Messaging
You can use Conferencing to start a chat session with other Teaming users.

1 Click the Presence icon of a Teaming user whom you want to instant message.
2 Click Send Instant Message.

The Conferencing client is launched.

For more information about how to use Novell Conferencing, see the Novell Conferencing User 
Guide (http://www.novell.com/documentation/team_plus_conf/conf10_user/data/bookinfo.html).

9.1.4  Making a Conferencing Voice Call
You can make a Conferencing voice call from within Teaming.

1 Click the Presence icon of a Teaming user whom you want to call.
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2 Click Call.
The Conferencing client is launched.

For more information about how to use Novell Conferencing, see the Novell Conferencing User 
Guide (http://www.novell.com/documentation/team_plus_conf/conf10_user/data/bookinfo.html).

9.2  Using Skype From within Teaming
Novell Teaming enables you to communicate with other Teaming users through Skype, without 
needing to leave the Teaming interface.

This feature must first be configured by your Teaming administrator before you can use Skype from 
within Teaming. If you cannot perform the tasks in this section as described, consult your Teaming 
administrator. For information on how to enable Skype in your Teaming environment, see 
“Integrating Skype with Teaming” in the Novell Teaming 2.1 Administration Guide.

Section 9.2.1, “Setting Up Your Skype Address in Teaming,” on page 121
Section 9.2.2, “Contacting Other Teaming Users with Skype,” on page 121

9.2.1  Setting Up Your Skype Address in Teaming
After Skype has been configured by your Teaming administrator, you must specify your Skype name 
in your personal profile. 

1 In the home page of your personal workspace, click the Profile tab.
2 Click Modify Profile in the Workspace toolbar.

The User page is launched. 
3 In the Skype Name field, specify your Skype username.
4 Click OK.

9.2.2  Contacting Other Teaming Users with Skype
You can use Skype to contact only those users who have specified their Skype name in their personal 
profile. For information on how to modify your personal profile, see Section 9.2.1, “Setting Up Your 
Skype Address in Teaming,” on page 121.

To contact a Teaming user by using Skype:

1 Click the Presence icon  of the user whom you want to call using Skype.
2 Click Call Using Skype.

The Skype application is launched.
For information on how to use Skype, see the Skype documentation.

9.3  Sending E-Mail From within Teaming
Novell Teaming enables you to send e-mail messages to your co-workers from a variety of different 
places within Teaming, and for a variety of reasons.

Section 9.3.1, “Informing Others about a Folder or Workspace,” on page 122
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Section 9.3.2, “Informing Others about a New Entry,” on page 122
Section 9.3.3, “Informing Others about an Existing Entry,” on page 122
Section 9.3.4, “Sending E-Mail Notifications to Other Users,” on page 122

The following options are functional only if you have an e-mail account assigned to you in Teaming. 
To assign an e-mail account to your Teaming profile, see Section 1.5.1, “Modifying Your Profile,” 
on page 19.

9.3.1  Informing Others about a Folder or Workspace
Teaming enables you to send an e-mail message to inform others about a specific folder or 
workspace.

1 Navigate to the folder or workspace that you want to inform others about via e-mail.
2 In the main sidebar, click Send E-Mail.

The Send E-Mail page is displayed.
A link to this folder or workspace is automatically created in the Message field.

3 Fill in the appropriate fields.
For information on filling in the rest of the Send E-Mail form, see Section 9.4, “Filling Out the 
Send E-Mail Page,” on page 123.

9.3.2  Informing Others about a New Entry
1 When you are creating an entry, click Send E-Mail When Entry is Submitted.

Options are displayed that enable you to specify the users that you want to send the e-mail to.
A link to this entry is automatically created in the Message field.

2 Fill in the appropriate fields.
For information on filling in the rest of the Send E-Mail form, see Section 9.4, “Filling Out the 
Send E-Mail Page,” on page 123.

9.3.3  Informing Others about an Existing Entry
1 Navigate to the entry that you want to inform others about via e-mail.
2 In the Footer toolbar for the entry, click Send E-Mail.

The Send E-Mail page is displayed.
A link to this entry is automatically created in the Message field.

3 Fill in the appropriate fields.
For information on filling in the rest of the Send E-Mail form, see Section 9.4, “Filling Out the 
Send E-Mail Page,” on page 123.

9.3.4  Sending E-Mail Notifications to Other Users
If you are the owner of a folder, you can configure that folder to send e-mail notifications to specific 
Teaming users.
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For information on how to do this, see “Configuring Folders to Send E-Mail Notifications to Other 
Users” in the Novell Teaming 2.1 Advanced User Guide.

9.4  Filling Out the Send E-Mail Page
When you send e-mail from within Teaming, Teaming displays the Send E-Mail page. This page 
contains the following fields and options:

Add E-Mail Addresses: Specify users’ individual e-mail addresses. You must separate multiple e-
mail addresses with commas; do not include spaces between addresses.

Your e-mail address: Select your name if you want to include yourself on the e-mail.

Users: Use Type-to-Find functionality to specify individual users to whom you want to send the e-
mail.

Groups: Use Type-to-Find functionality to specify individual groups to whom you want to send the 
e-mail.

Clipboard User Names: Click this option to include all users whose names are currently on your 
clipboard.

For more information on using the Teaming clipboard, see Section 9.5, “Using the Teaming 
Clipboard,” on page 123.

Team Members: Click this option to include all team members.

CC: Click this option to specify users to whom you want to send a carbon copy of the message.

BCC: Click this option to specify users to whom you want to send a blind copy of the message.

Subject: Specify the subject of your e-mail message.

Message/Additional Text Sent with the Entry: Specify the main content of your e-mail message.

Include Attachments: (This option is not available when you send an e-mail from a folder or 
workspace.) Select this option if you want to include any attachments that are attached to the entry 
from where you are sending the e-mail.

9.5  Using the Teaming Clipboard
The clipboard in Novell Teaming is a tool that you can use to gather people’s names as you visit 
places within Teaming. Later, when using a tool that requires you to specify usernames, you can 
easily reference the names on your clipboard. For example, you can put a name on the clipboard, 
then when you want to send an e-mail message from Teaming, you refer to the clipboard to specify 
the name of the user to whom you want to send the e-mail.

Names remain on the clipboard until you remove them or until you sign out.

Section 9.5.1, “Adding Names to the Clipboard,” on page 124
Section 9.5.2, “Removing Names from the Clipboard,” on page 124
Section 9.5.3, “Using the Names on Your Clipboard,” on page 125
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9.5.1  Adding Names to the Clipboard
“Adding Users from the Current Page” on page 124
“Adding Team Members” on page 124
“Adding Individual Users” on page 124

Adding Users from the Current Page

Teaming enables you to add all users to the clipboard who have created on the current page, or who 
have most-recently modified an entry on the current page.

1 Navigate to the page where you want to add users to the clipboard.
2 In the main sidebar, click Clipboard.

The Clipboard dialog box is displayed.
3 Click Add people from this page.

Those users who have added or modified entries on this page are added to the clipboard.
If you are in the home page of a user’s personal workspace, clicking this option adds the owner 
of the personal workspace.

4 Click Close.

Adding Team Members

Teaming enables you to add all team members to the clipboard from the team workspace where you 
currently are.

You must be in a team workspace to add team members to the clipboard.

1 Navigate to the team workspace where you want to add team members to the clipboard.
2 In the main sidebar, click Clipboard.

The Clipboard dialog box is displayed.
3  Click Add team members.

All members of the team are added to the clipboard.
4 Click Close.

Adding Individual Users

Teaming enables you to add individual users to the clipboard by clicking the user’s Presence icon 
, located next to his or her name in an entry.

1 Click the Presence icon of the user whom you want to add to the clipboard.
2 Click Add to Clipboard.

9.5.2  Removing Names from the Clipboard
You can easily remove names from the Teaming clipboard after you have added them.

1 In the Clipboard dialog box, select the names that you want to delete.
 Teaming 2.1 User Guide



novdocx (en)  7 January 2010
You can simultaneously select all names by clicking Select All. Click Clear All to deselect all 
names.

2 Click Remove Selected Names.
3 Click Close.

9.5.3  Using the Names on Your Clipboard
There are various places in Teaming where you can use the names that are stored on your clipboard:

When sending e-mail
When creating a new team workspace
When adding additional team members to a workspace
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10Using Workflows

Before you can use a workflow in Novell® Teaming, it must first be created and enabled. Workflows 
can be created and enabled for use in a folder by folder owners, or they can be created and enabled 
for use across the entire Teaming site by Teaming administrators. For information on how to create 
and enable a workflow, see “Creating and Managing Workflows” in the Novell Teaming 2.1 
Advanced User Guide.

Because workflow creators can control who has rights to perform certain functions concerning the 
workflow, you might not have appropriate rights to work with workflows as described in this 
section. For more information on setting access controls on workflows, see “Adding Access 
Controls” in the Novell Teaming 2.1 Advanced User Guide.

Section 10.1, “Manually Starting and Stopping a Workflow,” on page 127
Section 10.2, “Manually Transitioning a Workflow After It Starts,” on page 128

10.1  Manually Starting and Stopping a Workflow
If a workflow has been enabled for use in a folder where you are creating an entry, then depending 
on how the folder owner or site administrator enabled the workflow, the workflow either 
automatically starts when you create the entry, or you can manually start it after the entry is created.

Section 10.1.1, “Manually Starting a Workflow,” on page 127
Section 10.1.2, “Manually Stopping a Workflow,” on page 127

10.1.1  Manually Starting a Workflow
1 Navigate to and select the entry where you want to start the workflow.
2 In the Entry toolbar, click Workflow, then select the workflow that you want to start on the 

entry.
Multiple workflows can be enabled in the same folder, so multiple workflows might appear in 
the drop-down list.

3 Click OK when you are prompted about whether you really want to start the workflow.

10.1.2  Manually Stopping a Workflow
1 Navigate to and select the entry where you want to stop the workflow.
2 In the Entry toolbar, click Workflow, then select the workflow that you want to stop.

Multiple workflows can be active on the same entry, so multiple workflows might appear in the 
drop-down list.

3 Click OK when you are prompted about whether you really want to stop the workflow.
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10.2  Manually Transitioning a Workflow After It 
Starts
Workflows can be configured to automatically transition to another workflow state after the entry is 
modified, after someone has commented or replied to the entry, after a specified amount of time, or 
various other options.

Workflows can also be configured to be manually transitioned. If a workflow has been configured to 
be manually transitioned, and if you have appropriate rights, then you can manually transition the 
workflow from one workflow state to another.

1 Navigate to the entry that you want to transition to another workflow state.
The workflow must already be started on the entry.

2 In the Workflow section, in the Transition to field, click the drop-down arrow and select the 
workflow state that you want to transition the entry to.
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11Using Teaming on Your Mobile 
Phone

Novell® Teaming 2.1 supports using Teaming from your mobile phone. For more information, see 
“Using Teaming on Your Mobile Phone” in the Novell Teaming 2.1 Advanced User Guide.
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AWhat’s New in Teaming

Welcome to Novell® Teaming. You’ll find new features, a fresh user interface, and significant 
updates. The following list is an overview of the new features:

Section A.1, “New User Interface,” on page 131
Section A.2, “Getting Informed,” on page 132
Section A.3, “Flexible Navigation,” on page 134
Section A.4, “Easy Folder and Workspace Management,” on page 135
Section A.5, “YouTube Video Support (v2.1),” on page 137
Section A.6, “Skype Integration (v2.0),” on page 137
Section A.7, “Advanced User Enhancements,” on page 137

A.1  New User Interface
The user interface for Teaming has been significantly redesigned.

Section A.1.1, “Mobile Interface (v.2.1),” on page 131
Section A.1.2, “Navigation Toolbar (v2.0),” on page 131
Section A.1.3, “Sidebar (v2.0),” on page 131
Section A.1.4, “Main Content Area (v2.0),” on page 132
Section A.1.5, “Video Tutorials (v2.0),” on page 132

A.1.1  Mobile Interface (v.2.1)
Teaming 2.1 includes an interface optimized to view on your mobile device, so now it’s easy to 
access Teaming when you’re on the go.

For more information, see “Using Teaming on Your Mobile Phone” in the Novell Teaming 2.1 
Advanced User Guide.

A.1.2  Navigation Toolbar (v2.0)
Teaming 2.0 and later contains a Navigation toolbar that includes location identifiers, search tools, 
quick access lists, and tree navigation.

For more information, see Chapter 3, “Navigating the Teaming Interface,” on page 43.

A.1.3  Sidebar (v2.0)
You can accomplish the following tasks by using the Teaming sidebar:

Track workspaces and folders
Share a workspace or folder
View recent places
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View the workspace or folder where you currently are, and any sub-workspaces or sub-folders, 
in the workspace tree
View, manage, and send e-mail to your teams
Tag a workspace or folder
Change your personal preferences, such as the way entries are displayed, the default folder 
editor, and more
Send an e-mail
Access the Teaming clipboard
Access deleted items from workspaces and folders (v2.1)
For more information, see Section A.4.1, “Undeleting Workspaces, Folders, and Entries 
(v2.1),” on page 135.

A.1.4  Main Content Area (v2.0)
The main content area of the Teaming interface displays the contents of folders, entries, and 
comments. It also displays workspace landing pages, search results, the home page of your personal 
workspace, and other content.

A.1.5  Video Tutorials (v2.0)
The Teaming video tutorials explain how to use important features in the new Teaming interface. 
You can access them from the Video Tutorials section on the home page of your personal workspace.

For more information on the Teaming video tutorials, see Section 1.2, “Watching the Teaming Video 
Tutorials,” on page 14.

A.2  Getting Informed
Now Teaming enables you to find out what colleagues are saying more easily than ever.

Section A.2.1, “Setting Up Live Teaming Feeds (v2.1),” on page 132
Section A.2.2, “What’s New Quick Access Tab (v2.0),” on page 133
Section A.2.3, “Tasks and Calendars Quick Access Tab (v2.0),” on page 133
Section A.2.4, “Recent Entries Quick Access Tab (v2.0),” on page 133
Section A.2.5, “Micro-Blogs and Shared Items Quick Access Tab (v2.0),” on page 133
Section A.2.6, “Tracking Workspaces, Folders, and People (v2.0),” on page 133
Section A.2.7, “Finding What’s New in Specific Workspaces or Folders (v2.0),” on page 133
Section A.2.8, “Synchronizing Tasks and Calendars With iCal (v2.0),” on page 134

A.2.1  Setting Up Live Teaming Feeds (v2.1)
Teaming 2.1 enables you to view live feeds of the latest entries in your teams, tracked places, or 
across the entire site, so you can be up-to-date in real time without entering the Teaming site. And, 
like Twitter, you can see live feeds for the micro-blog entries of the people you are tracking.

For more information, see Section 2.14, “Viewing Live Teaming Feeds,” on page 41.
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A.2.2  What’s New Quick Access Tab (v2.0)
Teaming 2.0 and later enables you to view what’s new and what’s most popular in your teams, your 
tracked places, or across the site. 

For more information, see Section 2.2.2, “Finding What’s New in Your Teams, Tracked Places, or 
Across the Entire Site,” on page 28 and Section 2.3, “Finding What’s Most Popular In Your Teaming 
Site,” on page 28.

A.2.3  Tasks and Calendars Quick Access Tab (v2.0)
Teaming 2.0 and later enables you to view the tasks that are assigned to you, and the calendar events 
for which you are scheduled on the current day.

For more information, see Section 2.8, “Viewing Tasks,” on page 35 and Section 2.9, “Viewing 
Calendar Events,” on page 35.

A.2.4  Recent Entries Quick Access Tab (v2.0)
Teaming 2.0 and later enables you to view entries that you recently posted, as well as entries that 
you recently visited.

For more information, see Section 2.7, “Viewing Recent Contributions,” on page 34.

A.2.5  Micro-Blogs and Shared Items Quick Access Tab (v2.0)
Teaming 2.0 and later enables you to view the micro-blog entries of the people you are tracking, as 
well as see any items that people have shared with you.

For more information, see “Using the Relevance Tabs in Your Personal Workspace to View the 
Micro-Blog Entries of People You Are Tracking” on page 36 and Section 2.11.3, “Viewing Shared 
Items,” on page 38.

A.2.6  Tracking Workspaces, Folders, and People (v2.0)
Teaming 2.0 and later enables you to track workspaces, folders, and people. When you track 
something or someone in Teaming, you can easily see activity generated in the specific place that 
you are tracking, or for the specific person that you are tracking.

For more information, see Section 2.6, “Tracking and Untracking Places and People of Interest,” on 
page 33.

A.2.7  Finding What’s New in Specific Workspaces or Folders 
(v2.0)
Teaming 2.0 and later enables you to navigate to a specific workspace or folder, and immediately 
find the latest entries and additions.

For more information, see Section 2.2.1, “Finding What’s New in a Workspace or Folder,” on 
page 28.
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A.2.8  Synchronizing Tasks and Calendars With iCal (v2.0)
Teaming 2.0 and later enables you to synchronize your tasks and calendars with your desktop 
application by using iCal.

For more information, see Section 2.16, “Synchronizing Teaming Task and Calendar Folders to a 
Desktop Calendar Application,” on page 42.

A.3  Flexible Navigation
Novell Teaming provides easier navigation than in previous releases.

Section A.3.1, “Tree Navigation (v2.0),” on page 134
Section A.3.2, “Recent Places (v2.0),” on page 134
Section A.3.3, “Configuring a Folder and Workspace with a Simple URL (v2.0),” on page 134
Section A.3.4, “Entry Listing Toolbar (v2.0),” on page 134

A.3.1  Tree Navigation (v2.0)
The Workspace tree enables you to navigate to any page in the Teaming site without leaving the 
current page.

For more information, see Section 3.1, “Navigating the Workspace Tree,” on page 43.

A.3.2  Recent Places (v2.0)
Teaming 2.0 and later enables you to see and quickly revisit the folders and workspaces that you 
most recently accessed.

For more information, see Section 3.3, “Viewing and Revisiting Recent Places,” on page 44.

A.3.3  Configuring a Folder and Workspace with a Simple URL 
(v2.0)
You can quickly navigate to folders and workspaces by defining a simple URL to reference the 
folder or workspace.

For more information on defining a simple URL for a folder, see Section 5.10, “Setting Up a Folder 
to Receive Entries Via E-Mail,” on page 68.

For more information on defining a simple URL for a workspace, see Section 4.1.9, “Defining a 
User-Friendly URL for a Workspace,” on page 53.

A.3.4  Entry Listing Toolbar (v2.0)
The Entry Listing toolbar provides features that enable you to quickly locate entries within a folder.

For more information, see Section 5.16, “Listing Folder Entries and Pages,” on page 72.
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A.4  Easy Folder and Workspace Management
Section A.4.1, “Undeleting Workspaces, Folders, and Entries (v2.1),” on page 135
Section A.4.2, “Viewing All Calendar Events for Which You Are Scheduled (v2.1),” on 
page 135
Section A.4.3, “Viewing All Tasks That Are Assigned to You (v2.1),” on page 135
Section A.4.4, “Subscribing to Folders (v2.0),” on page 136
Section A.4.5, “E-Mailing Entries into a Folder (v2.0),” on page 136
Section A.4.6, “Identifying Unread Entries in a Folder or Workspace (v2.0),” on page 136
Section A.4.7, “Identifying New Entries in a Folder or Workspace (v2.0),” on page 136
Section A.4.8, “New Discussion Folder Features (v2.0),” on page 136
Section A.4.9, “New Blog Folder Features (v2.0),” on page 136
Section A.4.10, “New Wiki Folder Features (v2.0),” on page 136
Section A.4.11, “New Photo Album Features (v2.0),” on page 137

A.4.1  Undeleting Workspaces, Folders, and Entries (v2.1)
Teaming 2.1 enables you to undelete a workspace, folder, or entry that you previously deleted, and 
restore it to its previous location.

For more information, see:

Section 4.1.3, “Undeleting a Workspace,” on page 50
Section 5.3, “Undeleting a Folder,” on page 64
Section 7.9, “Undeleting a Folder Entry,” on page 96

A.4.2  Viewing All Calendar Events for Which You Are 
Scheduled (v2.1)
Teaming 2.1 enables you to display all past and future calendar events for which you are scheduled 
in one convenient location.

For more information, see Section 6.3.3, “Viewing All Calendar Events for Which you Are 
Scheduled,” on page 77.

A.4.3  Viewing All Tasks That Are Assigned to You (v2.1)
Teaming 2.1 enables you to display all of the tasks that are assigned to you, whether they are 
assigned personally to you, or assigned to a group or team of which you are a member.

For more information, see Section 6.11.4, “Viewing All Tasks That Are Assigned to You,” on 
page 85.

A.4.4  Subscribing to Folders (v2.0)
Teaming 2.0 and later enables you to subscribe to folders and configure them to notify you of any 
activity in the folder.
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For more information on subscribing to folders, see Section 2.12, “Subscribing to a Folder or Entry,” 
on page 38.

A.4.5  E-Mailing Entries into a Folder (v2.0)
Teaming 2.0 and later enables you to define simple URLs for folders and workspaces. When you 
define a simple URL for a folder, you can add entries to the folder via e-mail.

For more information on defining a simple URL for a folder, see Section 5.11, “Adding Entries to a 
Folder Via E-Mail,” on page 69.

A.4.6  Identifying Unread Entries in a Folder or Workspace 
(v2.0)
Teaming 2.0 and later enables you to quickly identify all entries that you have not yet read in a folder 
or workspace.

For more information on how to identify unread entries in a folder or workspace, see Section 2.4, 
“Finding What’s Unread,” on page 28.

A.4.7  Identifying New Entries in a Folder or Workspace (v2.0)
Teaming 2.0 and later enables you to quickly identify all entries that are new in a folder.

For more information on how to quickly identify all new entries in a specific folder or workspace, 
see Section 2.2, “Finding What’s New,” on page 27.

A.4.8  New Discussion Folder Features (v2.0)
Teaming 2.0 and later supports new features for Discussion folders, such as the ability to “pin” 
entries, open entries in place, and mouse over entries to display a short content preview.

For more information, see Section 6.1, “Working with Discussion Folders,” on page 73.

A.4.9  New Blog Folder Features (v2.0)
Teaming 2.0 and later supports new features for Blog folders, such as Blog Pages that enable you to 
better organize Blog folders, an Archives section, and a completely new layout. 

For more information, see Section 6.2, “Working with Blog Folders,” on page 74.

A.4.10  New Wiki Folder Features (v2.0)
Teaming 2.0 and later supports new features for Wiki folders, such as Wiki Topics that enable you to 
better organize Wiki folders, an Archives section, and a completely new layout.

For more information, see Section 6.12, “Working with Wiki Folders,” on page 87.
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A.4.11  New Photo Album Features (v2.0)
Teaming 2.0 and later supports new features for Photo Album folders, such as the ability to create 
nested Photo Albums, and an Archives section, enabling you to better organize Photo Album folders. 
Also, when viewing photos in Teaming 2.0 and later, you can easily scroll through pictures by 
clicking the navigation arrows.

For more information, see Section 6.9, “Working with Photo Album Folders,” on page 80.

A.5  YouTube Video Support (v2.1)
Novell Teaming enables you to display YouTube videos in any entry, folder, or workspace 
throughout the Teaming site.

For more information about how to display YouTube videos, see Section 7.15, “Displaying YouTube 
Videos in a Folder Entry,” on page 101.

A.6  Skype Integration (v2.0)
Novell Teaming has the capability to integrate with Skype, enabling you to communicate with other 
Teaming users through Skype, without leaving the Teaming interface.

Before you can use Skype from within Teaming, this feature must first be configured by your 
administrator.

For more information on how to use Skype with Teaming, see Section 9.2, “Using Skype From 
within Teaming,” on page 121.

A.7  Advanced User Enhancements
For a list of advanced features that are new in Teaming, see “What’s New in Teaming” in the Novell 
Teaming 2.1 Advanced User Guide.
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BTroubleshooting

The following sections provide guidance for difficulties you might encounter when using Novell® 
Teaming:

Section B.1, “You Have Exceeded Your Data Quota and Cannot Add Any Files or Attachments 
to the Teaming Site,” on page 139
Section B.2, “You Are Unable to Change Your Teaming Password,” on page 140
Section B.3, “Your Presence Icon Does Not Change Color,” on page 140
Section B.4, “WebDAV Link Does Not Work,” on page 140
Section B.5, “Too Many Sign-Ins for WebDAV,” on page 141
Section B.6, “WebDAV Phantom Folders,” on page 141
Section B.7, “Understanding Mirrored Folders,” on page 141
Section B.8, “Cannot Rename Attached Files through WebDAV,” on page 142
Section B.9, “Unable to Open Pictures from WebDAV in Microsoft Office Picture Manager,” 
on page 142
Section B.10, “Unable to Edit Files that Are Attached to Entries,” on page 142
Section B.11, “Cannot Upload a File Because it Is Too Large,” on page 144
Section B.12, “Upload Applet Problems on SLED 10 SP1,” on page 145
Section B.13, “Teaming Applets Are Not Working,” on page 145
Section B.14, “Edit-In-Place Applet Is Not Working on Mac,” on page 146
Section B.15, “Troubleshooting Your Mobile Device,” on page 147

B.1  You Have Exceeded Your Data Quota and 
Cannot Add Any Files or Attachments to the 
Teaming Site
Problem: When you try to add files and attachments to the Teaming site you are unable to do so 
because you have exceeded your data quota.

You can remove superfluous files and attachments that are counting toward your data quota by 
purging items that you have previously deleted from the Teaming site. Workspaces, folders, and 
entries that do not contain attached documents do not count toward your data quota.

NOTE: Purged items cannot be recovered. Before you purge an item, verify that you no longer want 
this item to exist in the Teaming site.

1 Navigate to the folder or workspace where you deleted the items that you now want to purge 
from the Teaming site.

2 Click the Trash icon , located in the Workspace or Folder toolbar.
3 Select the item that you want to purge from the Teaming site.
4 Click Purge > OK.
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For more information about purging deleted items, see “Making Disk Space Avaliable by Purging 
Deleted Items” in the Novell Teaming 2.1 Advanced User Guide.

For information on how to view your current disk space usage as it relates to your data quota, see 
“Viewing Your Data Quota” in the Novell Teaming 2.1 Advanced User Guide.

B.2  You Are Unable to Change Your Teaming 
Password
Problem: You are unable to change your Teaming password as described in section Section 1.5.1, 
“Modifying Your Profile,” on page 19.

If you are unable to modify your Teaming password it is probably because your personal 
information is being synchronized from an external directory server. You must consult your Teaming 
administrator to make any changes.

B.3  Your Presence Icon Does Not Change Color
Problem: When you sign in and view Novell Teaming pages, your presence icon does not change 
color to indicate that you are signed in, and it continues to display either the color that indicates no 
presence information (white) or that you are offline (gray).

If your presence icon indicates that there is no presence information for you (white):

1 View your personal workspace.
2 Click Modify profile.
3 In the Conferencing User Name field, type your Conferencing username for Novell 

Conferencing and its Pidgin client.
4 Click OK.

If your presence icon indicates that you are offline (gray) when you are signed in:

1 Start the Pidgin client on your computer.
For more information about installing and running the Conferencing Pidgin client on your 
computer, see your Teaming administrator.

B.4  WebDAV Link Does Not Work
Problem: When you click the View this folder as a WebDAV folder link in the footer toolbar or the 
icon used to attach a file through WebDAV, the WebDAV window does not function properly.

When you use Windows XP and Internet Explorer Version 7.0 or later, Novell Teaming activates the 
WebDAV link in the footer and the WebDAV icon used to attach files. If the administrator of the 
folder you are currently using did not properly configure the folder for use with WebDAV, then the 
WebDAV window does not function correctly. In order for a folder to enable WebDAV properly, it 
must be configured so that the names of all uploaded files are unique. To change this setting, the 
administrator can click Manage > Modify this folder.
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B.5  Too Many Sign-Ins for WebDAV
Problem: When using WebDAV, you must specify your Novell Teaming username and password 
more than once.

This is expected behavior for WebDAV. WebDAV requires that you sign in each time you access a 
separate program (for example, your Web browser and Teaming). It might ask you to sign in again to 
access a file.

B.6  WebDAV Phantom Folders
Problem: When using Novell Teaming to access a WebDAV folder, you might see a link to a 
subfolder that does not exist (a phantom folder). Clicking the link to the phantom folder returns you 
to your current folder (therefore, it has no effect). 

This error is caused by an interaction between WebDAV and Windows Explorer, it does not occur 
consistently, and there is no Teaming solution for this problem. Simply ignore phantom folders after 
you encounter them.

B.7  Understanding Mirrored Folders
Problem: You are not sure if you want to use mirrored folders, because you do not understand how 
they work.

A mirrored folder is a library folder within Teaming that is synchronized with a folder located on a 
system drive outside of Teaming. When you perform basic actions (adding subfolders and files, 
modifying files, deleting folders and files) by using the Teaming interface or by accessing the file on 
the drive, the change is reflected in the other interface. The advantage to using mirrored files is that 
you can apply Teaming tools to files on a drive, including tools such as text search, workflow, and 
discussion (in the form of comments applied to the entry in the library folder).

Teaming supports two types of external folders:

A directory on a file system
A folder accessible through WebDAV

Here are tips for using mirrored files:

When you specify the path to the system folder, specify the full (absolute) path to the folder.
After creating the mirrored folder, you cannot alter the pathname, and you cannot reconfigure 
the Teaming library folder to be a non-mirrored folder.
To initialize the new mirrored folder, click Manage > Modify this folder, and use the 
Synchronize tool.
Do not attach additional files to entries in a mirrored folder. Behavior regarding additional 
attachments is unpredictable.
Synchronization occurs only through manually using the Teaming menu items; you cannot 
schedule synchronization.
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When you delete a file on the server, Teaming deletes the entire entry in the library folder (not 
just the attached file).
Adding and deleting subfolders adds and deletes subfolders in the other system. When you 
delete a subfolder, you delete all of its contents in both places.

For more information about mirrored file folders, see “Working with Mirrored Folders” in the 
Novell Teaming 2.1 Advanced User Guide.

B.8  Cannot Rename Attached Files through 
WebDAV
Problem: You cannot rename a file through WebDAV when you are using the Access Attachments 
Using WebDAV link.

The Access Attachments Using WebDAV link should be used only as an alternative means of 
uploading and deleting files; renaming files is not supported through this link.

The following procedure explains how to rename a file through WebDAV:

NOTE: You must use Windows XP and Internet Explorer Version 7.0 or later.

1 Navigate to the File folder where the entry attachment resides.
2 In the footer toolbar, click View this folder as a WebDAV folder.
3 Log in to your WebDAV folder, then rename the file.

B.9  Unable to Open Pictures from WebDAV in 
Microsoft Office Picture Manager
Problem: When you are attempting to open pictures from WebDAV in Microsoft Office Picture 
Manager, you see the following error message: 

Picture Manager is unable to open pictures over the Internet that are not from 
a Windows SharePoint Services picture library. Please specify a valid picture 
library and try again.

This message occurs because Microsoft Office Picture Manager does not support the standard 
WebDAV protocol.

To work around this problem:

1 Copy the picture file to your local machine, then open the file using whatever photo viewer you 
want.

B.10  Unable to Edit Files that Are Attached to 
Entries
Problem: You are unable to edit files that are attached to entries. 
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If you are unable to edit a file, Novell Teaming might not be configured to support the editing 
application that is installed on your computer. For example, if Teaming is configured to use 
Microsoft Word as the default editor for all text files, but you have OpenOffice instead of Microsoft 
Word installed on your computer, Teaming displays an error, and won’t edit the document.

To fix this problem, Teaming enables you to override the default editor setting.

Section B.10.1, “Changing the Default Editor Settings for a Single File Type,” on page 143
Section B.10.2, “Changing the Default Editor Settings for All File Types,” on page 143
Section B.10.3, “Changing the Default Editor Settings When the Editor is Not Installed in the 
Default Location,” on page 143

B.10.1  Changing the Default Editor Settings for a Single File 
Type

1 In the main sidebar, in the Personal Preferences section, click Define Editor Overrides.
2 Click Add.
3 From the drop-down list, select the file extension for which you want to change the default 

editing application. 
4 In the Application field, specify the name of the application that you want to use to edit the type 

of files that you selected in Step 3.
5 Select the check box, then click OK.

B.10.2  Changing the Default Editor Settings for All File Types
You can configure Teaming to use the same editing application for all file types.

1 In the main sidebar, in the Personal Preferences section, click Define Editor Overrides.
2 Click the Use drop-down list, then select the application that you want Teaming to use to edit 

all file types.
3 Select the check box to the left of Extension, then click OK.

B.10.3  Changing the Default Editor Settings When the Editor is 
Not Installed in the Default Location

1 In the main sidebar, in the Personal Preferences section, click Define Editor Overrides.
2 In the Extension column, ensure that the correct file extension is selected in the drop-down list.
3 In the field in the Application column, specify the path to the application that you selected in 

Step 2.
For example, if your OpenOffice application is installed in a location other than the default 
location, and you want Teaming to recognize the unique location, specify the pathname to the 
OpenOffice application.

4 Click OK.
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B.11  Cannot Upload a File Because it Is Too 
Large
Problem: You are having trouble uploading a file because the file is too large. 

You might be able to fix this problem by increasing the default amount of memory used by Java* 
applets.

Section B.11.1, “Increasing the Default Memory Amount on Windows,” on page 144
Section B.11.2, “Increasing the Default Memory Amount on Linux,” on page 144

B.11.1  Increasing the Default Memory Amount on Windows
1 Navigate to the Control Panel (Click Start > Settings > Control Panel).
2 Double-click Java.

The Java Control Panel is launched.
3 Select the Java tab.
4 In the Java Applet Runtime Settings section, click View.
5 For each of your Java Runtime Versions, add -Xmx256m as a Java Runtime Parameter.
6 Click OK.

After increasing the default memory size for Java applets, you must exit all browsers and restart 
them before the change can take effect.

This setting causes the applet used for uploading files into a Teaming folder to start up with 256 MB 
of memory. If the applet still indicates that there is not enough memory to run the applet, you might 
need to reduce this number.

B.11.2  Increasing the Default Memory Amount on Linux
1 Locate the JRE* or JDK* being used for the browser plug-in.

The location of the JRE or JDK varies depending on your system.
2 In the bin directory of the JRE or JDK, run the ControlPanel file.

The Control Panel is launched.
3 Select the Java tab.
4 In the Java Applet Runtime Settings section, click View.
5 For each of your Java Runtime Versions, add -Xmx256m as a Java Runtime Parameter.
6 Click OK.

After increasing the default memory size for Java applets, you must exit all browsers and restart 
them before the change can take effect.

This setting causes the applet used for uploading files into a Teaming folder to start up with 256 MB 
of memory. If the applet still indicates that there is not enough memory to run the applet, you might 
need to reduce this number.
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B.12  Upload Applet Problems on SLED 10 SP1
Problem: When you use Novell Teaming in a browser running on SUSE® Linux Enterprise 
Desktop (SLED) 10 SP1, dragging and dropping picture files onto the upload applet results in the 
pictures being displayed in the browser instead of being added to the Teaming entry as attachments. 
This problem was reported by a user running a Firefox Version 2.0.0.12 browser, but the problem 
can also appear with other browsers.

In future releases of SLED, this problem might not occur if the Java JRE software is updated. Until 
then, you can either use the HTML form method of uploading files (the icon is next to the icon for 
the upload applet). You can also use the following procedure as a workaround for the problem:

1 Use your windowing software to select and copy the photo files to your windowing system 
clipboard.

2 Click Add Files to Folder.
3 Right-click the Upload applet icon (a blue folder) within the upload applet box.
4 Select Paste.

Teaming attaches the pictures to the entry.

B.13  Teaming Applets Are Not Working
The following Novell Teaming applets do not work:

The Add Files to Folder applet. This applet enables you to drag files from one location and 
drop them into a Teaming folder. It also enables to you copy and paste files into a Teaming 
folder.
The Edit in Place applet. This applet enables you to easily edit files that are attached to entries.
The Workflow Graphical Display applet. This applet enables you to graphically view the setup 
of your workflows.

You might be having difficulty using applets in Teaming in the following environments:

Section B.13.1, “Applets Are Not Working on a 64-Bit Operating System,” on page 145
Section B.13.2, “Applets Are Not Working on Windows with Firefox 3.6 and Later,” on 
page 146
Section B.13.3, “Applets Are Not Working on a Safari Web Browser,” on page 146

B.13.1  Applets Are Not Working on a 64-Bit Operating System
Problem:  If you are using a 64-bit operating system with a 64-bit version of Firefox (this is the 
default browser for some Linux 64-bit operating systems), Teaming applets do not work.

You can solve this problem in either of the following ways:

“Changing Your Browser to a 32-Bit Version of Firefox” on page 146
“Installing a 64-Bit Java Browser Plug-In and Firefox 3.0 or Higher” on page 146
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Changing Your Browser to a 32-Bit Version of Firefox

A simple solution to this problem is to run a 32-bit version of Firefox on your 64-bit operating 
system.

1 Install a 32-bit version of Firefox.
2 Install the 32-bit Java browser plug-in into the 32-bit version of Firefox that you installed in 

Step 1.
The Teaming applets now work as expected.

Installing a 64-Bit Java Browser Plug-In and Firefox 3.0 or Higher

If you want to keep your 64-bit browser, you can solve the applet problem by installing a 64-bit Java 
browser plug-in, and a version of Firefox greater than 3.0.

1 Download and install a 64-bit Java browser plug-in.
This Java browser plug-in supports only Firefox 3 or higher.

2 Download and install Firefox 3 or higher.

B.13.2  Applets Are Not Working on Windows with Firefox 3.6 
and Later
Problem: After upgrading to Firefox 3.6 or later on a Windows client, Teaming applets no longer 
work.

To fix this problem:

1 Update your Java client software to Java version 1.6.0_18 or later.

B.13.3  Applets Are Not Working on a Safari Web Browser
If you are using Safari* on Mac*, the following Novell Teaming applets do not display. These 
applets are not supported with the Safari Web browser:

The Add Files to Folder applet. This applet enables you to drag files from one location, and 
drop them into a Teaming folder. It also enables to you copy and paste files into a Teaming 
folder.
The Edit in Place applet. This applet enables you to easily edit files that are attached to entries.
The Workflow Graphical Display applet. This applet enables you to graphically view the setup 
of your workflows.

B.14  Edit-In-Place Applet Is Not Working on Mac
All Teaming applets work when using Firefox on Mac. However, the Edit-in-Place applet might not 
work if you have installed OpenOffice anywhere other than the default location.

To fix this problem:

1 Ensure that OpenOffice is installed at /Applications/OpenOffice.org.app.
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If OpenOffice is not installed, you must install it.
If you have installed OpenOffice somewhere other than the default location, you must specify 
this location in the Define Editor Overrides section in Teaming, as described in Section B.10.3, 
“Changing the Default Editor Settings When the Editor is Not Installed in the Default 
Location,” on page 143.

If the problem persists, consult your Teaming administrator.

B.15  Troubleshooting Your Mobile Device
The following sections provide guidance for difficulties you might encounter when accessing 
Novell Teaming from a mobile device:

Section B.15.1, “Your Browser Does Not Automatically Direct You to the Mobile Interface,” 
on page 147
Section B.15.2, “You Are Unable to View YouTube Videos from Your Mobile Device,” on 
page 147
Section B.15.3, “Your BlackBerry Curve Does Not Work with the Mobile Interface,” on 
page 148

B.15.1  Your Browser Does Not Automatically Direct You to the 
Mobile Interface
Problem: When accessing Teaming from your mobile device, the regular Teaming interface is 
displayed rather than the Teaming mobile interface. Because the regular Teaming interface is not 
optimized for mobile devices, this can make accomplishing tasks in Teaming difficult.

Some mobile device browsers do not automatically direct you to the Teaming mobile interface.

You can resolve this problem by manually accessing the Teaming mobile interface from your mobile 
device:

1 Launch a browser on your mobile device.
2 Specify the URL for your Teaming site, followed by /mobile.

For example: http://host/mobile.
The Teaming mobile interface is displayed.

B.15.2  You Are Unable to View YouTube Videos from Your 
Mobile Device
Problem: You are unable to view YouTube videos when accessing Teaming from a mobile device, 
such as a BlackBerry.

If you are unable to view YouTube videos when accessing Teaming from your mobile device, your 
device is probably not properly configured. To fix this problem:

1 Launch a Web browser, then navigate to the YouTube mobile interface (http://m.youtube.com).
2 Click the Help link, located near the bottom of the page.
3 Follow the instructions for optimizing YouTube Mobile for your device.
Troubleshooting 147



148 Novell

novdocx (en)  7 January 2010
B.15.3  Your BlackBerry Curve Does Not Work with the Mobile 
Interface
Problem: You cannot get the Teaming mobile interface to function on your BlackBerry Curve.

The BlackBerry Curve* has issues with JavaScript, and does not work with the Teaming mobile 
interface.

To fix this problem, update the browser on your BlackBerry Curve by updating the device software. 
For information on how to do this, see the BlackBerry Web site  (http://docs.blackberry.com/en/) for 
documentation about updating your BlackBerry device software.
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CAccessibility for People with 
Disabilities

Users with disabilities can use assistive technology (AT) such as a screen reader to access Novell® 
Teaming pages. AT users must adapt to the following Teaming functionality:

Section C.1, “New Windows Opened without Notification,” on page 149
Section C.2, “Text Added to a Page Is Not Conveniently Available,” on page 149
Section C.3, “Drop-Down List Access,” on page 149

C.1  New Windows Opened without Notification
When you click certain areas in Novell Teaming, the Teaming interface opens new windows. 
However, Teaming does not notify the AT user that it is opening a new window. As AT users become 
familiar with Teaming, they identify and remember where new windows are opened.

C.2  Text Added to a Page Is Not Conveniently 
Available
For some actions, Novell Teaming adds text to a page that is already displayed. However, AT 
software is not able to recognize that new text has been added unless the page is refreshed. After the 
page refreshes, the newly added text is available at the bottom of the page. The AT user must move 
to the bottom of the page and then move backwards up through the new content.

C.3  Drop-Down List Access
In fields where you type text and a drop-down list appears, press Enter to move the focus into the 
list. Press Tab to move down through the list, then press Enter to select an item in the list. 
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